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Warnings and Cautionary Statements 

WARNING:  Failure to perform certain procedures or note certain conditions may impair the 

performance of this product.  For maximum safety and optimal performance, please read and 

follow the procedures and conditions listed below. 

 Use of this product in areas where it may be subject to large amounts of electromagnetic 

interference may affect the reliable operation of this device and should be avoided. 

 Sources of large amounts of interference could be and are not limited to: 

o Operation near high radio frequency fields (near 2-way radio 

transmission antennas where the RF fields may greatly exceed 

10 V/M, etc.). 

o AC Power Mains that may have excessive power surges / spikes / 

transients (from large AC motors operating heavy loads which may 

induce voltage sags and, etc.).   

 
 

NOTE:  This product has been tested to, and passes all EMC requirements to EN 61326:1998 

Electrical Equipment for Measurement, Control and Laboratory Use for Type 2 (Industrial) 

Apparatus, as well as FCC Part 15, Class A emissions levels when installed to the requirements 

outlined within this manual.  Mandatory compliance to these standards help to ensure controlled, 

reliable operation of this device when exposed to typical levels of electromagnetic interference 

as well as ensuring that this device is not source of emissions that might interfere with other 

equipment installed nearby.   

 

NOTE:  Per 30 CFR 75.320(b), the DSX™ Docking Station tests for oxygen deficiency of 

MSHA approved oxygen detectors compatible with the DSX that can detect 19.5% oxygen with 

an accuracy of ± 0.5%. 

NOTE:  Per 30 CFR 22.7(d)(2)(i), the acceptable limit during calibration and bump testing with 

2.5% methane must be 10% for MSHA approved instruments using Industrial Scientific certified 

calibration gas. 

 

NOTE:  The DSX Docking Station has an internal pump that controls the flow of gas being 

delivered to the system.  As a result of the internal pump, a demand flow regulator must be used 

in conjunction with this calibration and bump test station. 
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About This Manual 

Chapter 

1 
 

1.1. Document Overview 

This documentation is designed to assist with the installation and use of the DSX-L Local Server 

Mode.  This user guide contains the following main sections:   

 Chapter 2:  Introduction - Begin with this section to learn the system components and an 

overview of functionality.   

 Chapter 3:  Getting Started - This section provides an introduction to the Docking Station 

Server Admin Console (DSSAC), the user interface through which administrative tasks 

are performed by the safety team.  It also provides minimum server and PC requirements 

for proper installation and operation of the software.  This section provides information 

on installing required operating system components, the DSS software, and the DSSAC 

software.  An overview of the the Broadcaster is also provided, as well as how to enable 

and disable this feature.  Finally, an overview of the DSSAC application is provided. 

 Chapter 4:  Setting Up Users – This section explains how to set up user accounts. 

 Chapter 5: Configuring Instruments – This section provides thorough explanations of 

instrument configuration processes including instrument options, DSSAC configuration, 

calibrations, graphing of data, bump tests, and data log data. 

 Chapter 6: Configuring the Docking Station – This section explains how to setup the 

Docking Station for operation.  It includes explanations of status, properties, setup and 

removal, and gas cylinder configuration and connections.  

 Chapter 7: Basic Operation – This section explains the basic operation of the docking 

station.  It includes topics such as user interface menu options, LED and alarm signals, 

forced bump tests, forced calibrations, downloading and clearing datalog data, IDS 

diagnostics, and operating guidelines. 

 Chapter 8: Event Scheduling – This section provides an overview of global and special 

events, and explains how they are used in the docking station system. 

 Chapter 9: The Journal Feature – This section provides an overview of the journal feature 

and how to view journal entries. 

 Chapter 10: Default Settings – This section explains how to monitor and modify default 

settings such as alarm settings and calibration gases. 
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 Chapter 11: Printing – This section provides information on various printing functions 

available on the docking station system.  This includes how to print lists, IDS and 

instrument details, calibration data, bump test certificates, and data log data. 

 Chapter 12: Language Features – This section explains the language feature and settings.   

 Chapter 13: Troubleshooting – Refer to this section if you are experiencing any problems 

with docking station. It contains information about common problems and their solutions.   

 Chapter 14: Warranty – Refer to this section for warranty and liability information.   

 Chapter 15:  iNet Configuration – This section provides an overview of iNet and explains 

how to configure iNet settings on the docking station.  

 Appendices – Various appendices provide quick access to reference material such as 

acronyms and frequently used terms. 

1.2. Document Conventions 

To help you easily locate and interpret information, this manual uses the following conventions.   

Table 1-1.  Document Conventions 

Convention Description 

ALL CAPITALS Acronyms and keys on the keyboard. 

Boldface type Menus and menu commands, command buttons, tab and dialog box 

titles and options, field names, and column headings. 

“Quotation Marks” System messages and options within a field. 

Italic type Terms that are being introduced, notes, alternatives, and book titles. 

 

 

NOTE:  Throughout this document, the term server−when used alone—refers to either a PC or 

server running the DSS software. 

 

    
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2.1. Overview 

DSX provides the capabilities for fleet management and the scheduling and automatic 

performance of testing, calibration, and battery charging for the following Industrial Scientific 

instruments: 

 Tango™ TX1 Single-Gas Monitor 

 Ventis™ Pro4 Multi-Gas Monitor  

 Ventis™ Pro5 Multi-Gas Monitor  

 

 Ventis™ MX4 Multi-Gas Monitor 

 Ventis™ LS Multi-Gas Monitor 

 MX6 iBrid™ Multi-Gas Monitor 

 GasBadge® Pro 

 

DSX-L and its software are installed to function as a system where data reside on a 

company’s internal computer network (or PC). The remainder of this guide describes this 

type of installation. 

2.2. Features 

Features of the docking station system include the following. 

 Ability to operate from a server or stand-alone PC. 

 Ability to handle up to 100 Instrument Docking Stations (IDS) with one docking station. 

 One fresh air input and two or five gas inputs.    

 Built-in smart charger on each IDS for rechargeable instruments.   

 Simplified feedback on the IDS via 3 LEDs (red, yellow, and green), and an audible 

alarm. 

 A graphical user interface tool (DSSAC) that allows an administrator to view operations 

on each IDS from a network computer. 

 Ability to schedule calibrations, bump tests, diagnostic tests and data log data downloads 

globally for all IDSs, or on an instrument-specific basis.   

 Multilingual user interface (Czech, English, French, German, Polish, Russian, or Spanish) 

on the IDS display as well as in the DSSAC application.   

 Storage of instrument data in a central database.   

 Option to use the Industrial Scientific supplied run-time database or the customer’s own 

existing Microsoft SQL Server.   

 Option to implement Industrial Scientific Corporation’s iNet solution, gas detection as a 

service.    

 Optional iGas configuration for automatic configuration of gas cylinders on an IDS.   
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2.3. Components of the Docking Station Network 

The DSX-L network consists of at least three (3) components:  

 a Docking Station Server (DSS) 

 the Docking Station Server Admin Console (DSSAC) application and user interface 

 multiple Instrument Docking Stations (IDSs). 

Refer to Figure 2-1.  An introduction to each of these components can be found in the next three 

sections.  

2.3.1. Docking Station Server (DSS) Overview 

The Docking Station Server (DSS) is a computer (server of PC) that controls the entire docking 

station network. The DSS sends information to—and retrieves information from—IDSs and the 

instruments docked in them.  IDS and instrument data, such as calibration and bump test results, 

are stored in databases that are controlled by the DSS.   Refer to Figure 2-1. 

   

 

Figure 2-1.  Sample Docking Station Network 

 

2.3.2. Docking Station Server Admin Console (DSSAC) Overview 

The DSS is administered using the Docking Station Server Admin Console (DSSAC) application. 

A Windows-based user interface, DSSAC is used by the safety team to manage instrument data, 

view IDS status, and manage DSS configurations.   

Before using the DSSAC for the first time, read Chapter 3 Getting Started for an overview of the 

application’s user interface.  Chapter 4 contains information about setting up and using IDSs.   

2.3.3. Instrument Docking Station (IDS) Overview 

An Instrument Docking Station (IDS) is the device into which an instrument is placed for use in 
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the DSS.  When placed in an IDS, an instrument is ready for automatic calibrations, bump tests, 

diagnostic tests, and data log data downloads, all of which are controlled by the DSS.  An IDS 

also serves as a battery charger for instruments with rechargeable batteries. 

An IDS contains an LCD panel that displays a menu used to perform tasks on an instrument or 

on the IDS itself.  The menu is controlled using a keypad on the IDS.  When the menu is not in 

use, the LCD panel shows the current activity of the IDS.  The IDS also contains LED lights and 

an audible alarm to provide you with additional feedback about current activity and status of the 

IDS. 

When idle, the IDS cycles through three screens of information, as shown below.  Each screen is 

shown for 10 seconds. 

 

Docki ng St at i on

200. 151. 100. 321

SN:  0511061- 023

Docki ng St at i on

200. 151. 100. 321

Char gi ng

Condi t i oni ng

SN:  0511061- 023
   

Docki ng St at i on

200. 151. 100. 321

SN:  0511061- 023

Docki ng St at i on

200. 151. 100. 321

Char gi ng

Condi t i oni ng

SN:  0511061- 023
 

Ser ver

200. 151. 100. 321

SN:  0511061- 023

Ser ver

200. 151. 100. 321

Char gi ng

Condi t i oni ng

SN:  0511061- 023
   

Ser ver

200. 151. 100. 321

SN:  0511061- 023

Ser ver

200. 151. 100. 321

Char gi ng

Condi t i oni ng

SN:  0511061- 023
 

    

Figure 2-2.  Sample LCD Panel Idle Displays (While and While Not Charging) 

 

Version 
9 . 0  ( MX 4 ) 

Charging 
Conditioning 

SN :  0511061 - 023 

Version 
9.0 . .0  ( MX4 ) 

SN :  0511061 - 023 
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Additional details about how to use the features of an IDS are covered in the following sections: 

 Chapter 6: Configuring the Docking Station 

 Chapter 7: Basic Operation  

2.4. Functionality and User Roles 

This section provides an overview of the functionality that is available in the Docking Station 

Server Admin Console (DSSAC) and on an Instrument Docking Station (IDS).  The availability 

of functions in the DSSAC is determined by your user role.  There are three user roles in the 

DSSAC.  The functionality of each is explained in the three sections that follow. 

 Systems Administrator - Can perform all functions in the DSSAC. 

 Technician - Can perform all functions except: managing users, editing iNet 

configuration information, editing events, editing default alarm settings, and 

editing default calibration gases.  

 Guest - Can log in and view information in the DSSAC.  This is a read-only role. 

 

NOTE:  Your current role is displayed in the title bar of the DSSAC application after you have 

logged in.  An example is shown below. 

 

 

Figure 2-3.  Sample Title Bar of the DSSAC Application Showing Administrator Role 

 

NOTE:  If you are assigned to the Technician role or Guest role in DSSAC, you will not see all 

of the functions for DSSAC described in this user guide. 

 

Technician and Administrator users can perform functions on the IDS, provided the IDS menu is 

not locked.  These functions are listed below. 

 Performing on-demand calibrations, bump tests, and data log downloads. 

 Clearing the data log data stored on an instrument. 

 Changing language settings on the IDS. 

 

NOTE:  It is possible to lock the menu on an IDS so that no one can access it.  See section 

6.4 Instrument Docking Station Status and Properties (on page 165) for more information about 

locking the IDS menu. 

 

In addition to the tasks in the DSSAC and on the IDS, a Technician or Administrator user may 

also be responsible for the physical configuration of IDSs, such as changing gas cylinders.  
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After logging in to the DSSAC using the “Guest” account, functionality is limited to read-only 

access through-out the program. 

 

NOTE:  The functionality of the DSSAC is based on the highest assigned role for any particular 

user (i.e., if a user is defined as both an Administrator and Technician, DSSAC will consider 

them an Administrator). 

 

2.4.1. Overview for Systems Administrators 

As a Systems Administrator in the DSSAC, you are able to perform all functions in the 

application.  These functions include the following. 

 User management - Add, edit and delete users of the DSSAC.   

 DSSAC configuration - Manage language settings and iNet configuration options.   

 Manage default settings - Configure the default alarm settings and default 

calibration gas types for the GasBadge Pro, MX6 iBRID, Tango TX1, Ventis 

Pro4, Ventis Pro5, Ventis MX4, and Ventis LS instruments.   

 View IDS status - Track the status of IDSs in the system.   

 IDS management - Manage IDS data and configure gas cylinders.   

 Instrument management - Manage instrument data, run reports on calibration and 

bump test results, and add legacy instrument information to the docking station  

system.   

 Manage events - Schedule events for calibration, bump tests, datalog downloads, 

and diagnostic tests; and create special events that apply to specific instruments.   

 View the Journal - View the dates and times of specific events on each instrument 

and IDS.   

A Systems Administrator may also be responsible for troubleshooting any issues related to the 

docking stations.  As a part of troubleshooting and general maintenance, a systems administrator 

will also typically be responsible for reviewing the Event Viewer for potential errors and 

messages.  All error information (for the DSS and the IDSs) is written to the event log on the 

DSS computer. 

See the Troubleshooting section (Chapter 13) for more information about possible issues and 

how to access the Event Viewer.   

2.4.2. Overview for Technicians 

If you are set up in the DSSAC as a Technician, you can perform the following functions in the 

DSSAC. 

 DSSAC configuration - Manage language settings for the DSSAC application on 

your workstation.   

 View IDS status - Track the status of IDSs in the system.   

 IDS management - Manage IDS data and configure gas cylinders. 

 Instrument management - Manage instrument data and run reports on calibration 

and bump test results.  

 View events - View Global and Special events for calibration, bump tests, data 

log downloads, and diagnostic tests.   
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 View the Journal - View the dates and times of certain events on each instrument 

and IDS.   

2.4.3. Overview for Guests 

If you are set up in the DSSAC as a Guest, you can perform the following functions in the 

DSSAC. 

 View IDS Status - Track the status of IDSs in the system.   

 View Events - View Global and Special events for calibration, bump tests, data 

log downloads, and diagnostic tests.   

 View the Journal - View the dates and times of certain events on each instrument 

and IDS.   

2.4.4. Context Summary Based on Roles 

The table below defines the context (right-click) menus for the DSSAC and what is displayed 

when a particular role is logged in.  In this table, “A”, “T”, and “G” refer to Administrator role, 

Technician role, and Guest role, respectively. 

Table 2-1.  Context Summary Based on Roles 

 Left Panel (Tree View) Right Panel (List View) 

 Add Refresh Print Find 
Apply 

Profiles 
Properti

es 
Remove Print 

DSS  A T G       

D.S.  A T G A T G   A T G A A T G 

Instr. A  A T G A T G A T G A A T G A A T G 

Comp.  A T G A T G   A T G   

Profiles A A T G A T G  A A T G A  

Users A A A T G   A A  

DS 
Global 

 A T G A T G  
 

A   

Instr 
Global 

 A T G A T G  
 

A   

Instr 
Special 

A A T G A T G  
 

A A  

Journal  A T G A T G      
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2.5. Required Network Connections 

Below is a summary of the required network connections needed for the docking station system 

to function.   

 

NOTE:  Throughout this document, the term server−when used alone—refers to either a PC or 

server running the DSS software. 

 

Table 2-2.  Required Network Connections 

Connection Requirements 

DSSAC to 

server 

The DSSAC client software must be able to reach the DSS server. 

This takes place over port 80 using http over TCP. 

The DSSAC calls various web services running under IIS. 

The DSSAC gets the IP address of the server either by listening for the 

broadcaster (if you are using it), or by reading it from the registry (if it has 

connected successfully in the past), or by the user typing it in, if the other two 

are not available. 

The best way to verify the DSSAC machine can reach the server is to open 

Internet Explorer and attempt to open one of the web services on the server, 

such as http://<server_ip_address>/DSSWS/Directory.asmx. 

Server to 

SQLServer 

The DSS server uses ODBC to access the SQL Server databases it uses. 

This ODBC connection is established using the servernames, users, and 

passwords in the Configuration.xml file. 

There are a total of 3 databases the DSS needs access to: DSS, DSSDL, and 

DSSUSERDIR. 

These databases can be local or remote. 

The database can use MSDE or SQLServer. 

To verify that the server machine can reach the database, try establishing an 

ODBC connection using the user, passwd, and servername from the 

Configuration.xml file. 

To IDS(s) 

Each IDS must be able to reach the server, and the server must be able to 

reach the IDS(s).  

This communication is XML over http, using TCP/IP. 

This takes place on port 80. 

The IDS posts XML to an ASP.NET page running under IIS.  The ASP.NET 

page used by the IDSs is shown below. 

  http://<server_ip_address>/DSSWS/Server.aspx  
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Connection Requirements 

Each IDS contacts the server once each minute, unless the IDS is in the 

middle of a long operation, in which case it contacts the server after the 

operation is over.   

The IDS learns the server IP address either by listening for the broadcaster (if 

you are using it), or by being programmed with the server IP using 

DS.Config. 

The Server learns of the IDS IP when the IDS contacts the server (the server 

merely replies). 

The IDS can have either a dynamic or static IP address. 

If a static IP address is used, you must set the address on the IDS using 

HyperTerminal and a serial cable. 

To verify the IDS is reaching the server, turn on the tracelog and look for 

messages from the IDS in question.  If there are any, it is reaching the server. 

Broadcaster to 

Network 

The “DS2 Broadcaster“ is a service that runs on the DSS server, broadcasting 

the IP address of the DSS server, to be received by any IDS and/or DSSAC 

running on the network. 

The broadcasts take place from the server via UDP on port 55555.   
 
 

     

 

 

 

  

 



 

 

Getting Started 

Chapter 

3 
 

3.1. Introduction 

This chapter explains how to install the DSS Software package onto a computer system to be 

used on either a server-based operating system or a PC-based system.  It also explains how to 

begin using the DSSAC application.    

This chapter is divided into the following topics: 

 Requirements for software installation 

 Installing Microsoft Internet Information Services (IIS)  

 Installing Microsoft Message Queuing (MSMQ) 

 Installing the Docking Station Server (DSS) software 

 Loading the installer software 

 Installation wizard for DSS 

 Database preparation options for first time installations 

 Selecting the database option 

 Installing the Docking Station Server Admin Console (DSSAC) software 

 Installing and running the Docking Station Configurator software 

 Assigning a static IP address to a sever or PC 

 Disabling the DS2 Broadcaster 

 Configuring Windows firewall 

 Starting the DSSAC application 

 Specifying the DSS IP address 

 

Each of these topics is explained in the sections that follow. 

3.2. Requirements for Software Installation 

Before installing the software make sure that the host system (server or PC) meets the following 

minimum requirements. 

3.2.1. Server Requirements 

 Pentium III, 800 MHz (or higher)  

 256 MB RAM 

 4 GB free disk space 

 Supported operating systems: 

o Windows 2000 Advanced Server or Datacenter Server with SP3 or higher 
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o Windows 2000 Professional or Windows XP (Supports 5 Docking Stations or less) 

o Windows 2003 (Standard Edition, Web Edition, Enterprise Edition, or Datacenter 

Edition) 

o Windows Vista 

o Windows 7  

o Windows 2008  

o Windows 8  

o Windows Server 2012  

 Supported operating system languages (for installation and running): 

o English 

o French 

o German 

o Spanish 

o Czech 

o Polish 

o Russian 

o Other Western Europe Latin-based languages (i.e., “Latin-1” languages per 

Windows) should also work, but have not been specifically tested.  These include:  

Afrikaans, Basque, Catalan, Danish, Dutch, Faeroese, Finnish, Galician (Spain), 

Icelandic, Indonesian, Italian, Malay, Norwegian, Portuguese, Swahili, and 

Swedish. 

o The SQL Server (or SQL Server 2008 Express Edition) database must be 

configured to use a Collation type within the Windows Latin codepage of 1252.  

(NOTE:  If the DS2 Database has any other collation type, it prevents the DSX 

Server software from functioning properly.)  The SQL Server (or SQL Server 

2008 Express Edition) will automatically default to “collation type” within the 

proper codepage of 1252 if installed under the Latin-based languages listed above.  

Installing SQL Server under a non-Latin-based operating system may result in a 

non-Latin collation type for the DS2 Database.  Database administrators also have 

the ability to change a database’s collation type.  Changing the collation type of 

the DS2 Database to anything other than a Latin collation type is not be supported. 

 Internet Information Services (IIS) must be installed to the operating system if not 

already present (may require the Operating System CD) 

 Message Queuing (MSMQ) must be installed to operating system (may require the 

operating system CD). 

 

NOTE:  Server software is supported on English, French, German, and Spanish Czech, Polish, 

or Russian operating systems.  Other Latin-based language operating systems may work, but 

they have not been fully tested. 
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The collation type of the database can be seen using SQL Server Enterprise manager and 

examining the Properties of a database as in the screenshot below. 

 

Figure 3-1.  Determining the Collation Type of a Database 

Although the DSS may run under non-English operating systems as described above, for it to 

successfully communicate data back and forth between docking stations necessitates that the 

English-US regional settings for Number formatting remain in their default state.  That is, even if 

the DSS is running under a non-English-US language, it is necessary that the settings for 

English-US remain at their defaults.  The default Number settings are shown below.  If any of 

these defaults are modified, then the DSS may be unable to properly communicate data with 

docking stations. 
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Figure 3-2.  Default English-US Regional Options for “Numbers” 

3.2.2. PC Requirements 

 Pentium III, 800 MHz (or higher)  

 256 MB RAM 

 4 GB free disk space 

 Windows XP or Windows Vista or Windows 2003, Windows 7, Windows 8, Windows 2008 

or Windows Server 2012. 

 Internet Information Services (IIS) must be installed to the Operating System if not 

already present (may require the Operating System CD) 

 Message Queuing (MSMQ) must be installed to Operating System (may require the 

Operating System CD) 

NOTE: DSSAC supports Federal Desktop Core Configuration (FDCC) settings. 

3.2.3. Additional Requirements and Warnings 

WARNING:  PCs or laptops having two network adapters will not allow the DSS to properly 

function.  Do not install to a laptop that has both a built in LAN adapter and a built in Wireless 

adapter.  If the laptop has a removable wireless card, remove the wireless card and place laptop 

on a LAN via Ethernet cable while doing the install. 
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WARNING:  When connecting a single IDS to either a server or PC, an Ethernet cross over 

cable must be used.  If you are connecting multiple IDSs to a network, standard Ethernet cables 

must be used. 

WARNING:  If you are installing the DSS software on a server or PC, any network device must 

be connected to the PC via an Ethernet Cable, for the software to install.  Simply connecting the 

docking station on any other network device such as a hub or router to the server or PC will be 

adequate.  If no devices are connected to the computer, the DSS will not install. 

 

NOTE:  If installing the software onto a Windows XP operating system, some screen shots may 

have some inaccuracies; depending on if the PC views are set for Classic/Traditional View, or 

XP View. 

 

NOTE:  Throughout this document, Internet Information Services will be referred to as IIS, and 

Message Queuing will be referred to as MSMQ. 

 

Prior to installing the DSS software, IIS must be installed to the Operating System if it is not 

already present.  Installing this Windows service requires the Operating System CD.   

The DSS installer will check for “prerequisite” programs during DSS installation. If prerequisite 

programs are not found in the machine, DSS installer will display the message below:  

 

For Windows versions less than v6.0 (Windows 7) 
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For Windows versions starting from v6.0 (Windows 7) 

At this time, the user can go back and install the IIS using the procedures outlined on the 

following pages. 

3.3. Installing Microsoft Internet Information Services (IIS) and Microsoft 

Message Queuing (MSMQ) 

3.3.1. Overview 

Microsoft Internet Information Services (IIS) and Microsoft Message Queuing (MSMQ) must be 

installed before installing the DSX software.  The procedures for installing IIS and MSMQ differ 

based on the version of the operating system that is used, namely: 

 Windows 2000 Professional and Windows XP Professional  

 Windows 2000 Standard Server and Windows 2003 Server 

 Windows Vista, Windows 7, Windows 8, Windows 2008 Server and Windows 2012 

Server 

Separate sections are provided for explaining the IIS and MSMQ installation processes under 

each of these systems.  Refer to the appropriate section below. 

3.3.2. Installing IIS and MSMQ on Windows 2000 Professional and Windows XP 

Professional 

To install IIS and MSMQ on Windows 2000 Professional and Windows XP Professional, follow 

the instructions listed below. 

NOTE:  You may need the Windows Operating System CD if the service was not previously 

installed. 
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Step Instruction 

1. Navigate to Control Panel (Start / 

Settings / Control Panel) 
 

 

Figure 3-3.  The Add/Remove Windows 

Component Button 

2. Click on Add / Remove Programs. 

3. Click on Add / Remove windows 

components.  

4. Find and, if needed, place a check mark 

on Internet Information Services (IIS).  

If a check mark already exists, the 

service is currently installed.  

 
 

 

Figure 3-4.  The IIS Check Box 

5. Find, and if needed, place a check mark in the box labeled Message Queuing 

Services.  If a check mark already exists, the service is currently installed.  

 

Figure 3-5.  The Message Queuing Services Check Box 
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Step Instruction 

6. For Windows XP Operating Systems, highlight Message Queuing and select details.  

Make sure that there is a check mark in the Common box and none in the Active 

Directory Integration box. 

 

Figure 3-6.  The Active Directory Integration and Common Check Boxes 

7. Select OK. 

8. For Windows 2000 Professional, Choose NEXT. 

 

Figure 3-7.  The IIS Check Box 
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Step Instruction 

9. When installing the Windows 2000 Professional OS for the first time, the following 

two choices must be made.  At the Message Queuing (MSMQ) type option, leave 

selection on Independent Client and choose Next. 

 

Figure 3-8.  Selecting Independent Client for MSMQ Type 
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Step Instruction 

10. At the Message Queuing Server (MSMQ) option select “Message Queuing will not 

access a directory service” and choose Next. 

 

Figure 3-9.  The Message Queuing Server Option 

11. Windows will then install the new components.  If your PC does not contain the 

source cabs (most do not), then you will be prompted to place the Windows system 

disk into the CD drive.  Answer any prompts accordingly. 

12. When it is completed, choose Finish. 
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3.3.3. Installing IIS and MSMQ on Windows 2000 Standard Server and Windows 2003 

Server Web Edition  

To install IIS and MSMQ on Windows 2000 Standard Server and Windows 2003 Server Web 

Edition, follow the instructions below. 

 

NOTE:  You may need the Windows Operating System CD if the services were not previously 

installed. 

 

Step Instruction 

1. Navigate to Control Panel (Start / Settings / 

Control Panel) 

 

Figure 3-10.  The Add/Remove 

Windows Component Button 

2. Click on Add / Remove Programs. 

3. Click on Add / Remove Windows 

components.  

4. If you are installing on Windows 2000 Server, 

the following three screens are applicable.  

Find and if needed, place a check mark on 

Internet Information Services (IIS).  If a 

check mark already exists, the service is 

currently installed.  
 

 

Figure 3-10.  The IIS Check Box 

5. Find, and if needed, place a check mark on Message Queuing Services.  If a check 

mark already exists, the service is currently installed. 
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Step Instruction 

 

Figure 3-11.  The Message Queuing Services Check Box 

6. Choose Next. 

7. If you are running Server 2003, the Message Queuing (MSMQ) is installed in the 

following manner. 

8. Select Application Sever from the check box and choose Details. 

 

Figure 3-12.  The Windows Components Wizard 
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Step Instruction 

9. Make sure that ASP.NET, Internet Information Services (IIS), and Message Queuing 

are checked.  

 

Figure 3-13.  The ASP.NET, IIS, and Message Queuing Check Boxes 

10. Highlight Message Queuing and click Details.  Make sure that there is a check mark 

in the box marked Common and no check mark in the Active Directory Integration 

box, and then click OK.  

 

Figure 3-14.  The Message Queuing Dialog Box 
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Step Instruction 

11. When installing the Windows 2000 Server OS for the first time, the following two 

choices must be made.  At the Message Queuing (MSMQ) type option, leave 

selection on Independent Client and choose Next.  At the Message Queuing Type 

option, leave selection on Independent Client and choose Next.  

 

Figure 3-15.  The Message Queuing Type Option 



 

25 

 

Step Instruction 

12. At the Message Queuing Server option, select “Message Queuing will not access a 

directory service” and choose Next.   

 

Figure 3-16.  The Message Queuing Server Option 

13. Windows will then install the new components.  It your PC does not contain the 

source cabs (most do not), then you will be prompted to place the Windows system 

disk into the CD drive.  Answer any prompts accordingly. 

14. When it is completed, choose Finish, and reboot the PC or server. 

15. After the IIS is installed, the PC or Server is now ready to install the DSS software. 
 

3.3.4. Installing IIS and MSMQ on Windows Vista, Windows 7, Windows 8, 

Windows 2008 Server and Windows 2012 Server 

To install IIS and MSMQ on these operating systems follow the instructions below. 

 

NOTE:  You may need the Windows Operating System CD if the services were not previously 

installed. 

When installing any of the DSX software applications on Vista™, the user will need to have 

“administrative” privileges.  This is due to the new User Access Control (UAC) feature within 

Vista™.  The following provides instructions on installing the DSX Software suite on Vista™ 

operating system.  For more information about Vista’s UAC, see the following link: 

http://www.microsoft.com/windows/products/windowsvista/features/details/useraccountcontrol.

mspx 

 

http://www.microsoft.com/windows/products/windowsvista/features/details/useraccountcontrol.mspx
http://www.microsoft.com/windows/products/windowsvista/features/details/useraccountcontrol.mspx
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The following images define which settings should be enabled for MSMQ and IIS Installed 

Windows Components settings under Vista, Windows 7, Windows 8, and Windows 2012. 

MSMQ 

 

IIS  
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To install DSX software on Windows Vista, follow the instructions below. 

Step Instruction 

1. To avoid any problems with privileges, close the CD launcher if the autorun feature 

automatically starts it. 

2. Browse to the DSX-L CD and right-click on the Launch application.  Choose the Run as 

administrator option; provide an administrative password if required. 

 

 

 

 

3. Install the applications as needed. 
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Step Instruction 

4. If the current user does not have “administrative” privileges at the time of installation, 

the User Access Control (UAC) will prompt for an admin password as shown below. 

 

5. Provide an administrative password and then continue with the install. 

 

3.3.5. Installing IIS and MSMQ on Windows 2008 

Step Instruction 

1. Navigate to Control Panel (Start 

/ Settings / Control). 

 

2. Click on Programs / Features.  

 



 

29 

 

Step Instruction 

3. Click on Turn Windows Features On and Off; this is located in the window pane to the 

left.  

 

4. Click on Features, then choose Add Features.  
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Step Instruction 

5. From Message Queuing / Message Queuing Services, find and, if needed, place a check mark 

on HTTP Support.  

 

If the check mark already exists, the service is currently installed. If the check mark is added, 

a new window will open; click on “Add Required Role Services”.  
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Step Instruction 

6. From the Add Features main window, under Web Server (IIS), click on Role Services.  

 

The features that should be selected with a check mark are highlighted below. In some cases, 

such as when choosing “ASP.NET”, a second window will open (similar to the second screen 

shown in Step 5 above) requiring the user to confirm the choice to add the feature. 

 After selecting all required features (see list below), click on Next.  

 

 

The following defines which settings should be enabled for Windows 2008.  

-  Web Server 

 -   Common HTTP Features 

   Static Content 

  Default Document 

  Directory Browsing 

  HTTP Errors 

  HTTP Redirection 

-   Application Development 

   ASP.NET 

  .NET Extensibility 

  ASP 

 CGI 

  ISAPI Extensions 

  ISAPI Filters 
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 Server Side Includes  

-   Health and Diagnostics 

   HTTP Logging 

  Logging Tools 

  Request Monitor 

  Tracing 

 Custom Logging 

 ODBC Logging 

-   Security 

   Basic Authentication 

  Windows Authentication 

  Digest Authentication 

 Client Certificate Mapping Authentication 

 IIS Client Certificate Mapping Authentication 

  URL Authorization 

  Request Filtering 

  IP and Domain Restrictions  

-   Performance 

   Static Content Compression 

 Dynamic Content Compression 

-  Management Tools 

   IIS Management Console 

  IIS Management Scripts and Tools 

  Management Service 

 -  IIS 6 Management Compatibility  

   IIS 6 Metabase Compatibility  

 IIS 6 WMI Compatibility 

 IIS 6 Scripting Tools 

 IIS 6 Management Console  

-  FTP Publishing Service 

  FTP Server 

 FTP Management Console  
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7. The Confirmation screen will open in a new window; choose Install to confirm the selections. 
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3.3.6. Installing IIS and MSMQ on Windows 7 

Step Instruction 

1. Navigate to Control Panel (Start 

/ Settings / Control). 

 

2. Click on Programs.  

 

 

3. Click on Turn Windows features on or off.  
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Step Instruction 

4. From the Microsoft Messaging Queue (MSMQ) Server / Microsoft message Queue 

(MSMQ) Server Core. Select MSMQ HTTP Support.  

 

 

 

5. Select Internet Information Services / Web Management Tools. The features shown below 

with a check mark should be turned on.  

 

6 In addition to the MSMQ and IIS features noted above in steps 4 and 5, other features are 

required (e.g., Security). Refer to the full list of Windows 7 features that should be selected 

as shown on page 26. After all features are selected, click OK.  



 

36 

 

3.4. Installing the Docking Station Server (DSS) Software 

The procedures that follow are intended for the operating systems listed below:  

 Windows 2000 Standard Server 

 Windows 2003 Server Web Edition 

 Windows 2000 Professional 

 Windows XP Professional (firewall must be configured) 

 Windows Vista 

 Windows 7 

 Windows 2008 

 Windows 8 

 Windows Server 2012. 
 

The DSS software is installed in segments.  These segments are outlined in the sections that 

follow. 

3.5. Loading the Installer Software 

To load the installer software, follow the instructions below. 

Step Instruction 

1. Place the DSX Operating CD into your computer. 

2. The CD will automatically run and the following window will appear. 

 

Figure 3-17.  The Installer Software Startup Window 

The launcher displays seven language options on the screen. Click a language to re-

display the Launcher in the chosen language. 
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Step Instruction 

3. Click on “Install Docking Station Server.”  This will automatically launch the DSS 

installer.  The first window that appears is the License Agreement. 

4. If the Microsoft .Net 

Framework v2.0 is not 

currently installed, the 

following screen will 

appear.  

Click “OK”. 

 

5. Click the Next button at 

the Welcome screen. 

 

 

Figure 3-18.  The Welcome Window 
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Step Instruction 

6. Review the license 

agreement, choose “I 

agree,” and then click 

Install. 

 

 

Figure 3-19.  The License Agreement Window 

7. The Installer will 

automatically install 

the .NET framework (if it 

currently is not installed).  

When this installation is 

complete, the following 

window will appear.  

Choose Finish to continue 

with the installation. 

 

 

Figure 3-20.  The .NET Framework Installation 

Complete Message Box 
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Step Instruction 

8. The DSS software is now ready to install.  Choose Next to continue. 

 

Figure 3-21.   The DSS Installation Wizard Window 

3.6. Installation Wizard for DSS 

Step Instruction 

1. Click YES to accept the license agreement. 

 

Figure 3-22.   The Software License Agreement Window 
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Step Instruction 

2. At this point the installation will check to make sure all prerequisites are already 

installed. 

 

Figure 3-23.  The Prerequisite Check Window 

3. Choose Next. 

4. If installing the DSS software onto Windows 2000 Professional or Windows XP 

Professional operating systems, the following message will be displayed.  This 

message is a reminder that the maximum number of IDSs that can be connected to a 

PC is limited to 8. 

 

 

Figure 3-24.  The Max Docking Station Information Window 

5. Choose OK. 

6. WARNING:  If you are installing the DSS onto a PC running Windows XP Service 

Pack 2, the warning above applies to you.  Please see section 3.14.1. 
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Step Instruction 

7. If the installer does not detect IIS and/or MSMQ, the installation will be halted, and 

the following warning will appear.  To install IIS or MSMQ onto either a server or 

PC, refer to section 3.3 Installing Microsoft Internet Information Services (IIS) and 

Microsoft Message Queuing (MSMQ). 

 

Figure 3-25.  The Prerequisite Check Failed Window 

 

3.7. Database Preparation Options for First Time Installations 

3.7.1. Overview 

This step in the installation is to select the database option that you are going to use.  The 

following window will appear if this is a new installation.  For new installations, choose one of 

the following three options: 

(a)  Install SQL Server 2008 Express Edition and a New DSS database on this machine 

(b) Install new DSS database to an existing SQL Server/SQL Server 2008 Express 

Edition on this machine 

(c)  Attach to an existing DSS database available on my network. 

Each of these options is explained in the following sections (marked as a, b, and c).  After you 

select your option, choose Next. 

NOTE: Regardless of the database location, the following apply:  

 File attributes of .MDF files are set to “writable” mode (disables read-only). Since the 

base structure of databases are copied from CD, the file attribute is set to read-only by 

default; the change to a writable setting allows the application to use the database. 



 

42 

 

 The following services are started through registry: INet Uploader, DSX Printing, and 

DS2 Broadcaster (during uninstall, these registry entries are removed). 

 In SQL Server, the following steps are completed during DSS Install: 

o “DSSUSERROLE” user role will be created. 

o “DS2” login will be created.  This is the login used by the DSS server. 

o “DS2” login will be given access to DSS, DSSDL and DSSUSERDIR databases 

with DSSUSERROLE, and DB_OWNER permissions. 

 

 

Figure 3-26.   The Setup Type Window 

 

NOTE:  When performing a fresh install of DSS that includes SQL Server 2008 Express Edition, 

newer versions of the installer no longer ask for passwords for the SA, SQL DSSUSER and 

DSSAC DSSUSER accounts.  The default value of D$2u$er$ will be used for all three. 
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Existing SQL/

New DSS

Perform Upgrade?Perform Upgrade?

The Docking Station Server installer 

has detected existing database files.

Do you want to perform an 
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Inform user files 

must be removed

Simplified Flow Diagram for DSS/SQL Express Installation

Instance NameInstance Name

Select Instance
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Figure 3-27.   Simplified DSS Installation Flowchart 

D$2u$er$ 
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3.7.2a. Install SQL Server 2008 Express Edition and a New DSS Database on This Machine 

Step Instruction 

1. Start installation. 

 

Figure 3-28.  Review Settings and Begin Installation 

 
 

NOTE:  A new SQL Server 2008 Express Edition database installed with a fresh DSS 

installation will use the following default account information: 

 Account     User  Password 

 SA Password     SA  D$2u$er$D$2u$er$ 

 DS2 DB User Login    DS2  D$2u$er$D$2u$er$ 

 DSSAC Default Admin User Login  DSSUSER  DS2user 

 DSSAC Read-only User Login  GUEST  guest 
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3.7.2b. Install New DSS Database to an Existing SQL Server/SQL Server 2008 Express 

Edition on This Machine 

Step Instruction 

1. When choosing this option, if the installer is unable to find a version of SQL Server 

installed on the local machine, the following message will be displayed. 

 

Figure 3-29.   Missing SQL Server Message 

2. Select the database Instance name from list of instances currently installed on the PC and 

choose Next. 

 

Figure 3-30.  Select the Database Instance 
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Step Instruction 

3. Enter the System Administrator (SA) Password for the selected instance and choose Next. 

 

Figure 3-31.    Entering the System Administrator Password 
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Step Instruction 

4. Start installation. 

 

Figure 3-32.  Review Settings and Begin Installation 

 

3.7.2c. Attach to An Existing DSS Database Available on My Network 

Step Instruction 

1. When choosing this option, the installer will display the following warning that, 

before proceeding, SQL Server must already be installed on the target PC and 

the DSS database files must be attached. 

 

Figure 3-33.  Entering the SQL Server Name 
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2. Enter the name of the server that SQL Server is running. 

 

Figure 3-34.  Entering the SQL Server Name 

3. Enter the database Instance name and choose Next. 

 

Figure 3-35.  Entering the Database Instance Name 
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4. Enter the login Name and Password for the DSX Server – SQL Server account and 

choose Next. 

 

Figure 3-36.  Entering the DSS SQL Login information 

5. Start installation. 

 

Figure 3-37.  Review Settings and Begin Installation 
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3.8. Continuing Installation (or Installation After Uninstalling a Previous 

Version) 

The following window will appear if you have uninstalled a previous version or you already 

have SQL Server/SQL Server 2008 Express Edition installed on the current PC and it has the 

DSS database tables already attached.   

 

Figure 3-38.  Existing DSS BD Files Popup 

The installer will recognize the existence of the previous databases and give you the following 

option.  If you want to use the existing databases choose Yes.  If you want to start with fresh 

databases, choose No.  If you do choose No, the installer will inform you that you must remove 

the databases and re-run the installer.  It will then quit, allowing you to remove the database files. 

Step Instruction 

1. Finally, the installation is now complete.  Select the desired restart method and 

choose Finish. 

 

Figure 3-39.  Installation Complete Window 
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2. Installation of the DSS will also install the DS2 Broadcaster and start it upon a reboot 

of the PC.  The DS2 Broadcaster is a UDP broadcaster that will broadcast out the IP 

address of the PC or server running the DSS such that all docking station units on the 

network will know which computer to communicate with.  Industrial Scientific does 

not recommend turning off your DS2 Broadcaster unless you are running multiple 

DSSs on your network.  It is the policy of some IT professionals not to have the DS2 

Broadcaster running on a network.  Therefore, the Broadcaster can be turned off. 

3. If the DS2 Broadcaster is disabled, the docking station units will need to know the IP 

address of the server running the DSS.  This is accomplished through using the DSX 

Configurator Software.  See section 3.12 on how to manually send out the IP address 

of the computer running the DSS. 

 

3.9. Installing the Docking Station Server Admin Console (DSSAC) 

Software 

NOTE:   The following procedure is for the following Operating systems:  

 Windows 2000 Standard Server 

 Windows 2003 Server Web Edition 

 Windows 2000 Professional 

 Windows XP Professional 

 Windows Vista 

 Windows 2008 

 Windows 7 

 Windows 8 

 Windows Server 2012 
 

To begin the installation of the DSSAC software, follow the instructions below. 



 

52 

 

Step Instruction 

1. Place the DSX Operating CD into your computer. 

2. The CD will automatically run and the following window will appear. 

 

Figure 3-40.  Docking Station Installation Window 

3. Click on “Install Docking Station Server Admin Console.”  This will automatically 

launch the DSSAC installer.  The DSSAC can be installed on any computer on the 

network as well as the server or PC running the DSS software. 

4. The software will guide you through the installation of the DSSAC.   

 

3.10. The Docking Station Configurator 

3.10.1. Installing the Docking Station Configurator Software 

The Docking Station Configurator Software is a tool that can be used to send the IP address of 

the server (or PC) that is running the Docking Station Server Software (DSS) to a known IDS.  If 

the DS2 Broadcaster service is turned off, or if an IDS is located on a different subnet than the 

computer or server running the DSS, then this software package must be used. 

NOTE:  The following procedure is for the following Operating systems:  

 Windows 2000 Standard Server 

 Windows 2003 Server Web Edition 

 Windows 2000 Professional 

 Windows XP Professional 

 Windows Vista 

 Windows 2008 
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 Windows 7 

 Windows 8 

 Windows Server 2012 
 
 

Step Instruction 

1. Place the DSX Operating CD into your computer. 

2. The CD will automatically run and the following window will appear. 

 

Figure 3-41.  Docking Station Installation Window 

3. Click on “Install Docking Station Configurator.”  This will automatically launch the 

Configurator installer.  The configurator software can be installed on any computer 

on the network as well as the server or PC running the DSS software. 
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3.10.2. Running the Docking Station Configurator Software 

To run the Docking Station Configurator Software, follow the instructions below. 

Step Instruction 

1. Choose START / PROGRAMS / INDUSTRIAL SCIENTIFIC / DS2 

CONFIGURATOR.  The Docking Station Configurator screen is displayed.  

 

To tell the docking station what the IP address of the server is, select the Server IP 

Address tab, and then type in: 

 the IP address of the docking station 

 the IP address of the server  

and choose Send. 

 

 

Figure 3-42.  Docking Station Configurator Screen 

2. At this point, the IDS will automatically reboot. 
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3.11. Assigning a Static IP Address to a Server or PC 

To assign a static IP address, you will need the desired IP address and the values for Subnet 

mask and Gateway address. If these values are unknown to you, contact your IT administrator.  

The following instructions tell you how to use PuTTy, a free and open-source terminal emulator, 

to assign a static IP address for the DSX-L.  

PuTTy can be obtained at putty.org. From their download page, select putty.exe.  

Step Instruction 

11 Power off the docking station: remove the power cord from the back of the unit.  

Ensure the docking station is connected to your computer with a serial cable, either a 

Male to Female DB-9 serial cable or a USB to DB-9 serial adapter. 

12. From your computer, click on the 

executable to run PuTTy.  

In the left column click “Serial”.  

In the dialog box, ensure the parameters 

are set as they are shown here. Note: 

your COM port may be something 

other than COM1; check the device 

manager on your PC to be sure. 

 

 

 

13. Click on Session in the left column. In 

the dialog box, ensure Serial is selected 

for Connection type and that the proper 

COM port is selected.  

Click on Open.  

Reconnect the power cable to the back 

of the docking station. Tap the space 

bar on your keyboard. 
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Step Instruction 

 At the blinking prompt, type the 

number 4 and press enter. The 

menu will refresh and the DHCP 

will change from Enabled to 

Disabled.  

At the next blinking prompt, type 

the number 1 and press enter. 

When prompted, type in the 

desired IP address, then press 

enter. The menu will refresh and 

will show the new IP address. 
Note: There is no ability to backspace 

when typing. To correct any 

typographical errors, simply repeat the 

task to enter the correct value. 

In the same manner, type in the 

number 2 to enter the Subnet 

mask. Then, type in the number 3 

to enter the Gateway address.  

The menu will refresh after you 

complete each entry and will 

show the new values.   

 

 

 Confirm that all values are correct and that the DHCP is still showing as Disabled. If 

needed, repeat any of the above tasks to correct a value 

14. Once you have confirmed the values are correct, type S and press enter to save the 

configuration.  

If the docking station is to be relocated to another area, disconnect the power cord. When 

the station is relocated, plug its power cord into a suitable outlet.   
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3.12. Disabling the DS2 Broadcaster 

 

NOTE:  This portion of the installation process is only to be done if the policy of your 

Information Technology (IT) Department prohibits the broadcaster to be turned on. 

 

The DS2 Broadcaster needs to be disabled if using the DSS on a LAN with other DSS installs.   

This step is not necessary for a production install of a DSS.  This procedure is to accommodate 

users wishing to install DSS as a demo tool. 

To disable the DS2 Broadcaster, follow the instructions below. 

Step Instruction 

1. Navigate to Control Panel (Start / Settings / Control Panel). 

2. Choose Administrative Tools. 

3. Choose Services.  The Services window is displayed. 
 

 

Figure 3-43.  Sample Services Window 

4. Locate and right click on DS2 Broadcaster. 

5. Choose Properties. 

6. In the Startup type dropdown box, select Manual. 

7. If the service is currently running, click the STOP button. 

8. Click OK. 
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3.13. Configuring the Firewall 

3.13.1  Windows Firewall 

If you are running Windows XP with Service Pack 2, the firewall will need to be set to allow the 

IDSs to communicate to the server.  To properly set the firewall, follow the instructions below. 

Step Instruction 

1. Select 

Start/Settings/Control 

Panel/Security Center.  

The Windows Security 

Center Screen will be 

displayed. 

 

Figure 3-44.  Windows Security Center Screen 

2. Select Windows Firewall.  The Windows Firewall screen will be displayed. 

3. The default setting shows the Windows Firewall “On”.  Select the Advanced tab.  

Select “Local Area Connection” and click the Settings button next to it. 

4. Check the box next to “Web Server (HTTP)” Click OK and exit. 

5. NOTE:  This procedure does not disable the firewall.  Adding the Web Sever (HTTP) 

setting allows this service to communicate through the firewall.  This allows the IDSs 

to communicate to the DSS software package installed on the PC. 

6. NOTE:  When updating Windows XP, the firewall may be enabled and may stop 

communications.  When this occurs, the firewall must be disabled. 

 



 

59 

 

 

Figure 3-45.  The Windows Firewall Screen 
 

Figure 3-46.  The Advanced Tab of the 

Firewall Window 

 

 

Figure 3-47.   The Web Server (HTTP) Check Box 
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3.13.2.  Windows Firewall for SQL Server in Server 64-bit OS (Windows 2003, Windows 

2008, and Windows 7) 

Step Instruction 

 NOTE: the user should be logged-on as an Administrator to perform the following 

tasks. 

1. Make sure that “IIS_IUSRS” group has been provided the full access permissions for 

“C:\Windows\Temp” directory. 

 Navigate to C:\Windows. 

 Right-click on “Temp” directory and choose Properties. 

 In Security tab, make sure that IIS_IUSRS group has been listed. If not listed, 

click the “Modify” or “Edit” button; click the “Add” button and add 

“IIS_IUSRS”; and click the Resolve button on the right-hand side. Mark “Full 

Control” and click Apply and OK. It will give one warning message; click OK. 

 

2. Enable Windows Firewall if it was disabled earlier. 

3. Go to All Programs >> Microsoft SQL Server 2008 >> Configuration Tools >> SQL 

Server Configuration Manager. 

4. Choose SQL Server Services and check that SQL Server (<<instance name>>) is 

running. 

 

 

5. Navigate to SQL Server Network Configuration >> Protocols for MSSQLSERVER and 

Enable TCP/IP if it is disabled. 

6. Navigate to SQL Server Network Configuration >> Protocols for DSS (if available) and 

Enable TCP/IP if it is disabled. 

7. Right-click on TCP/IP and choose Properties.  

Scroll to the bottom and clear TCP Dynamic Ports and add TCP Port as “14331” (note: 

Port can be any number but it should not be conflict with any other port). 
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8. Navigate to SQL Server Network Configuration >> Protocols for MSSQLSERVER. 

 

9. Disable “VIA” protocol Name, if it is enabled. (Note: The VIA protocol only works with 

VIA hardware that has the VIA driver installed. If you enable the VIA protocol on a 

computer that does not support the VIA protocol, the SQL Server service will not start.) 

10. Repeat steps 7 and 8 for Protocols for DSS, if available. 

11. Go to Control Panel >> Windows Firewall >> Change Settings >> Exceptions  >> Add 

Port. 
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12. Make the following entries in the pop-up “Add a Port” and click OK. 

 

13. Verify “SQL” has been added to the Exceptions list and click OK. 
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14. Click “Add Port” again and make the following entries in the pop-up and click OK. 

Make sure that port number given in Step 6 is given here. 

 

15. Verify “SQLDSS” has been added to the Exceptions list and click OK. 
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16. Click “Add Port” again, and make the following entries in the pop-up and click OK. 

Make sure that UDP Protocol is selected and Port number is 1434. Name it as you 

wish. 

 

17. Verify “SQLBROWSER” has been added to the Exceptions list and click OK. 

18. Log on to SQL Server using SA log-in or Windows Authentication. Right-click on the 

server node and choose Properties 

 

 

 

 

 

 

 



 

65 

 

19. Go to Left Tab of Connections and verify “Allow remote connections to this server” is 

enabled. 

 

20. Restart IIS where DSS is installed. 

3.14. Overview of the DSSAC Application 

This section explains how to start the DSSAC application and contains an overview of the user 

interface. 

3.14.1. Starting the DSSAC Application 

To start the DSSAC application, follow the instructions below. 

Step Instruction 

1. Using the Windows
® 

Start menu, select Programs, then Industrial Scientific Corporation, 

and then Docking Station Server Admin Console. 

2. The DSSAC splash screen 

appears, followed by the 

DSSAC Login dialog box.  

Enter your User Name and 

Password and click the OK 

button. 

NOTE:  Passwords are case-

sensitive and can be a 

maximum of 30 characters in 

length. 
 

Figure 3-48.  DSSAC Login Window 

Alternative:  You may also press the ENTER key on your keyboard after you have 
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Step Instruction 

entered your User Name and Password.   

NOTE:  If you click the Cancel button, the DSSAC does not open. 

3. The DSSAC application opens.  The title bar displays the role (e.g., Technician or 

Administrator) to which your user account is assigned. 
 

 

Figure 3-49.  DSSAC Application Showing User Role in Title Bar 

4. To close the DSSAC application, click on the File menu, and select Exit. 

 

3.14.2. Resetting the DSSUSER Password  

This section explains how to reset the DSSUSER password.   

Step Instruction 

1. From the DSSAC Login 

window, click on the 

"Advanced" tab to reveal its 

drop-down menu.  

 

Figure 3-50.  DSSAC Login Window 
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Step Instruction 

2. From the Advanced drop-

down menu, click on the 

option, Reset DSSUser 

Password.  

 
Figure 3-51.  DSSAC Login Window 

3. The Reset DSSUser 

Password window will 

open. The Request Key box 

( read-only field) will be 

automatically populated 

with a randomly generated 

string.  

 
Figure 3-52.  DSSUser Password Window with 

Request Key. 

4. Click on the Tech Support 

link to locate an ISC 

Technical Support center.  

Provide the support 

representative with the 

Request Key. The 

representative will then 

provide the Reset Password. 

Enter this into the Reset 

Password field. Click on 

Reset to complete the 

process.  
 

Figure 3-53.  Reset DSSUser Password Window 



 

68 

 

Step Instruction 

5. If successful, a 

confirmation box will open. 

Click OK.  

 

If unsuccessful, an error 

message box will open.  

The cause will be indicated 

and may be due to an older 

version of DSSAC installed 

at the DSS IP address, or an 

error in the DSS IP address 

field.  Contact ISC 

Technical Support for 

assistance.  

 

 

3.14.3. Specifying the DSS IP Address 

By default, the DSSAC will attempt to log in to the nearest Docking Station Server (DSS) from 

which it receives a broadcast.  If you know the IP address of another DSS, you can log into it by 

specifying the server’s address in the Login dialog box.  You will also need to specify the DSS 

IP when your DSS is not using the broadcaster service.   

To specify a DSS IP address, follow the instructions below. 

Step Instruction 

1. Using the Windows
® 

Start menu, select Programs, then Industrial Scientific 

Corporation, and then Docking Station Server Admin Console. 

2. The DSSAC splash screen appears, followed by the DSSAC Login dialog box.  Enter 

your User Name and Password. 

3. Click the Options button.  The DSS IP field will appear in the DSSAC Login dialog. 

NOTE:  Clicking the Options button again will hide the DSS IP field. 

4. Enter the IP address of 

the DSS to which you 

would like to connect.  

Click the OK button. 

 

 

 

Figure 3-54.  Specifying the DSS IP Address at Login 
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5. DSSAC connects to the specified DSS and the application opens. 

6. When the DSSAC is 

unable to connect to the 

server during log in, the 

error message “Failed to 

Connect to Server” is 

displayed. 

 

 

Figure 3-55.  Failed to Connect to Server Message 

 

NOTE:  When you restart the DSSAC, it will always attempt to log in to the DSS from which a 

broadcast is received, if any.  If a broadcast is not received, it will remember the IP of the DSS to 

which the DSSAC was last logged in. 

3.14.4. The DSSAC Screen 

The DSSAC screen is similar to Windows 
 

Explorer, containing a navigation pane on the left 

side, and a contents pane on the right.   

 

NOTE:  The title bar of the DSSAC shows the name of the user who is currently logged in.  The 

title bar also displays the user’s role (e.g., Technician “JOESMITH”). 

 

Navigation Pane     Contents Pane 

 

Figure 3-56.  The DSSAC Screen 

The DSSAC window also contains a menu that is used to perform certain commands.  Specific 

instructions on using the menu options are covered in the Using Docking Station section.  The 

menu options are shown below. 
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Table 3-1.  DSSAC Menu Options 

Menu Option Description 

File 

Change 

Password 
Used to change your DSSAC password. 

Add 

Used to add information into the system.  This option may not be 

available depending on what type of object is selected in the 

DSSAC. 

Remove 

Used to remove information from the system.  This option may not 

be available depending on what type of item is selected in the 

DSSAC. 

Properties 

Used to view information about the currently selected item.  This 

option may not be available depending on what type of object is 

selected in the DSSAC. 

Print 

Used to print information about the currently selected item.  This 

option may not be available depending on what type of object is 

selected in the DSSAC. 

Exit Used to close the DSSAC application. 

View 

Configuration 
Used to change language settings, and, if you are a Systems 

Administrator, iNet settings. 

Default Alarm 

Settings 

Used to manage default alarm settings for the GasBadge Pro, MX6 

iBRID, Tango TX1, Ventis Pro4, Ventis Pro5, Ventis MX4, and 

Ventis LS instruments.  This option is only available only if you are 

a systems administrator. 

Default 

Calibration 

Gases 

Used to manage the default calibration gases for  GasBadge Pro, 

MX6 iBRID, Tango TX1, Ventis Pro4, Ventis Pro5, Ventis MX4, 

and Ventis LS instruments.  This option is only available if you are a 

systems administrator. 

Refresh 
Used to update the contents pane to display the most recent 

information. 

Tools Find 

Used to locate instruments that meet certain criteria, such as those 

instruments due for calibration.  This option is only available when 

the instruments object is selected in the navigation pane. 

Help 

Contents Used to view the help documentation for the DSSAC. 

About 

DSSAC 
Used to view version information about the DSSAC. 
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3.14.5. Using the Navigation Pane 

The navigation pane contains a tree-

like structure showing the contents of 

a docking station network.  When you 

select an option in the navigation pane, 

a list of related items appears in the 

contents pane on the right.  For 

example, if you click on Instruments 

in the navigation pane, a listing of 

instruments configured for use in the 

system appears in the contents pane. 

At the top of the tree is an option for 

DSS, which represents the server.  If 

you click on the DSS option, you can 

see the current status of IDSs that are 

currently running in the socking 

station network. 

Under the DSS entry are the following 

options. 

 

Figure 3-57.  Navigation Pane 

 

NOTE:  The DSS and Events options in the navigation pane can be collapsed and expanded, 

similar to file folders in Windows
® 

Explorer.  If you see a minus sign (-) next to the option, then it 

is expanded.  If you see a plus sign (+) next to the option, then it is collapsed.  You can collapse 

or expand the entry by clicking on the minus or plus sign or by double-clicking on the entry.  The 

Docking Station and Instrument options underneath the Events option can also be collapsed 

and expanded.   

 

Table 3-2.  Options Under the DSS Entry in the Navigation Pane 

Option Description 

Docking 

Stations 

Displays a list of Instrument Docking Stations that are configured in your 

docking station network.  These can be sorted by location and can be 

designated as “Out of Service”.  See the How to Setup and Configure an 

Instrument Docking Station (Chapter 6) for information about setting up IDSs. 

Instruments Displays a list of instruments in your docking station network.  See the How to 
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Option Description 

Setup and Configure Instruments section for information about configuring 

instruments. 

Components 

Displays a list of all of the components in the DSS database, whether or not 

they are currently installed in an instrument.  The component list for each 

instrument includes those items shown on the “Components” tab of the 

Instrument form, including sensors and batteries.   

The default sort order of the list is in ascending by instrument serial number.  

If the user clicks any column header in the right pane list, the list is sorted by 

that column.  If the user double-clicks on any sensor in the list, the “Edit 

Sensor” screen opens.  If the user double-clicks on any battery in the list, the 

“Edit battery” screen opens. 

Users 

Displays the user accounts created to use the DSSAC.  Only Systems 

Administrators can see the Users option.  See the Setting up Users for more 

information about user accounts. 

Events 

Contains options for scheduling global and special events for IDSs and 

instruments.  See the How to Schedule Events section for more information. 

The Events options are:  

Docking 

Station: 

Global - Displays Global events that are configured for IDSs. 

Instrument: 

Global - Displays Global events that are configured for 

instruments. 

Special - Displays Special events that are configured for 

instruments. 

 Journal: 
Displays information about activities that have occurred for 

instruments in the system.  
 

3.14.6. Using the Contents Pane 

The specific information that you see in the contents pane varies depending on the option 

selected in the navigation pane.  The contents pane displays a list of information that can be 

sorted in various ways.  If more than one item is displayed in the contents pane, the column 

headings can be used to re-sort the information that you are viewing.   
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Figure 3-58.  Sample Contents Pane Showing Column Headings for Sorting 
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For example, when viewing the list of instruments as in the picture above, the contents pane 

contains eight column headings: Serial Number, Type, Last Cal, Next Cal, Last Bump, Next 

Bump, Status and Location.  If you click the Type heading, the list sorts by instrument type.  If 

you click on Serial Number, the list sorts by Serial Number of the instrument.  Likewise, if you 

click on Status, the list of instruments sorts by status.   

 

NOTE:  All column headings in the contents pane can be used to sort the data that you are 

viewing.   

 

Each column heading can also be resized to better accommodate the information being displayed.  

You can resize the column headings in one of two ways. 

1. Place your mouse pointer over the divider between two column headings.  Your mouse 

pointer changes into a vertical bar with an arrow on each side.  Click and drag to change the 

size of the column.   

2. Place your mouse pointer over the divider between two column headings.  Your mouse 

pointer changes into a vertical bar with an arrow on each side.  Double-click to resize the 

column to fit the widest entry in the column.   

3.14.7. Viewing and Re-instating Removed Instruments 

The DSSAC tree view (left panel) contains an “Removed from System” sub-node for Docking 

Stations and instruments that have been removed.   

 

NOTE:  Pressing [F5] while the DSSAC Main Screen is selected, refreshes the Docking Station 

and Instrument Sub-nodes. 

 

Selecting the “Removed from System” sub-node will cause the right-panel to display all Docking 

Stations (or instruments) which have been removed from service.  This node will have an icon 

similar to the other location nodes except it will have an “X” to indicate removed. 
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Figure 3-59.  DSSAC Tree View Showing Removed Instruments 

The following functions apply to removed instruments: 

 Double-clicking or selecting the properties of a docking station or instrument has the 

standard results. 

 Pressing [F5] while a Docking Station Archived sub-node is selected only refreshes the 

docking station list in the right pane. 

 Selecting a docking station while on the Docking Station (or instrument) “Removed from 

System” sub-node and right-clicking on it, adds “Restore” to the context menu list. 

 Selecting the “Restore” menu option causes the selected Docking Station or Instrument to 

be un-removed and shown in the normal Docking Station node. 

 If the user assigns a location value of “Removed from System”, a separate node will be 

created with the standard location node icon. 
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Figure 3-60.  DSSAC Tree View Showing User-Assigned Out of Service Location Value 

To view removed from system nodes, access the View menu and select the “Display ‘Removed 

from System’ Node” option.  

 

Figure 3-61.  The Display “Removed from System” Node Option 

Clicking the “Display ‘Removed from System’ Node” menu toggles its check mark (which 

indicates whether the feature is enabled or not).  The default setting for the menu option is 

unchecked, which means removed from system nodes are not displayed.   
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 When the check mark is on, the “Removed from System” node for the Docking Stations 

and Instruments is visible (if docking stations and/or instruments have been removed).   

 When the check mark is off, the “Removed from System” node for the Docking Stations 

and Instruments will not be visible (regardless if docking stations and/or instruments have 

been removed). 

3.14.8. The Instrument Node in the Tree View 

The Instrument option is a node on the tree view used to perform functions associated with 

instruments.  These functions include adding instruments, refreshing instrument lists, applying 

profiles of similar instruments, and printing instrument information. 

 

Figure 3-62.  The Instrument Node in the Tree View 

The context menu for the Instrument node on the tree view contains an “Apply Profile” option 

that is used to apply profiles to selected instruments of matching instrument type.  When this 

option is selected, the Apply Profile screen is displayed. 

3.14.9. The Profiles Node in the Tree View 

The Profiles option is a node on the tree view used to apply profiles to selected instruments of 

matching instrument type.  When the Profile Node is selected, the list view in the right pane 

displays all available Profiles currently saved within the DSS database 
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Figure 3-63.  The Profiles Node in the Tree View 

Whenever the Profiles node is selected, the File menu on the main menu bar will have an enabled 

“Apply Profile” menu option.  Selecting the Apply Profile menu option opens the “Apply 

Profile” screen. 

 

Figure 3-64.  The Apply Profile Option of the File Menu 

Selecting File from the menu bar while the Profiles node is selected will enable the Add sub 

menu.  Right-clicking on the Profiles node will display a context menu which contains the Add 

option (for Administrators only) and Refresh option. 

 Selecting the Add from the menu bar or from the context menu opens the Edit Profile 

screen in add mode. 

 Selecting Refresh from the context menu refreshes the list of current profiles saved 

within DSS. 
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The Profiles list view displays information about the current profiles.  The information is 

provided in two columns:  

 Profile Name - This column will display the name for each available profile.   

 Type - This column will display the type of instrument the profile has been created for.  

If the user clicks any column header in the right pane list, the list shall be sorted by that 

column.  By default, the list view will be sorted alphabetically first on the Type column 

and then the Profile Name column. 

If an Admin User double-clicks on any profile in the list, the “Edit Profile” screen will open.  If 

an Admin User right-clicks on a Profile, a context menu which contains the following menu 

options will be displayed. 

 Properties    (Single Selection) 

 Remove from Service  (One or More Selected) 

Selecting Properties from the context menu opens the Edit Profile screen in edit mode.  Selecting 

Remove from Service from the context menu prompts the user to confirm the deletion of the 

Profile(s).  If the user confirms the deletion, the profile(s) is permanently deleted. 

3.14.10. Applying Profiles – The Apply Profile Screen 

The Apply Profile form is used to apply profiles to selected instruments of matching instrument 

type.  The Apply Profile form has a list view of all the available profiles, a list view of 

instruments matching the profile instrument type, an Apply and Close button. 

 

Figure 3-65.  The Apply Profile Screen 
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Table 3-3.  Components of the Apply Profile Screen 

Component Description 

Available 

Profiles list 

view 

The Available Profiles list view will display all of the currently created 

profiles.  The Available Profiles list view has two columns:  Profile Name and 

Type.   

If the user clicks any column header within the list view, the list is sorted by 

that column.  By default, the list view is sorted alphabetically first on the 

Profile Name column.  Double-clicking on any single profile opens that profile 

in the Edit Profile form. 

Apply 

Selected 

Profile To 

list view 

The “Apply Selected Profile To” list view displays all of the instruments 

associated with the currently selected profile type.  It has three columns: Serial 

Number, Status and Location Last Docked.  If the user clicks any column 

header within the list view, the list is sorted by that column.  By default, the 

list view is sorted alphabetically first on the Profile Name column.  Multiple 

instruments can be selected within the list view. 

Apply 

Profile 

Button 

The Apply Profile button is disabled by default.  Once one or more 

instruments are selected, it is enabled.  Clicking the Apply Profile button 

applies the selected profile to the selected instruments.  When the profile 

is successfully applied, the following message is displayed. 

 

Figure 3-66.  Update Complete Message  After Profile Is Successfully 

Applied 

Close 

Button 

Clicking the Close button will close the Apply Profile form. 
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3.14.11. The Edit Profiles Screen – General Tab 

The General tab of the Edit Profiles screen is shown below.  It displays the profile name, 

password and profile type. 

 

Figure 3-67.  The Edit Profiles Screen – General Tab 

Table 3-4.  Components of the Edit Profiles Screen – General Tab 

Component Description 

Profile Name This is the user-defined name for the profile. A name MUST be 

specified, but can be no longer than 24 characters. 

Profile Password This field is used to specify an optional password needed to apply 

the profile when using the instrument.  Password maximum length is 

10 characters. 

Profile Type This field is a pre-populated drop-down list of dockable instruments.  

It determines which instrument types the selected profile may be 

applied to. 

This field is enabled during adding a new profile and is disabled 

when editing an existing profile. 

Changing this field removes existing options and components and re-

configures the tabs to match the newly selected profile type. 
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The Options tab of the Edit Profiles screen is shown below.  It defines which options will be set 

within the profile.  This tab mimics the Options tab on the Edit Instrument Screen in 

functionality.  Only group options relevant to the instrument type are enabled, and only Boolean 

options (true/false or on/off) relevant to the instrument type are shown within the tree node list.  

The individual group options are enabled depending on the instrument type. 

 

Figure 3-68.  The Edit Profiles Screen – Options Tab 

 

The following table indicates when the controls are enabled for the supported instruments. 

 

Table 3-5.  Controls Enabled on the Options Tab Based on Instrument 

(‘X’ indicates the absence of controls for specific instrument type) 

Option GBPro MX4 MX6  Tango TX1 

Bump Test 

Overdue Warning 

X X v3.5 and Above  

Calibration Date 

on Start up 

X X  X 

Calibration 

Display mode 

X v3.7 and above v3.5 and Above  

Bump Interval v2.0 and above  X  

Confidence 

Indicator Type 

X  X  

Bump timeout     
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The Users and Sites tab of the Edit Profiles screen is shown below.  It displays the users and sites 

assigned within the profile.  It displays all the users and sites currently available, the users and 

sites which are currently assigned to the profile, and the active user and site to be set within the 

profile.  This tab mimics the Users and Sites tab on the Edit Instrument Screen in functionality. 

 

Figure 3-69.  The Edit Profiles Screen – Users and Sites Tab 

Table 3-6.  Components of the Edit Profiles Screen – Users and Sites Tab 

Component Description 

All Instrument Users 

list box 

This list box displays all of the users which are available within the 

system and may be used in being assigned to a profile.  The list 

comes from all of the users currently assigned to an instrument 

within the system.  Double-clicking on a user within the All 

Instrument Users list makes it the current Active User. 

Active User text box This text box displays/sets the currently selected Active User for the 

selected profile. The maximum length allowed entered is 16 

characters. 

All Instrument Sites 

list box 

This list box displays all of the sites which are available within the 

system and may be used in being assigned to a profile.  The list 

comes from all of the sites currently assigned to an instrument within 

the system.  Double-clicking on a site within the All Instrument Sites 

list will make it the current Active Site. 

Active Site text box This text box displays/sets the currently selected Active Site for the 

selected profile.  The maximum length is 16 characters. 
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Component Description 

Set Active Button The Set Active Button is used to indicate which user or site should 

be the active user/site within the instrument when the profile is 

applied.  This button is disabled by default, but becomes enabled 

when a single user/site is selected from the All Instrument 

Users/Sites list. 

Clear Button The Clear button is used to clear the Active User/Site text box. 

 

The Components tab of the Edit Profiles screen is shown below.  This tab displays the profile 

component information.  It contains a list of the component types assigned to the profile as well 

as an Install and Uninstall button. 

 

Figure 3-70.  The Edit Profiles Screen – Components Tab 

 

Table 3-7.  Components of the Edit Profiles Screen – Components Tab 

Component Description 

Component List View The Component list view displays the component types assigned to 

the profile as well as the information about each one.  The columns 

listed are Sensor Type, Enabled, Alarm Low, Alarm High, Alarm 

STEL, Alarm TWA, and Gas Concentration. 

When no component types are currently assigned to the profile, a 

single column is displayed with the heading “There is no component 

installed!”. 
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Component Description 

When one or more component types have been assigned, the data is 

displayed in the above mentioned columns. 

The list view is sorted by the Sensor Type column by default.  

Clicking any column heading resorts by that column.  Clicking a 

column heading a second time reverses the sort order of that column. 

Double-clicking on any row within the list view opens the selected 

sensor type within the Edit Profile Component form. 

Install Button The Install Button is used to add new component types to the profile.  

It is only be enabled if the user has a role of ADMIN.  Clicking the 

Install Button opens the Add Profile Component form. 

Uninstall Button The Uninstall Button is used to remove an existing sensor type from a 

profile.  By default the Uninstall button is disabled. 

The Uninstall Button is enabled if the user has a role of ADMIN and 

one or more currently assigned sensor types have been selected. 

When the Uninstall button is clicked, the following message is 

displayed to confirm removing the components. 

 

 

Figure 3-71.  Confirm Component Removal Screen 

If the user chooses Yes, then the selected components are removed 

from the profile.  If the user chooses No, the action is canceled and 

the user is returned to the Components tab. 
 

The Add Profile Component screen is used to assign a component to a profile.  In addition, it 

assigns the Sensor type, alarms, and (if its an MX6 instrument type) whether the sensor should 

be enabled or not. 
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Figure 3-72.  Add Profile Component Screen – Example 1 (CO Sensor) 

 

Figure 3-73.  Add Profile Component Screen – Example 2 (PID Sensor) 
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Figure 3-74.  Add Profile Component Screen – Example 3 (Combustible LEL Sensor) 

 

NOTE:  Not all screen components are shown for every sensor type.  For example, for non-PID 

an non-LEL sensors, no Response Factor or Correlation Factor field are shown. 

 

Table 3-8.  Components of the Add Profile Components Screen 

Component Description 

Sensor type This drop down list will be populate with the appropriate sensor 

types for the profile instrument type.  Changing the sensor type will 

enable or disable the STEL and TWA text boxes depending on the 

selected sensor type. 

Gas Response Dropdown field is disabled for non-LEL and non-PID sensors. 

 For PID sensors, shows a list of all MX6 Response Factors, plus 

any Custom Response Factors that the user has created in the 

profile. 

 User must select an entry from the dropdown. 

 Default is “Isobutylene”. 

Gas Response  For LEL sensors, shows a list of all MX6 Correlation Factors.   

 User must select an entry from the dropdown. 

 Default is “Pentane”. 

Enabled checkbox The default value will be “Checked”.  This control will only be 

enabled for MX6 instrument types.  For all prior instruments, this 

control will be “Checked” and Disabled. 
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Component Description 

PID Response Factor This dropdown field will only appear for MX6 PID sensors.  From 

this drop down, the user must select either a custom response factor 

or a ‘built-in’ response factor from the list to specify what type of 

gas the sensor should be configured to sense.  Custom response 

factors will be sorted alphabetically within the list of built-in 

response factors. 

LEL Correlation 

Factor 

This dropdown field will only appear for MX6 LEL sensors.  From 

this drop down, the user must select one of the provided correlation 

factors to specify what type of gas the sensor should be configured to 

sense. 

Alarm Low text box This field will hold the low alarm value to be applied to the senor 

type.  The value in this text box cannot be empty nor zero or less.  It 

also cannot have a decimal resolution of more than two. 

Alarm High text box This field will hold the high alarm value to be applied to the senor 

type.  The value in this text box cannot be empty nor zero or less.  It 

also cannot have a decimal resolution of more than two. 

Alarm STEL text box This field will hold the STEL alarm value to be applied to the senor 

type.  The value in this text box cannot be empty nor zero or less.  It 

also cannot have a decimal resolution of more than two.  This text 

box will be disabled for O2 and Combustible sensor types. 

Alarm TWA text box This field will hold the TWA alarm value to be applied to the senor 

type.  The value in this text box cannot be empty nor zero or less.  It 

also cannot have a decimal resolution of more than two.  This text 

box will be disabled for O2 and Combustible sensor types. 

Cal Gas Concentration 

text box 

This field will hold the Gas Concentration value to be applied to the 

senor type.  The value in this text box cannot be empty nor zero or 

less. 

Ok Button Clicking the OK button will first validate the information entered by 

the user and if there are no errors, the sensor component will be 

added to or updated within the profile. 

If validation fails, a variant of the following message will be 

displayed. 
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Component Description 

 

Cancel Button Clicking the cancel button will close the Add/Edit Profile 

Component form without applying any changes. 

 

The Response Factors tab of the Edit Profiles screen is used to display the profile Response 

Factor information.  It contains a list of the possible Response Factors, a list of custom response 

factors, and a list of favorite response factors for the instrument.  Also, there is an Edit Custom 

button and Clear Favorites button. 

 

 

Figure 3-75.  The Edit Profiles Screen – Response Factors Tab 

Table 3-9.  Components of the Response Factors Tab of the Edit Profiles Screen 

Element Description 

Response Factors list The Response Factors list displays all response factors 

available for the selected profile instrument type.  Each item in 

the list has a checkbox.  Clicking in the checkbox toggles the 

check on and off. 

Double-clicking on an item in the list also toggles the check on 

and off. “Checking” a response factor adds it to the Favorite 

Response Factor list.  “Un-checking” a response factor 

removes it from the Favorite Response Factor list. 

Custom Response Factors 

list 

The Custom Response Factor list displays all of the custom 

response factors currently available within the selected profile 

as well as their response factor value.  Each item in the list has 

a checkbox. 
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Element Description 

Clicking in the checkbox toggles the check on and off.  

Double-clicking on an item in the list also toggles the check on 

and off. 

Checking” a custom response factor adds it to the Favorite 

Response Factor list.  “Un-checking” a custom response factor 

removes it from the Favorite Response Factor list 

Response Factor Name 

column 

This is a customizable name for the custom response factor. 

Response Value column This is the response value for the custom response factor. 

Edit Custom button Used to edit the selected custom response factor. 

Remove Custom button Used to delete the selected custom response factor. 

Favorite Response Factors 

list 

Displays the selected response factors, standard or custom, 

which have been deemed a favorite.  A maximum of 5 

responses, in any combination of standard or custom, may be 

selected.  The order in which the favorite responses are 

selected is the order in which they will be saved to the 

instrument. 

Clear Favorites Used for removing the checks from the selected responses and 

thereby removing them from the Favorite Responses list. 

Edit Custom Clicking the Edit Custom button opens the Edit Custom 

Response Factor form. 

Edit Custom Response 

Factor form 

The Edit Custom Response Factor form will be used to modify 

the name and or value of the custom response value. 

 

Figure 3-76.  The Edit Custom Response Factor Screen 

Response Factor Name This is a customizable name for the custom response factor 

Response Value This is the response value for the custom response factor.  The 

maximum length allowed entered is 16 characters.  This can be 

a number from 0 to 99.99 inclusive. 
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3.15. Changing Your Password 

You can change the DSSAC password that was assigned to you.  You can change your password 

at any time.  To change your password, follow the instructions listed below. 

Step Instruction 

1. Click on the File menu, and select Change Password. 

2. The Change Current Password dialog box appears. 

 

Figure 3-77.  Change Current Password Dialog Box 

3. Enter your Current Password, your New Password, and your New Password Again 

for confirmation.  Click the OK button. 

NOTE:  Your password must be between 6 – 30 characters in length. 

4. Your password has been changed. 

 

 

    



 

 



 

 

 

Setting Up Users 

Chapter 

4 
 

4.1. Introduction 

This chapter explains how to create, change, and remove users in the DSSAC.  Only Systems 

Administrators can use this feature. 

4.2. Understanding Roles 

Before setting up users, you should have an understanding of the three roles that can be assigned 

to users.  The roles determine the functions that a user is permitted to perform.   

The roles in the DSSAC are:  

 Systems Administrator - Can perform all functions in the DSSAC. 

 Technician - Can perform functions related to configuration of instruments and 

IDSs, as well as change language settings and his/her own password.  They 

cannot perform user management tasks, modify default alarm settings, modify 

default calibration gases, or configure iNet options.  

 Guest - Can log in and view information in the DSSAC.  This is a read-only role. 

Typically, the Systems Administrator role should be given out to only select individuals.  Most 

users can perform their functions adequately with the Technician role.   

 

NOTE:  You can assign all roles to a user, however the highest role applies when the user 

accesses the DSSAC.   

 

4.3. Adding Users 

In order to use the DSSAC, a user must have a user account set up for him or her.  To add a user 

to the DSSAC, follow the instructions below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click the Users option in the navigation pane of the DSSAC.  A list of users appears 

in the contents pane. 

 



 

94 

 

3. Click on the File menu, and select Add.   

Alternative: You can also right-click on Users, and select Add from the context 

menu. 

4. The Add User dialog box appears. 

5. Enter the user‘s information in the dialog box.  Be sure to enter a unique user name 

for the person in the User Name field, and enter a password in both the Password and 

Password Again fields. 

 

Figure 4-1.  Add User Dialog Box 

NOTE:  The user is “Active” by default when it is first created. 

6. To select roles, click in the checkbox next to the role you wish to assign to the user.  

You must assign at least one role to the user. 

7. Click the OK button when complete.  The user appears in the Users contents pane. 
 

4.4. Changing User Properties 

Once a user is created, you may need to update his/her personal information.  For example, you 

may need to reset a password if the user forgets his/her current password or you may want to 

limit the information that the user can see to information only regarding his or her location..   

To change user properties, follow the instructions listed below.   

Step Instruction 

1. Click the Users option in the navigation pane of the DSSAC.  A list of users appears in the 

contents pane. 

 



 

95 

 

2. Double-click on the user whose information you would like to change. 

Alternative:  You can also right-click on the user and select Properties. 

Alternative:  You can also select the user, and then click on the File menu, and select 

Properties. 

3. The Edit User dialog box appears. 

 

Figure 4-2.  Edit User Dialog Box 

4. Change the data that needs to be updated. 

NOTE:  You cannot change the User Name. 

NOTE:  If you change the password, remember to enter it twice; once in the Password 

field and a second time in the Password Again field. 

NOTE:  You cannot change the roles assigned to the account with which you are currently 

logged into the DSSAC.  Also, the Active check box is grayed out and may not be edited 

for the current user. 

5. If you wish to inactivate the account, de-select the checkmark next to the Active option.  

This prevents the user from logging into the DSSAC.  To re-activate an account, click the 

Active option so that a checkmark appears. 

6. Click the OK button to save your changes and return to the user list.  If you click the 

Cancel button, your changes are not saved. 
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7. If you wish to limit the locations from which the user can see information, click on the 

Login Preferences tab.  The Login Preferences dialog box appears.  All available locations 

or registered instruments and docking stations will be shown according to the Location 

column of the instrument or docking station listing. 

8. Check the boxes under Available Locations of the locations that user should be able to 

view information for.  Checking the Show only selected box will limit the list for that user 

to those locations selected.  If the selection has been previously limited, checking the 

Show all locations box will place all locations back in the user list. 

9. Click the OK button to save your changes and return to the user list.  If you click the 

Cancel button, your changes are not saved. 

 

4.5. Removing Users 

You may wish to remove a user account completely from the system.  Only do this when you are 

sure that the user account is no longer going to be used.  To remove a user account, follow the 

instructions below. 

Step Instruction 

1. Click the Users option in the navigation pane of the DSSAC.  A list of users appears 

in the contents pane. 

2. Click on the user that you wish to remove.  You can select multiple users by pressing 

the CTRL key on your keyboard while clicking on each user. 

3. Click on the File menu, and select Remove. 

Alternative:  You can also right-click on the user and select Remove from the context 

menu. 

4. A confirmation prompt appears.  Click Yes to confirm that you wish to remove the 

user(s).  Otherwise, click No to cancel the action. 

5. The selected users are deleted from the system. 

 

 

Note:  You cannot delete the account with which you are currently logged in to the DSSAC.  

Also, you cannot delete the default DSS User account. 

 

 

 

     



 

 

 

Configuring Instruments 

Chapter 

5 
 

5.1. Introduction 

The DSX docking station was designed for use with several Industrial Scientific instruments.  

When these instruments are docked in the appropriate IDS, the docking station system 

automatically detects them.  While docked, the instruments can take full advantage of automatic 

calibrations and bump tests, as well as datalog data management that docking station provides. 

5.2. Instrument Compatibility 

The IDS only accepts the type of instrument it was designed for: 

 GasBadge® Pro 

 MX6 iBrid™ Multigas Monitor 

 Tango™ TX1 

 Ventis ™ Pro4 

 Ventis ™ Pro5 

 Ventis™ LS Multigas Monitor 

 Ventis™ MX4 Multigas Monitor  

 

Be sure that you are using the correct IDS for the instrument you are setting up.  

Certain legacy instruments are not compatible with the DSX Docking Stations, but their 

information can be entered manually for record keeping.  The legacy instruments whose 

information can be entered into the system are listed in  

Table 5-1.  Legacy Instruments 

 

Model Number Legacy Instrument 

ATX612 Multi-Gas Aspirated Monitor 

ATX620 Multi-Gas Aspirated Monitor  

CD210 Digital Methanometer 

CD211 Methane Detector  

CDU440 Carbon Monoxide Monitor 
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5.3. Setting Up an Instrument 

The IDS contains a cradle that is designed to hold one of the compatible instruments (GasBadge 

Pro, Tango TX1, Ventis Pro4, Ventis Pro5, Ventis MX4 , Ventis LS, or the MX6 iBRID).  The 

first time that an instrument is docked, the Docking Station Server detects it, and adds its 

information into the system. 

The IDS only accepts the type of instrument it was designed for.  Be sure that you are using the 

correct IDS for the instrument you are setting up. 

To set up an instrument, follow the instructions listed below. 

Step Instruction 

1. Place the instrument securely into the IDS cradle.   

 

Model Number Legacy Instrument 

CL266 Chlorine Monitor 

CMX270 Combination Oxygen/Methane/Carbon Monoxide Gas Monitor 

CMX271 Combination Oxygen/LEL/Carbon Monoxide Gas Monitor  

CO262 Carbon Monoxide Monitor 

HMX271 Combination Oxygen/LEL/Hydrogen Sulfide Gas Monitor  

HS110 Hydrogen Sulfide Monitor 

HS560 Hydrogen Sulfide Monitor 

LD322 Combustible Gas Monitor 

LTX310 Multigas Monitor 

LTX311 Multigas Monitor 

LTX312 Multigas Monitor 

MDU440 Dual-Range Methane Monitor 

MG140 Four Gas Monitor 

MX250 Combination Oxygen/Methane Gas Monitor 

MX251 Combination Oxygen/LEL Gas Monitor 

STX70 Single Gas Monitor/SewerGuard 

T40 Rattler Single Gas Monitor 

T80 Single Gas Monitor 

TMX410 Multigas Monitor 

TMX412 Multigas Monitor 

TX418 Multigas Monitor 
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2. Be sure that the IDS is powered 

on, and is connected to the 

network.  (See Chapter 6 for 

information about setting up and 

configuring the IDS.)  

LCD Screen 

 

LEDs 

Green (top) 

Amber (middle) 

Red (bottom) 

 

3. The Docking Station Server 

detects the instrument and 

registers it in the system.  The 

LCD screen on the IDS displays 

“Discovering.”  The yellow LED 

is illuminated. Left Arrow 
Key 

Enter Key Right Arrow 
Key 

Figure 5-1.  Front Panel of a DSX-L  

 

NOTE:  When docking an instrument that has already been registered, the LCD on the IDS also 

displays “Discovering” while it determines which instrument has just been docked.   

 

Step Instruction 

4. When the LCD displays and the green LED is illuminated, the instrument has been 

registered and is now ready to be used in the docking station system.  
 

If any events are scheduled for the instrument, they automatically occur after the instrument is 

docked.  In order to successfully complete the calibrations and bump tests, ensure that the proper 

gas cylinders are connected and configured for use on the IDS.  See section 6.6: Configuring Gas 

Cylinders for information about setting up an IDS to use gas cylinders.   

 

NOTE:  For information of adding legacy instruments, removing instruments, and using the find 

instrument feature, refer to section 5.17. 

 

5.4. Instrument Properties 

Once the Docking Station Server has detected the instrument, and added the instrument’s 

information into the system, the instrument’s properties can be viewed in the DSSAC.  The 

DSSAC can also be used to: 

 update instrument options and alarms 

 review calibration and bump test results 

 view datalog data. 

To view an instrument’s properties, follow the instructions listed below. 
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Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

NOTE:  Any instrument that is currently docked appears in blue. 

3. Double-click on the instrument whose properties you wish to view. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu.   

Alternative:  You can also select the instrument, and then click on the File menu, and 

select Properties.   
 

 

Figure 5-2.  Instruments Option in the Navigation Pane 

 

Step Instruction 

4. The Edit Instrument dialog box appears.  Refer to Figure 5-3. 

NOTE:  If you are viewing a compatible instrument, many of the fields cannot be 

changed since they are automatically configured by the system.  If you are viewing a 

legacy instrument, additional fields can be modified.   

5. The Edit Instrument dialog box contains the tabs shown in Figure 5-. 

Each of these tabs is explained in the sections that follow. 

6. If you made any changes that you would like to save, click the OK button.  

Otherwise, click the Cancel button. 
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Figure 5-3.  Edit Instrument Dialog Box 

 

NOTE:  Certain reserved characters may not be used in fields.  Unacceptable characters include 

the following. 

 > greater than 

 < less than 

 & ampersand 

 % percent 

 

If the user types any of these keys, nothing will appear.  The application ignores these key-stokes 

if the user attempts to use them when creating a new user or new site (Users and Sites tab of the 

Edit Instrument screen), as well as on the Status field (General tab of the Edit Instrument screen) 

and Location field (General tab of the Edit Docking Station screen). 

 

 

NOTE:  The Datalog tab is only available for docking station compatible instruments.   
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5.5. Edit Instrument – The General Tab 

The contents of the General Tab are explained in the table below. 

 

Figure 5-4.  Edit Instruments – General Tab 

 

Table 5-2.  Fields in the Event Journal Details Screen 

Field Description 

Serial Number  Displays the serial number of the instrument.   

Type  

Displays the instrument type.  For example: 

 GasBadge Pro Single-Gas Monitor 

 Tango TX1 Single-Gas Monitor 

 MX6 iBrid Multi-Gas Monitor 

 Ventis Pro4 

 Ventis Pro5 

 Ventis MX4 

 Ventis LS 

 any one of the legacy instrument types. 

This is displayed as text via a drop-down box. 

Part Number  Displays the Industrial Scientific part number for the instrument. 

Job Number The user-supplied job number associated with this instrument (optional). 

Setup Technician The name of the technician who configured this instrument (optional). 

Setup Date  Displays the manufacture date of the instrument. 

Software Version  Displays the current version of the software installed in the instrument.   
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Field Description 

Operation 

Minutes  

Displays the number of minutes that the instrument has been in operation.  

This field does not apply to legacy instruments.  For docking station 

compatible instruments, Operation Minutes is updated by the system. 

Status  Displays a text field that can be used to identify the status of the 

instrument.  The status displays in the instrument’s contents pane in the 

DSSAC.   

Location Last 

Docked 

A read-only text box that displays the “Location” value of the docking 

station upon which it was last docked.  

Access Code  The password required to use certain features of the instrument.  Only 

users assigned to the Systems Administrator role can see the contents of 

the Access Code field.   

5.6. Edit Instrument – The Options Tab 

Instrument options can be set in two ways:  

 on the instrument itself 

 by using the DSSAC application.   

The options in the DSSAC will always take precedence over the settings on the instrument.  If 

settings are changed on the instrument, they are overridden by the DSX-L docking station system 

when the instrument is next docked.  If settings are changed using the DSSAC, they are 

transferred to the instrument when the instrument is next docked.   

 

NOTE: Instrument options are only available for Docking station compatible instruments.   

 

5.6.1. Setting Instrument Options from the Instrument Itself 

For information about the specific options for an instrument and their purposes, please refer to 

your Instruction Manual for the instrument.  The Instruction Manual also describes how to 

change the settings on the instrument.  This user guide only covers how to change instrument 

settings using the DSSAC.   

5.6.2. Setting Instrument Options from the DSSAC Application 

To change instrument settings using the DSSAC, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument whose options you wish to change.   

Alternative:  You can also right-click on the instrument and select Properties from the 

context menu.   

Alternative:  You can also select the instrument, and click the File menu and select 
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Step Instruction 

Properties.   

4. Click on the Options tab.  Instrument options are displayed in separate fields on the 

left and a tree-like structure on the right.  You can find any setting under the category 

All or in a specific category, such as Basic or Survey.   A checkmark is displayed next 

to any setting that is enabled. 

5. To change a setting, click in the checkbox next to a setting or edit the appropriate 

fields.  For check boxes, clicking in the checkbox toggles whether or not it is 

enabled/disabled.  You can also select all settings in a category by clicking in the 

checkbox next to the category name.  For example, to select all Survey options, click 

in the box next to Survey.  You can then de-select individual options in the category, 

if desired. 

6. Click OK to save your changes.  Otherwise, click Cancel to close the Edit Instrument 

dialog box without saving your changes. 

 

NOTE: The Options tab is only available for Docking station compatible instruments.   

 

 

Figure 5-5.  The Options Tab of the Edit Instrument Dialog Box 

Key fields on this screen are shown in the table that follows. 
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NOTE:  The settings update occurs after the instrument is docked.  If you change settings while 

an instrument is docked, you must undock and then re-dock the instrument for the changes to 

take effect.   

Table 5-3.  Components of the Options Tab 

Component Description 

Backlight Displays “Timed”.  Dropdown is grayed out. 

Backlight Timeout Displays the Backlight timeout duration in seconds if Backlight 

mode is timed. 

Display Mode  Displays the current Display Mode.  Possible values are “Text”,  

“Numeric” and “Graphical”. 

Clock/Temp Display Mode Indicates whether the instrument will display the “Clock”, 

“Temperature” or both. 

PID/LEL Display Mode Indicates whether the instrument will display the “PID Response 

Factor”, the “LEL Correlation Factor” or both. 

Datalog Option  Displays “Installed”.  Dropdown is grayed out. 

Datalog Mode Display whether the datalog mode is “Enabled”, “Snapshot” or 

“Event Logging”. 

Recording Interval  Displays the current recording interval for the datalogger.   This 

must be between 1 and 300 seconds in increments of 1 second.  

Default value: 60 seconds. 

TWA Time Base  Displays the current TWA Time Base for the instrument.    This 

field must be an integer between 0 and 40.  Default value: 8. 

Calibration Overdue  Displays the current Calibration Overdue Warning indication. 

Bump Test Overdue  Displays the current Bump test  Overdue Warning indication. 

Bump Interval Displays the current Bump interval in intervals of 0.5 days. 

Bump Threshold The percentage concentration of gas (from 50% to 99%) that 

must be seen in order for a bump test to pass.  The default value 

for this field is 50%. 

Bump Timeout The maximum amount of time (from 30 to 300 seconds, given in 

5-second increments) after a bump test is initiated that a docking 

station will wait to complete/pass the test, before ultimately 

aborting and failing the bump test.  The default value for this 

field is 120 seconds. 

Calibration Date on Startup Displays the last/next Calibration date of display on instrument 

start up. 

Calibration Display Mode Displays the Calibration date display mode on instrument. 

Magnetic field Duration Displays the current magnetic field duration in seconds for TX1 



 

106 

 

instruments only. 

Confidence Indicator type Displays the current confidence indication type for MX4 

instruments only. 

Dock overdue warning Displays the dock overdue warning indication for Ventis Pro 

instruments only. 

Dock Interval Displays the number of Days between Docks in increments of 1 

day for Ventis Pro instruments only. This field must be a whole 

number between 1 to 31.  

Date format Displays the Date Format display on instrument for Ventis Pro 

instruments only. 

Toxic display units Displays the toxic measurement unit type on the instrument for 

Ventis Pro instruments only. 

Temperature units Displays the Celsius-Fahrenheit mode of temperature display on 

the instrument for Ventis Pro instruments only. 

Company Message Displays the company Message text to be display on startup for 

Ventis Pro instruments only. 

Man-Down Warning 

Interval 

Displays the length of time between the man-down warning and 

man-down alarm for Ventis Pro instruments only. This field 

must be a whole number between 30 to 300.  

Calibration Interval Displays current calibration interval in increments of 1 day for 

Ventis Pro instruments only. This field must be a whole number 

between 1 to 365.  

 

5.7. Edit Instrument – The Users and Sites Tab 

Some instruments have the ability to record user and site information with the datalog feature.  

This information can then be downloaded with the datalog data. 

User and Site information can be maintained using the DSSAC, and then transferred to the 

instrument the next time it is docked.   

To manage User and Site data, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 
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Step Instruction 

3. Double-click on the instrument whose Users and Sites information you wish to view 

or change. 

Alternative:  You can also right-click on the instrument and select Properties from the 

context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 

4. Click on the Users and Sites tab. 

5. User information is displayed in the top half of the dialog box, while Site information 

is displayed in the lower half of the dialog box.  The instructions that follow can be 

applied to both the User section and the Site section. 

6. The Users / Sites section contains two lists.  The list on the left (All Instrument Users / 

All Instrument Sites) displays the user or site names available in the system.  The list 

on the right (Current Instrument Users / Current Instrument Sites) contains the users / 

sites stored in the current instrument. 
 

 

NOTE:   Only instruments that have a Users and Sites feature display this tab in DSSAC.   

 

 

Figure 5-6.  The Users and Sites Tab of the Edit Instrument Dialog Box 

Step Instruction 

7. To add a new User or Site, type the name in the text box under the Current 

Instrument Users or Current Instrument Sites field, and then click the Add New 

button.  The name is added to the Current Instrument Users / Current Instrument 

Sites list.  Once saved, the name can also be used on the Users and Sites tab for other 

instruments. 
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Step Instruction 

8. To add a user or site from the existing names in the system, select the name in the All 

Instrument Users / All Instrument Sites list and click the Add button. 

9. To remove a user or site from the instrument, select the name you wish to remove 

from the Current Instrument Users / Current Instrument Sites list, and click the 

Remove button.  The name is removed from the list.   

10. You can select multiple user or site names by pressing the CTRL key on your 

keyboard while clicking on each name that you would like to include. 

11. Click the OK button on the Edit Instrument dialog box to save your changes. 

 

5.8. Edit Instrument – The Components Tab 

5.8.1. Overview 

Instrument components are accessory parts of an instrument, such as batteries and sensors.  

Component information is maintained using the DSSAC.  For compatible instruments, 

information about these components is automatically detected and stored in the DSX docking 

station system.  For legacy instruments, component information can be manually added to the 

system using the Edit Instrument dialog box. 

To view component information, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument whose components you wish to view or change.   

Alternative:  You can also right-click on the instrument and select Properties from the 

context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 
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Step Instruction 

4. Click on the Components tab.  A screen containing a list of components appears.  

Installed components are shown in blue.  The Uninstall Date column contains the date 

the component was uninstalled.  If the component is currently installed, then this field 

is blank.  The Components tab contains the following columns. 

Field Description 

Type Displays the type of device (i.e., battery pack, sensor, etc.). 

Position For MX6 instruments, this is the position of the sensor.  Battery 

packs are shown as “N/A”. 

Enabled This column indicates the status of the listed components.  Only 

currently installed components will have a value in this column.  

Batteries will always show “N/A”.  Sensors will either show “Yes” 

for enabled or “No” for not.  For all instrument except the MX6, 

this column will display “Yes” for all installed sensors.  For the 

MX6, the column will reflect the actual state of the sensor. 

Serial 

Number 

Displays the serial number of the component.  

Part Number Displays the part number of the component. 

Install Date Shows the date and time when the component was installed. 

Uninstall 

Date 

Shows the date and time when the component was uninstalled. 

    

 

 

Figure 5-7.  The Components Tab of the Edit Instrument Dialog Box 
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Step Instruction 

5. Optionally, select an option in the Filter By field.  If you select “Batteries,” then the list 

displays only batteries.  If you select “Sensors,” then the list displays only sensors.  

Selecting “All” displays the entire list of installed components. 

6. To view a component, double-click on its entry in the list.   

7. If you selected a battery, the Edit Battery dialog box appears.  See the table below for an 

explanation of the fields on the Edit Battery tab. 

 

Figure 5-8.  The Edit Battery Dialog Box 

NOTE:  You cannot edit the properties of a battery once it is installed.  If you need to 

change the properties, remove the battery, and then reinstall it.   
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8. If you selected a sensor, the Edit Sensor dialog box appears.   

 

Figure 5-9.  The Edit Sensor Dialog Box 

9. The Edit Sensor dialog box contains three tabs. 

Tab Description 

Sensor Displays general sensor information.   

Calibrations Used to display results of calibration tests specific to the sensor.   

Bump Tests Used to display results of bump tests specific to the sensor.   
 

10. Click the OK button to close the Edit Battery or Edit Sensor dialog box. 
 

Table 5-4.  Fields in the Edit Battery Dialog Box 

Field Description 

Serial Number  The serial number of the battery.   

Type  The battery type.   

Part Number  The part number for the battery.   

Manufacturer  
The manufacturer of the battery, e.g., Industrial Scientific 

Corporation.   

Install Date  

The date that the battery was first installed in the instrument.  For 

docking station compatible instruments, this is the date that the 

DSS first detected the battery.  For legacy instruments, it is the 

date that the battery was added using the DSSAC application.   

Operation Minutes The number of minutes that the battery has been in use. 

Software Version The software version of the battery (if available). 
 

NOTE:  The battery screens are grayed out (and therefore may not be edited) for dockable 

instruments. 
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Table 5-5.  Fields in the Edit Sensor Dialog Box (Sensor Tab) 

Field Description 

Serial Number  The serial number of the sensor.   

Type  The sensor type, e.g., Chlorine Sensor, Carbon Monoxide Sensor.   

Part Number  The part number for the sensor.   

Manufacturer  The manufacturer of the sensor, e.g., Industrial Scientific Corporation.   

Install Date  The date on which the sensor was first installed in the instrument.  For 

Docking station compatible instruments, this is the date that the DSS 

first detected the sensor.  For legacy instruments, it is the date that the 

sensor was added using the DSSAC application.   

Position  The position of the sensor in the instrument.   

Setup Date  The date on which the sensor was manufactured.   

Enabled checkbox This check box determines if the sensor type should be enabled or 

disabled within the instrument.  This control will only be enabled for 

MX6 instrument types.  For all other instruments, this control is 

“Checked” and Disabled.  The default value is “Checked” 

PID Response 

Factor 

This dropdown field will only appear for MX6 PID sensors.  From this 

drop down, the user must select either a custom response factor or a 

‘built-in’ response factor from the list to specify what type of gas the 

sensor should be configured to sense.  Custom response factors will be 

sorted alphabetically within the list of built-in response factors. 

LEL Correlation 

Factor 

This dropdown field will only appear for MX6 LEL sensors.  From this 

drop down, the user must select one of the provided correlation factors 

to specify what type of gas the sensor should be configured to sense.  

NOTE:  For non-PID an non-LEL sensors, no Response Factor or 

Correlation Factor field will be shown. 

Calibration Gas  The type of calibration gas to use to calibrate the sensor.   

Gas Concentration  The concentration of gas to use to calibrate the sensor.   

Alarm High  The gas reading that triggers a high alarm.   

Alarm Low  The gas reading that triggers a low alarm.   

Alarm STEL  The threshold that a Short Term Exposure Limit (STEL) reading must 

cross to trigger an alarm.   

Alarm TWA  The threshold that a Time Weighted Average (TWA) reading must cross 

to trigger an alarm.   

Gas Alert The gas reading that triggers a warning, which indicates the level of gas 

present may be approaching alarm levels.   

For O2 sensors, setting is supposed to be between low and high alarm. 
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5.8.2. Adding Components 

If an instrument is not a docking station compatible instrument, you can manually add or remove 

component information.   To add components, follow the instructions listed below.  

Step Instruction 

1. Open the DSSAC application.   

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments.   

3. Double-click on the instrument for which you would like to add components. 

Alternative:  You can also right-click on the instrument and select Properties from the 

context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 

4. Click on the Components tab.  A screen containing a list of installed components 

appears. 

5. Click the Install button.   

6. The Add Battery or Add Sensor dialog box appears.  Select the type of component you 

wish to add and complete the fields.  See the tables above for the fields used to 

describe batteries and sensors.   

7. Click OK to add the component to the instrument. 

8. Click the OK button on the Edit Instrument dialog box to save your changes. 
 

NOTE:  The title of the dialog box will change depending on the type of component selected.   

 

 

Figure 5-10.  The Add Battery Dialog Box 
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5.8.3. Removing Components 

If an instrument is not a Docking station compatible instrument, you can manually add or remove 

component information.  To remove components, follow the instructions listed below.  

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument for which you would like to remove components.   

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu.   

Alternative:  You can also select the instrument, and click the File menu and select 

Properties.   

4. Click on the Components tab.  A screen containing a list of installed components 

appears. 

5. Select the component you would like to remove.  You can select multiple 

components by pressing the CTRL key on your keyboard while clicking on each 

component. 

6. Click the Uninstall button. 

7. A confirmation prompt appears.  Click Yes to remove the component. 

8. Click the OK button on the Edit Instrument dialog box to save your changes. 

  

5.9. Edit Instrument – The Response Factors Tab 

The Response Factor Tab of the Edit Instrument screen displays the instrument Response Factor 

information.  It contains a list of the possible Response factors, a list of custom response factors 

and a list of favorite response factors for the instrument.  Also, there is an Edit Custom button 

and Clear Favorites button. 
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Figure 5-11.  The Response Factors Tab of the Edit Instrument Screen 

 

Table 5-6.  Fields in the Edit Instrument Screen (Response Factors Tab) 

Element Description 

Response Factors list The Response Factor list displays all response factors available for 

the selected instrument type.  Each item in the list has a checkbox.   

Clicking in the checkbox toggles the check on and off.  Double-

clicking on an item in the list toggles the check on and off.  

“Checking” a response factor will add it to the Favorite Response 

Factor list.  “Un-checking” a response factor removes it to the 

Favorite Response Factor list. 

Custom Response 

Factors list 

The Custom Response Factor list displays all of the custom 

response factors currently available within the selected instrument 

as well as its response factor value.  Each item in the list has a 

checkbox.  Clicking in the checkbox toggles the check on and off.  

Double-clicking on an item in the list toggles the check on and off.  

“Checking” a custom response factor adds it to the Favorite 

Response Factor list.  “Un-checking” a custom response factor  

removes it from the Favorite Response Factor list.   

Response Factor Name - This is a customizable name for the 

custom response factor.  The maximum length allowed entered is 16 

characters. 

Response Value - This is the response value for the custom 

response factor.  Each item in the list has a checkbox.  Clicking in 

the checkbox toggles the check on and off.  This can be a number 
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Element Description 

from 0 to 99.99 inclusive.   

Double-clicking on an item in the list toggles the check on and off.   

“Checking” a custom response factor adds it to the Favorite 

Response Factor list.  “Un-checking” a custom response factor 

removes it to the Favorite Response Factor list.   

Edit Custom Button The Edit Custom button is used to edit the selected custom response 

factor.  Clicking the edit Custom button opens the Edit Custom 

Response Factor form.  The Edit Custom Response Factor form is 

used to modify the name and or value of the custom response value. 

Remove Custom Button The Remove Custom button is used to delete the selected custom 

response factor.  When a Custom response factor is removed, then 

any installed PID sensor currently configured to use that custom 

response factor is automatically reverted back to Isobutylene. 

Favorite Response 

Factors list 

The Favorite Response Factor list displays the selected response 

factors, standard or custom, which have been deemed a favorite.  A 

maximum of 5 responses, in any combination of standard or 

custom, may be selected.  The order in which the favorite responses 

are selected is the order in which they are saved to the instrument 

Clear Favorites Button The Clear Favorites button is used for removing the checks from the 

selected responses, thus removing them from the Favorite 

Responses list. 
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5.10. Edit Instrument – The Profiles Tab 

The Profiles tab within the Edit Instrument screen is present only for MX6 instruments.  The 

Profiles tab allows an Admin User to assign up to five profiles to the current MX6 instrument. 

 

Figure 5-12.  The Profiles Tab of the Edit Instrument Screen 

 

Table 5-7.  Fields in the Edit Instrument Screen (Profiles Tab) 

Component Description 

Available Profiles list 

box 

The Available Profiles list box displays all profiles currently 

available for the current instrument based on the instrument type.  

Double-clicking a Profile in the Available Profiles list box removes 

that Profile from the list and adds it to the Current Instrument 

Profiles list box. 

Current Instrument 

Profiles list box 

The Current Instrument Profiles list box displays the possible five 

profiles assigned to the current instrument.  The Current Instrument 

Profiles list box shows 0 to 5 profiles, depending on how many are 

currently assigned the instrument. 

Double-clicking a Profile in the Current Instrument Profiles list box 

removes that Profile from the list and adds it to the Available 

Profiles list box. 

Double-clicking a Profile in the Available Profiles list box while 

there are already five Profiles listed in the Current Instrument 

Profiles list box, displays the following message and the profile is 

not moved. 
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Component Description 

 

Figure 5-13.  Validation Error Screen 

Add button The Add button assigns the selected profile to the instrument.  If 

there is no profile selected in the Available Profiles list box when the 

user presses the Add button, nothing happens.   

Pressing the Add button while a Profile in the Available Profiles list 

box is selected removes that Profile from the list and adds it to the 

Current Instrument Profiles list box 

If the user presses the Add button while a Profile is selected in the 

Available Profiles list box and there are already five Profiles listed in 

the Current Instrument Profiles list box, the previous validation error  

message is displayed and the profile is not moved. 

Remove button The Remove button removes the selected profile from the assigned 

list.  If there is no profile selected in the Current Instrument Profiles 

list box when the user presses the Remove button, nothing happens. 

Pressing the Remove button while a Profile in the Current Instrument 

Profiles list box is selected removes that Profile from the list and 

adds it back to the Available Profiles list box. 

5.11. Edit Instrument – The Notes Tab 

5.11.1. Overview 

Instrument Notes are comments about an instrument that you can store in the system.  You can 

also remove notes that no longer apply to the instrument.  To maintain instrument notes, follow 

the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument whose notes you wish to view or change. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 

4. Click on the Notes tab.  A screen containing a list of notes appears.   
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Step Instruction 

5. To view a note, double-click its entry in the list.   

6. To add a note, click the Add button.  The Add Note dialog box appears. 

7. Enter your note and then click the OK button.  The Note has been saved.   

NOTE:  You may not change a note once it has been saved. 

8. To remove a note, select the note and then click the Remove button.  A confirmation 

prompt appears.  Click Yes to remove the note. 

9. Click the OK button or the Cancel button to close the Edit Instrument dialog box. 
 

 

Figure 5-14.  The Notes Tab of the Edit Instrument Dialog Box 

 

Figure 5-15.  The Add Note Dialog Box 
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5.11.2. Sample Application Using Notes Field – iNet Exchange Instruments 

In order to indicate that an instrument is a replacement for another instrument, the following 

must apply. 

 The replacement instrument must be new to the DS2 Database in question.  If the 

replacement instrument is already in the database (even if “removed”), it will not be 

recognized by the DSX. 

 The serial number of the instrument being replaced should be entered into both the Active 

User and Active Site field of the replacement instrument before it is docked for the first 

time on the target system. 

 For those dockable instruments in which DSX does not support Active User and Active 

Site, a list containing a single user and a list containing a single site should be entered, 

with both the user and the site being the serial number of the instrument to be replaced.   

Note:  This would normally be done by ISC personnel before the instrument is sent to the 

customer.   The customer system would be considered the target system. 

The replacement serial number can be entered into the user & site field either by 

DataLink or by manually using the keypad, if the instrument supports keypad entry. 

The replacement serial number should not be added to the user and site fields using 

DSSAC.  Although this may work, it is not a recommended practice because the DSX 

may at that time trigger the replacement logic. 

For instruments with a list of users and sites, the list must contain only this 1 entry, which 

is the serial number of the instrument being replaced. 

The serial number must be exactly the same as the number programmed into the 

replacement instrument, including any dashes or lack of dashes. 

The serial number must be exactly the same in both the user and site field. 

If all the above conditions are met, the DSX will trigger a replacement algorithm when the 

replacement instrument is docked for the first time.  The new instrument will be given all the 

settings of the old instrument.  The old instrument will be “removed” automatically.  The old 

instrument will then act like any other “removed” instrument.  The old instrument will be given a 

“Note” visible through DSSAC indicating when it was replaced and which instrument replaced it. 
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Figure 5-16.  Sample Note for Exchanging Instruments 

 

The following settings will be copied from the old instrument to the new one: 

 Access code 

 Backlight setting 

 Language 

 Location 

 Recording interval 

 Status 

 TWA timebase 

 All options 

 All users 

 All sites. 

Copying of sensor settings occurs according to the following rules. 

 When the replacement instrument has a sensor of the same sensor type in the same 

position as the original, the sensor settings will be copied. 

If the replacement instrument is missing 1 or more sensors that were present in the 

original instrument, the settings will still be copied for the sensors that are present. 

If the replacement instrument has a sensor of a type which was not present in the original 

instrument, the settings of that sensor will not be changed. 

If the replacement instrument has 1 sensor which is the same type as the original, but it is 

in a different position, the settings for that sensor will still be copied. 

If the replacement instrument has 2 sensors of same type, 1 in the same position as the 

original instrument, and 1 in a different position, only the sensor in the correct position 

will be modified. 

If original instrument has sensor of type A in positions 1 and 2, and replacement 

instrument has sensor of type A in position 1 only, then only the settings from position 1 

should be copied to the replacement instrument. 

 

 The sensor settings that will be copied are as follows: 

- Alarms settings 

- Calibration gas 

- Calibration gas concentration 

- Gas detected 

- Response Factor. 
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5.12. Edit Instrument – The Calibrations Tab 

5.12.1. Overview 

A calibration is a test that is used to detect inaccuracies in an instrument’s sensors and make 

minor adjustments if necessary.  When a calibration is performed on an IDS, the results are sent 

from the IDS to the docking station system.   

Calibration results can be viewed in the DSSAC for an instrument, or for an individual sensor.   

 

NOTE:  Calibration data can also be entered into the system manually using the DSSAC.  For 

example, if you performed a hand calibration on an instrument, you may wish to store the results 

in the docking station database.   

 

To view calibration results for an instrument, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument whose calibration information you wish to view. 

4. Click on the Calibrations tab. 

5. Do one of the following: 

 Click the Show Last button to display the results of the last calibration for 

each of the sensors in the instrument. 

 Select a Start Date and an End Date, and then click the Display button to 

show calibration results for a specific date range.   

6. The calibration results appear in the list. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties.   
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Figure 5-17. Calibrations Tab of the Edit Instrument Dialog Box 

 

Figure 5-18.  Displaying Calibration Information 

 

The following information is displayed for each calibration:  

 Serial Number -The serial number of the sensor  

 Time -The date and time on which the calibration was performed  

 Gas Type - The type of gas that was used for the calibration  

 Passed/Failed -Whether or not the sensor passed the calibration.  (Failed entries also 

display in red.)  Options are “Passed”, “Span failed” (if the instrument times out before 
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the IDS does), and “Failed” (if the IDS times out before the instrument does), although 

the user should only ever see “Passed” or “Span failed.” 

 Full Span Reserve - The Full Span Reserve measurement of the sensor at the time of the 

calibration.   

 Automated/Manual – Whether the calibration was performed automatically on the 

docking station, or manually by the user. 

To view the details of a calibration, follow the instructions listed below. 

Step Instruction 

1. To view the details of a calibration, double-click on its entry in the list. 

Alternative:  You can also right-click on the entry and select Properties from the 

context menu. 

2. The Gas Responses dialog box appears.  See the table below for an explanation of the 

fields in the Gas Responses dialog box. 

3. Click OK or Cancel to return to the Edit Instrument dialog box.   

 

 

Figure 5-19.  The Gas Responses Dialog Box 

You can also view calibration results for each individual sensor in an instrument that contains 

multiple sensors. 

To view calibration results for an individual sensor, follow the instructions listed below. 
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Table 5-8.  Fields in the Gas Responses Dialog Box (Calibrations Tab) 

Field Description 

Serial Number  The serial number of the sensor.   

Gas Type  The type of gas that is used to perform the calibration  

Passed 
Whether or not the sensor passed the calibration.  Values can be 

“Passed” or “Failed.” 

Gas Concentration The concentration of gas in the gas cylinder. 

Reading 
The concentration reading that the instrument took during the 

calibration. 

Date The date on which the calibration was performed. 

Time The time at which the calibration was performed. 

Accessory Pump Whether or not the instrument has an accessory pump. 
 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument whose calibration information you wish to view.   

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties.   

4. Click on the Components tab. 

5. Double-click on the sensor whose calibration results you wish to view. 

Alternative:  You can also right-click on the sensor entry and select Properties from 

the context menu.   

6. The Edit Sensor dialog box appears.  Click on the Calibrations tab. 

7. Do one of the following:  

 Click the Show Last button to display the results of the last calibration. 

 Select a Start Date and an End Date, and then click the Display button to 

show calibration results for a specific date range. 

8. The calibration results appear in the list.  You can sort the calibration results by 

clicking on the column heading by which you would like to sort. 

9. To view the details of a calibration, double-click on its entry in the list. 

Alternative:  You can also right-click on the entry and select Properties from the 

context menu. 
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Step Instruction 

10. The Gas Responses dialog box appears.  See the table above for an explanation of the 

fields in the Gas Responses dialog box. 
 

 

Figure 5-20.  The Calibrations Dialog Box 

 

5.12.2. Adding Calibration Data 

You can also manually add calibration data to the system.  You can use the instrument properties 

or the properties of an individual sensor to add calibration data. 

 

NOTE: For legacy instruments, be sure that you have added sensor information to the 

Components tab of the instrument before you add calibration data.  Refer to section 5.8 The 

Components Tab for more information about adding sensor information.   

 

To add calibration data using instrument properties, follow the instructions below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument for which you would like to add calibration data. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties.   
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4. Click on the Calibrations tab.   

5. Click the Add button.  The Gas Responses dialog box appears.   

6. Enter the data for each calibration, and then click the Add button to add it to the list. 

7. Click the OK button when you have finished adding calibration results in order to 

save them to the system.  The results display on the Calibrations tab. 
  

 

Figure 5-21.  The Gas Responses Dialog Box – Serial Number Field 
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To add calibration data to an individual sensor, follow the instruction listed below. 

Step Instruction 

1. Open the DSSAC application.   

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument for which you would like to add calibration 

information. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu.   

Alternative:  You can also select the instrument, and click the File menu and select 

Properties.   

4. Click on the Components tab. 

5. Double-click on the sensor for which you would like to add calibration information. 

Alternative:  You can also right-click on the sensor entry and select Properties from 

the context menu. 

6. The Edit Sensor dialog box appears.  Click on the Calibrations tab. 

7. Click the Add button.  The Gas Responses dialog box appears. 

8. Enter the data for the calibration, and then click the OK button to save the entry.  The 

new 

calibration data displays on the Calibrations tab. 

9. Click the OK or Close button to close the Edit Sensor dialog box. 
 

 

NOTE:  If you are an iNet customer, calibration information that is added manually to the 

system will not be downloaded to iNet.   
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5.12.3. Removing Calibration Data 

You can remove calibration data from the system by using the Calibration tab in the instrument 

properties or in the properties of an individual sensor. 

To remove calibration data from the instrument, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument that contains calibration results you wish to remove. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 

4. Click on the Calibrations tab. 

5. Do one of the following to locate the calibration results:  

 Click the Show Last button to display the results of the last calibration.   

 Select a Start Date and an End Date, and then click the Display button to 

show calibration results for a specific date range. 

6. The calibration results appear in the list.   

7. Select the calibration result you wish to remove.  You can select multiple calibration 

results by pressing the CTRL key on your keyboard while clicking on each entry. 

8. Right click on the calibration result(s) and select Remove. 

9. The system displays a confirmation prompt.  Click Yes to remove the calibration 

entries.   

10. Click OK to close the Edit Instrument dialog box. 
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5.12.4. Graphing Calibration Data 

You can display a graph that shows the results of calibrations over a period of time.  The graph 

can be used to view the trend of sensor degradation over a period of time. 

To view a calibration data as a graph, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument whose calibration information you wish to view. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 

4. Click on the Calibrations tab. 

5. Select a Start Date and an End Date.  You may optionally click the Display button to 

view the data that you are about to graph.   
 

NOTE:  The Graph feature does not necessarily graph the data that is displayed in the list of 

calibration results on the Calibration tab.  It will graph the data that is between the dates selected 

in the Start Date and End Date fields.   
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Step Instruction 

6. Click the Graph button. 

7. A graph of the calibration results that were in the selected date range appears in the 

Span Reserve Trend window.  The graph shows the Span Reserve Values of the 

sensor(s) over the selected time range.  You can modify the appearance of the graph 

by using the Graph Toolbar 
 

 

 

Figure 5-22.  The Span Reserve Trend Window 

 

 

Step Instruction 

8. Click the close button ( ) in the top right corner of the window to close the graph. 

9. Click the Cancel button to close the Edit Instrument dialog box. 
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5.13. Edit Instrument – The Bump Tests Tab 

5.13.1. Overview 

A bump test, also known as a functional test, is a procedure that verifies that an instrument is 

able to detect gas.  In a bump test, an instrument is exposed to a concentration of gas that is 

above the lowest alarm setting to verify that the alarm is functioning properly.  Results of bump 

tests performed on an instrument while docked are downloaded to the docking station system, 

and can be viewed in the DSSAC.   

Bump test results can be viewed in the DSSAC for an instrument, or for an individual sensor.   

 

NOTE:  Bump test data can also be entered into the system manually using the DSSAC.   

 

To view bump test results for an instrument, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument whose bump test information you wish to view. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu.   

Alternative:  You can also select the instrument, and click the File menu and select 

Properties.   

4. Click on the Bump Tests tab. 

5. Do one of the following: 

 Click the Show Last button to display the results of the last bump test. 

 Select a Start Date and an End Date, and then click the Display button to 

show bump test results for a specific date range. 

6. The bump test results appear in the list. 
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Figure 5-23.  The Bump Test Tab of the Edit Instrument Dialog Box with Sample Results 

 

 

Step Instruction 

7. You can sort the bump test results by clicking on the column heading by which you 

would like to sort. 

8. The following information is displayed for each bump test. 

Item Description 

Serial Number The serial number of the sensor 

Time The date and time when the bump test was performed  

Gas Type The type of gas that was used for the bump test 

Passed/Failed Whether or not the sensor passed the bump test.  (Failed 

entries also display in red.)  

Bump Threshold The bump threshold for the bump record.  If no value has 

been recorded, the column will display the default value of 

50. 

Bump Timeout The bump timeout for the bump record.  If no value has been 

recorded (pre-5.0 docking stations), the column will display 

“N/A”, since some older docking stations bump with a 

timeout of two minutes, and others at 90 seconds. 

Automated/Manual Whether the calibration was performed automatically on the 

docking station or manually by the user. 
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Step Instruction 

9. To view the details of a bump test, double-click on its entry in the list. 

Alternative:  You can also right-click on the entry and select Properties from the 

context menu. 

10. The Gas Responses dialog box appears.  See the table below for an explanation of the 

fields in the Gas Responses dialog box. 
 

 

Figure 5-24.  The Gas Responses Dialog Box 

Table 5-9.  Fields in the Gas Responses Dialog Box (Bump Test Tab) 

Button Description 

Serial Number  The serial number of the sensor.   

Gas Type  The type of gas that is used to perform the bump test.   

Passed  Whether or not the sensor passed the bump test.  Values can be “Yes” or 

“No.”    

Gas Concentration  The concentration of gas in the gas cylinder.   

Date  The date on which the bump test was performed.   

Time  The time at which the bump test was performed.   

Accessory Pump Whether or not the instrument has an accessory pump. 

Bump Threshold Bump threshold of instrument. 

Bump Timeout Bump timeout of instrument. 
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You can also view bump test results for each individual sensor in an instrument that contains 

multiple sensors.  To view bump test results for an individual sensor, follow the steps listed 

below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument whose bump test information you wish to view. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 

4. Click on the Components tab. 

5. Double-click on the sensor whose bump test results you wish to view. 

Alternative:  You can also right-click on the sensor entry and select Properties from 

the context menu. 

6. The Edit Sensor dialog box appears.  Click on the Bump Tests tab. 

7. Do one of the following: 

 Click the Show Last button to display the results of the last bump test. 

 Select a Start Date and an End Date, and then click the Display button to 

show bump test results for a specific date range. 

8. The bump test results appear in the list. 

9. To view the details of a bump test, double-click on its entry in the list. 

Alternative:  You can also right-click on the entry and select Properties from the 

context menu. 

10. The Gas Responses dialog box appears.  See the table above for an explanation of the 

fields in the Gas Responses dialog box. 
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Figure 5-25.  The Bump Tests Tab of the Edit Senor Dialog Box 

 

Figure 5-26.  Sample Bump Test Data 

 

NOTE:  In the event of a failed sensor (CL2, HCL, or NH3), the docking station ignores any 

large reading that are above the sensor’s maximum reading.  In addition, the docking station 

ignores any negative readings whose absolute value is larger than the sensor’s maximum reading. 

 

NOTE:  For bump tests, the IDS does not purge gas lines immediately before, during, or 

immediately after a bump test.  The exception is the MX6 iBrid instruments that have an 

attached pump.  For these, a 30-second gas line purge occurs at the end of all bump tests. 
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5.13.2. Adding Bump Test Data 

You can also manually add bump test data to the system.  You can use the instrument properties 

or the properties of an individual sensor to add bump test data.   

 

NOTE:  For legacy instruments, be sure that you have added sensor information to the 

Components tab of the instrument before you add bump test data.  Refer to the Instrument 

Components section for more information about adding sensor data.   

 

To add bump test data using instrument properties, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of  instruments. 

3. Double-click on the instrument for which you would like to add bump test 

information. 

Alternatives:  You can also right-click on the instrument and select Properties from 

the context menu.  You can also select the instrument, and click the File menu and 

select Properties. 

4. Click on the Bump Tests tab. 

5. Click the Add button.  The Gas Responses dialog box appears.   

6. Enter the data for each bump test, and then click the Add button to add it to the list. 

7. Click the OK button to save the bump test results.  The results display on the Bump 

Test tab. 
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Figure 5-27.  Adding Bump Test Data Using Instrument Properties 

 

NOTE:  If you are an iNet customer, bump test information that is added manually to the system 

will not be downloaded to iNet. 

5.13.3. Removing Bump Test Data 

You can remove bump test data from the system.  You can use the instrument properties or the 

properties of an individual sensor to remove bump test data. 

To remove bump test data from the instrument, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument that has bump test data you wish to remove. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 

4. Click on the Bump Tests tab. 

5. Do one of the following to locate the bump test results: 

 Click the Show Last button to display the results of the last bump test. 

 Select a Start Date and an End Date, and then click the Display button to 

show bump test results for a specific date range. 
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Step Instruction 

6. The bump test results appear in the list. 

7. Select the bump test result you wish to remove.  You can select multiple bump test 

results by pressing the CTRL key on your keyboard while clicking on each entry. 

8. Right click on the bump test result(s) and select Remove. 

9. The system displays a confirmation prompt.  Click Yes to remove the bump test 

results. 

10. Click OK to close the Edit Instrument dialog box. 
 

To remove bump test data from a specific sensor, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument that contains bump test data you wish to remove. 

Alternative:  You can also right-click on the instrument and select Properties from 

the context menu. 

Alternative:  You can also select the instrument, and click the File menu and select 

Properties. 

4. Click on the Components tab. 

5. Double-click on the sensor that contains bump test data you wish to remove. 

Alternative:  You can also right-click on the sensor entry and select Properties from 

the context menu. 

6. The Edit Sensor dialog box appears.  Click on the Bump Tests tab. 

7. Do one of the following: 

 Click the Show Last button to display the results of the last bump test. 

 Select a Start Date and an End Date, and then click the Display button to 

show bump test results for a specific date range. 

8. The bump test results appear in the list. 

9. Select the bump test result you wish to remove.  You can select multiple bump test 

results by pressing the CTRL key on your keyboard while clicking on each entry. 

10. Right click on the bump test result(s) and select Remove. 

11. The system displays a confirmation prompt.  Click Yes to remove the bump test 

results. 

12. Click OK to close the Edit Sensor dialog box.  Click OK to close the Edit Instrument 

dialog box. 
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5.14. Edit Instrument – The Datalog Tab 

5.14.1. Overview 

Datalog data is information that is recorded during an instrument’s normal operation.  This data 

are used to compute the STEL and TWA values over a period of time.  For compatible 

instruments, datalog data are downloaded into the docking station system and can be viewed 

using the DSSAC.  Components of the Datalog tab are explained below. 

 

Figure 5-28.  Datalog Tab 

Table 5-10.  Elements of the Datalog Tab 

Element Description 

Session This field shows the current session number.  Below it are the associated 

date and time. 

Forward/Back 

Arrow Buttons 

The forward and back buttons are located on the left side of the screen and 

allow the user to navigate through different data session screens. 

Start Date and 

End Date 

These fields define selection criteria for session data.  Select a Start Date 

and an End Date, and then click the Display button to show datalog data 

sessions for the specified date range in the Session Window. 

Display Button Displays session data in the Session Window.  To view only those 

sessions within a selected date range, use the Start Date and End Date 

fields. 

Actions Button The Actions button (or clicking the right mouse button over the list 

control) displays the Actions Context Menu. 
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Element Description 

Print Button Prints the current screen to the selected printer. 

OK Button Displays specific device data for the session selected in the Session 

Window. 

Cancel Button Pressing the Cancel button returns the user to the Session selection screen 

of the Datalog tab with no change to the data shown. 

Status Bar The status bar (located at the bottom of the screen) indicates any filters 

that may be applied. 

Sessions Window Scrollable window in which session data is displayed.  Columns of  the 

Session Window are listed and explained in the following table.     

If the user selects and double clicks a session, the window will change to 

show the session details.  (Alternative is to select Show Selected 

Components from the Actions button.)  If the datalog data has a session 

number, this number appears above the session date. 

 

Figure 5-29.  Session Details Window Showing Session Number 

NOTE:  Datalog session numbers are uploaded to iNet as part of datalog 

uploads.  Refer to the iNet section for more information. 

 

Table 5-11.  Elements of the Sessions Window 

Column Description 

Serial Number This column lists the serial number of the sensor. 

Gas Type This column lists the type of gas that the sensor was detecting.  It is not 

the type of sensor.  For example, if a PID sensor is configured to use a 

“Hexane” response factor, then a gas type name of “Hexane” will appear 

in this column. 

Status This column lists the state of the sensor when the session was recorded.  

(Note:  It is always empty for non-MX6 instruments). 

 States are any combination of the following: “Disabled”, “Zero failed”, 
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Column Description 

“Bump failed” or “Calibration failed”.  The sensor will have no 

readings associated with it in the session if it has any of these three 

states. 

 A sensor may have more than one state, separated by commas; e.g. 

“Disabled, Zero failed”. 

Alarm Low The gas reading that triggers a low alarm.   

Alarm High The gas reading that triggers a high alarm.   

Alarm TWA The threshold that a Time Weighted Average (TWA) reading must cross 

to trigger an alarm.   

Alarm STEL The threshold that a Short Term Exposure Limit (STEL) reading must 

cross to trigger an alarm.   

Bump failed The instrument failed the bump test. 
 
 

NOTE:  If a sensor was Disabled, or was in Cal Failure or Zero Failure mode during recording 

of the session, then the sensor information appears in red in the session window. 

 

NOTE:  If session contains a PID sensor that was using a Custom Response Factor (CRF) at the 

time of datalog recording, then that CRF is displayed in the DSSAC.  The CRFs name and value 

are displayed in the column that normally displays the gas type for sensor.  For example,  instead 

of “02 – Oxygen”, the column would contain something like “My Custom RF – 1.01”. 

 

NOTE:  Users are able to select multiple sensors on the Session/Sensor screen. 

 

NOTE:  If two sensors are installed in the Tango TX1 when the data are logged, the docking 

station system will download data for three sensors. Data from the installed sensors are logged 

and downloaded as sensor 1 and sensor 2 data. Data that are logged and downloaded as sensor 3 

(or VIRTUAL) are algorithm-calculated values that are based on sensor 1 and sensor 2 data. 

DSSAC displays only the VIRTUAL data. 

 If only one sensor is installed or working when the data are logged, the downloaded and 

DSSAC-displayed data will contain only information for that sensor.  
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Figure 5-30.  Actions Context Menu 

Table 5-12.  Elements of the Actions Context Menu 

Item Description 

Show Selected 

Components 

Causes the sessions window to change to the session details window.  If the 

datalog data has a session number, this number appears above the session 

date as shown in Figure 5-5. 

Selecting one or more sensors will enable this option on the context menu.  

Selecting this option or double-clicking on any single selection will display 

the Session/Data screen. 

Find 

User/Location 

Presents the user with the Find form which is used to filter session data by 

user, location, and date.  For additional information, refer to the Find 

User/Location section that follows. 

View/Edit 

Comments 

Displays a form in which comments for the selected session can be viewed, 

entered and/or edited.  It is disabled until a session is selected. 

Graph Session 

Data 

Presents a graph of the selected session’s data.  The graph displays data from 

all of the sensors in the session. 

Graph Period 

Data 

Presents a graph of the selected period’s data.  The graph displays data from 

all of the periods in the session. 

Print Data Prints a Detail Report of the selected session data.  This option is disabled 

until a session is selected. 

Print Summary Prints a Datalog Summary Report of the selected session data.  This option is 

disabled until a session is selected. 
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Item Description 

Export The Export option exports all data for the selected sensors.  This option is 

disabled until one or more sensors are selected. 
 

5.14.2. Find User/Location 

The Find User/Location option of the Actions context menu displays the Find User/Location 

form which is used to filter session data by user, location, and date.  

  

Figure 5-31.  Find User/Location Form 

Table 5-13.  Elements of the Find User/Location Form 

Element Description 

User field Use this field to specify user text search criteria. 

Location field Use this field to specify location text search criteria. 

Start Date and 

End Date fields 

The Start and End dates reflect the values from the datalog tab.  If these 

dates are changed on this screen, the Start and Stop drop-down boxes on 

the datalog tab will reflect those changes after the Find button is pressed. 

Entering nothing in the User and Location fields and pressing the Find 

button will be the same as selecting dates on the Datalog tab and pressing 

the Display button. 

Cancel button Pressing the Cancel button returns the user to the Session selection screen 

of the Datalog tab with no change to the data shown. 

Find button Pressing the Find button after entering user and/or location search criteria 

will return the user to the Session selection screen of the Datalog tab.  The 

data shown will be filtered with only sessions that meet the selected criteria 

of user, location, and date(s).   
 

NOTE:  Search filtering does implicit wildcarding on the entered user and location fields.  For 

example, if the user types in “smith”, the filtering will show both “Joe Smith” and “Smithers” 

records. 

 

NOTE:  If both a user and location are specified, the search will logically “AND” these fields.  

That is, it will find all matches that have both the specified user and the specified location. 
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NOTE:  The status bar on the Datalog tab indicates if there is a filter applied. 

 

5.14.3. Graph Session Data 

You can display a graph that shows datalog data over a period of time.  There are two ways to 

graph datalog data: you can display a graph of an entire datalog session (Graph Session Data), 

or you can graph each period within the session for a particular sensor (Graph Period Data). 

The Graph Session Data option of the Actions context menu displays the Datalog graph shown 

below.  In the header of the graph, the datalog graph contains the instrument serial number, and 

the session date.  The legend of the graph contains the sensor serial numbers and sensor types. 

 

Figure 5-32.  Sample Datalog Graph (No User Name Associated) 
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Figure 5-33.  Sample Datalog Graph (With an Associated User Name) 

5.14.4. Graph Period Data 

You can display a graph that shows datalog data over a period of time.  There are two ways to 

graph datalog data: you can display a graph of an entire datalog session (Graph Session Data), 

or you can graph each period within the session for a particular sensor (Graph Period Data). 

The Graph Period Data option of the Actions context menu displays the TWA/STEL graph. 

One or more sensors are selected, then period information is displayed.  The Session/Data screen 

shows the selected sensors and sensor data.  A new list box displays the selected sensors. 
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Figure 5-34.  Selecting Sensors to Graph Period Data 

Information recorded for each sensor is displayed.  To return to the previous screen, use the back 

button.  The following information is displayed for each sensor. 

Table 5-14.  Descriptions of Displayed Sensor Information 

Item Description 

Serial Number The serial number of the sensor 

Gas Type The type of gas that was being monitored. 

Alarm Low The Low Alarm setting on the sensor for the session. 

Alarm High The High Alarm setting on the sensor for the session. 

Alarm TWA The TWA Alarm setting on the sensor for the session. 

Alarm STEL The STEL Alarm setting on the sensor for the session. 
 

NOTE:  Selecting one or more sensors enables the Export Data and Show Selected Components 

options of the Actions menu. 

 

NOTE:  Selecting the Show Selected Components option (or double clicking any single 

selection) displays the Session Data screen. 
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Figure 5-35.  Period Data and List Box Showing the Sensor List Box 

 

The following period information is displayed for each sensor. 

Table 5-15.  Descriptions of Displayed Period Information 

Item Description 

Period-Location 

The period and site, if any, for which the readings were taken. 

NOTE:  The T82 Single Gas Monitor does not record Site data, so only 

the period number displays in the Period-Location column for the T82. 

Time The time of the reading. 

Reading The actual reading that was taken by the instrument. 

Temp (C) The temperature (in Celsius) at the time of the reading. 

TWA The Time Weighed Average (TWA) value at the time of the reading. 

STEL The Short Term Exposure Limit (STEL) value at the time of the reading. 

       

Selecting the Graph Selected Period Data from the Actions button displays a graph of all the 

sensors selected on previous screen. 
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Figure 5-36.  TWA/STEL Graph 

5.14.5. Print Summary 

The Print Summary option of the Actions button prints the Datalog report illustrated below.  

Highlighting any displayed session enables this option.  This option is disabled by default and 

whenever no session is currently selected.   

 

 

Figure 5-37.  Selecting the Print Summary Option 
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Figure 5-38.  Sample Datalog Summary Report 

5.14.6. Export 

The Export option of the Actions button is used to send sensor datalog information to an external 

file in comma separated variable (CSV) format.  Upon successful completion, the following 

message is displayed: 
 

“Exporting sensor datalog information completed successfully.” 
 

If an error occurs during the export process, the following message is displayed: 
 

“The Docking Station Server Administration Console could not export 

datalog information!  Please contact your System Administrator for assistance.” 

 

5.15. Edit Instrument – Alarm Events Tab 

The Alarm Events tab displays alarm events downloaded from the instrument during a schedule 

Alarm Events Download Event.  The contents of the Alarm Events Tab are explained below. 
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Figure 5-39.  Edit Instruments – Alarm Events Tab 

Table 5-16.  Components of the Alarm Events Tab of the Edit Instrument Screen 

Component Description 

Forward/Back 

Arrow Buttons 

The forward and back buttons are located on the left side of the screen 

and allow the user to navigate through different alarm event screens. 

Start Date and 

End Date 

These fields define selection criteria for session data.  Select a Start Date 

and an End Date, and then click the Display button to show alarm 

information for the specified date range in the Session Window. 

Display Button 
Displays alarm data in the Session Window.  To view only those sessions 

within a selected date range, use the Start Date and End Date fields. 

Print Button Prints the current screen to the default printer. 

OK Button Displays specific alarm data for the sensor selected. 

Cancel Button 
Pressing the Cancel button returns the user to the Session selection screen 

of the Alarm Events tab with no change to the data shown. 

Alarm Events 

Window 

Scrollable window in which alarm data is displayed.  Columns of  the 

Alarm Events Window include sensor type, serial number, the time the 

alarm event was reported, the duration of the alarm event, and peak, high, 

and low alarm values.   

NOTE:  If two sensors are installed in the Tango TX1 when the data are logged, the docking 

station system will download data for three sensors. Data from the installed sensors are logged 

and downloaded as sensor 1 and sensor 2. Data that are logged and downloaded as sensor 3 (or 

VIRTUAL) are algorithm-calculated values that are based on sensor 1 and sensor 2 data. DSSAC 

displays only the VIRTUAL data. 
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 If only one sensor is installed or working when the data are logged, the downloaded and 

DSSAC- displayed data will contain only information for that sensor.  

 

Table 5-17.1.  Components of the Alarm Messages Tab of the Edit Instrument Screen 

For Ventis Pro4 and Ventis Pro5, each sensor type can have its own unique set of alarm 

messages, and for a given sensor type, the messages can be unique for each event type (gas alert 

warning, gas low alarm, gas high alarm, TWA alarm, and STEL alarm). The instrument is 

capable of storing messages for up to 4 or 5 sensor types, for the Ventis Pro4 and Ventis Pro 5, 

respectively.  

 

 

Figure 5-39.1.  Edit Instruments – Alarm Messages Tab 

5.16. Edit Instrument – Manage Events Tab 

The Manage Events tab of the Edit Instrument screen displays the journal events for the current 

instrument.  The Manage Events tab has a Journal Entries frame and a Force Event frame.  The 

contents of this tab are explained below. 
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Figure 5-40.  Edit Instruments – Manage Events Tab 

 

Table 5-18.  Components of the Manage Events Tab of the Edit Instrument Screen 

Element Description 

Force Event frame Inside the Force Event frame will be a drop-down list of all the possible 

events which may be forced and a button which will force the selected 

event. 

Event Code Drop-

down 

The Event Code selection drop-down box lists the available events for 

that instrument.  It also includes a “None” as the first entry. 

The drop-down element “all the possible events” is defined as any event 

that has been performed by the instrument and now has a journal entry. 

The “None” entry is the default. 
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Element Description 

Force Event button The Force Event button is disabled while “None” is the current 

selection of the Event Code drop-down box.  Selecting an Event Code 

other than “None” enables the button. 

Pressing the Force Event button after an event code is selected removes 

the selected event from the Journal Entry listview and Event Code 

dropdown and then sets the currently selected Event Code to “None”. 

The following error messages are displayed when the user attempts to 

force an event in any of these cases. 

- “Instrument failed its last calibration” 

- “Docking Station unavailable due to leak detected” 

- “Instrument not docked” 

Forced event will not take place in these cases. 

Forced events will not occur if the matching Global Event is currently 

disabled. 

Journal Entries 

frame 

Inside the Journal Entries frame is a list view which displays all journal 

entries for the current instrument and a Refresh List button. 

Refresh List Button The Refresh List button forces the DSSAC to re-query the journal 

entries for the current instrument and updates the Journal Entry list 

view. 

Journal Entry list 

view 

The Journal Entry list view displays the Journal Type and Time for all 

journal entries for the current instrument.  The list is sorted 

alphabetically by journal type.  Double-clicking on any journal entry 

opens the Event Journal Details screen. 
 

 

Figure 5-41.  Event Journal Details Screen 
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NOTE:  The docking station system will download bump test date for physical sensors only. 

There will be no data logged or DSSAC-displayed for sensor 3 (or VIRTUAL).  

5.17. Special Features 

5.17.1. Adding Legacy Instruments 

Legacy instruments are those instruments that cannot be docked in the DSX. See section 5.2 

Instrument Compatibility for a list of the instruments that are not docking station compatible, but 

can be entered into the docking station system.   

You can enter information about these legacy instruments into the system so that all of your 

instrument information is stored in a central location. 

NOTE:  The system provides an “Other Instrument” option for instruments that are not specified 

on the list of non-docking station compatible instruments.   

 

To add a legacy instrument to the system, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Click on the File menu and select Add. 

Alternative:  You can also right click on the Instruments option in the navigation 

pane and select Add from the context menu. 

4. The Add Instrument dialog box appears, displaying the General tab. 
 

 

Figure 5-42.  Adding a Legacy Instrument to the System 
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Step Instruction 

5. Enter the serial number of the instrument and select an instrument type. Complete 

the remaining fields.  See the Instrument Properties section for a description of each 

of the fields on the General tab. 

6. Click on the Components tab.  Enter the batteries and sensors that are used in the 

instrument.  See the Instrument Components section for detailed instructions for 

adding instrument components. 

7. Click on the Users and Sites tab to enter User and Site information for the instrument.  

See the Users and Sites section for detailed instructions for adding user and site data. 

8. Click OK to save your changes.  The instrument information has been added to the 

system. 
 

5.17.2. Removing an Instrument 

You can also remove an instrument from the system using the DSSAC.  However, if you remove 

a docking station compatible instrument, the system will detect it the next time it is docked, and 

re-add it to the system. 

To remove an instrument, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Select the instrument you would like to remove.  You can select multiple instruments 

by pressing the CTRL key on your keyboard while selecting each instrument. 

4. Click on the File menu and select Remove. 

Alternative:  You can also right click on the instrument(s) you have selected and 

select Remove from the context menu. 

5. A confirmation prompt appears.  Select Yes to remove the instrument.  If you select 

No, the instrument is not removed. 

6. The instrument is removed from the system. 

 

5.17.4 Manual Instrument Registration  

Instruments typically are registered into the docking station system automatically.  However, in 

some cases system administrators wish to prevent instruments from coming into the system 

automatically.  This may be the case for example, when an instrument user from outside the 

system wishes to use the docking station to calibrate his instrument.  The Manual Registration 

feature is designed to handle this case.   
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To use the Manual Registration feature, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the View option in the main tool bar.  Select Configuration from the context 

menu. 

3. The Configuration dialog box appears. 

4. Select the Registration tab within the Configuration dialog box. 

 Click on the Enforce Manual Registration button.  Once the manual 

registration option is selected, users will now be informed on the docking 

station display that their instrument is unregistered and should contact the 

system administrator. 

 

 

 

 

 

 

5. When the Enforce Manual Registration feature is selected and Unregistered 

instruments list will now appear under the Instruments heading in the Navigation 

Pane.  Right clicking on one or more of the options in the “Unregistered” list in the 

contents pane will provide the option to register previously unwanted instruments 

into the system. 

 

Unregistered 

Instrument      

Contact 

Administrator 

SN: XXXXXXX-XXX 
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Figure 5-43.  Instrument Configuration Dialog Box 

 

5.17.3. Using the Find Instrument Feature 

The Find Instrument feature allows you to display instruments that meet certain criteria, such as 

those instruments that are overdue for calibration, are due for calibration by a particular date, or 

failed their last calibration.  You can also print a report that displays the instruments meeting the 

criteria rather than displaying the results on your screen. 

To use the Find Instrument feature, follow the instructions listed below. 
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Step Instruction 

1. Open the DSSAC application. 

2. Right click on the Instruments option in the navigation pane.  Select Find from the 

context menu. 

3. The Find Instruments dialog box appears. 

4. Select one of the options below. 

 Due for Calibration – If you select this option, you must also select a date in 

the By Date field.  This option displays instruments that are due for a 

calibration by the specified date. 

 Overdue for Calibration – Select this option to view all instruments whose 

calibration is overdue based on today’s date. 

 Failed Last Calibration – Select this option to view all instruments for which 

the last calibration failed. 

 Marginal Calibration – Select this option to view all instruments for which the 

last calibration was marginal. 

 Overdue for bump test – Select this option to view all instruments for which 

the bump test is overdue based on today’s date. 
 

 

Figure 5-44.  Finding Instruments Dialog Box 
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Step Instruction 

5. Do one of the following: 

 Click Display to view only the instruments that meet the criteria in the 

Instruments contents pane.  This option works as a filter, displaying only the 

instruments that match, and hiding those that do not.  After you are done 

viewing the instruments, you must turn off the filter to view all instruments.  

To turn the filter off, right-click on the Instruments option in the navigation 

pane, and select Cancel find from the context menu.   

 Click Print to print a report that lists the instruments that meet the selected 

criteria.   

 Click Cancel to close the dialog box and not perform the instrument find.   

 

 

    



 

 

 

Configuring the Docking 
Station 

Chapter 

6 
 

6.1. Introduction 

This chapter explains information about how to set up an Instrument Docking Station (IDS), 

from plugging it in, to configuring it to use gas cylinders for calibrations and bump tests, to 

viewing its status in the DSSAC. 

Before you set up an IDS, be sure that the Docking Station Server (DSS) is running on your 

network, since the IDS requires the DSS in order to function.  Each IDS also requires an Ethernet 

connection to your network as well as a power outlet. 

6.2. Instrument Docking Station Hardware Overview 

Below is a diagram that shows all of the connections on the back of an IDS.  The details about 

how to use these connections are explained later in this chapter.   
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Port Set 4 (left) 
  

Port Set 5(middle) 
 

Port Set 6 (right) 
 

 Power supply port (12 VDC) 

Port Set 1* (left) USB port (USB) for firmware 
upgrades only 

 

Port Set 2 (middle) 

Port Set 3 (right) 

*Use port set 1 only for zero-grade-air 
cylinders (or a fresh air fitting), not for 
calibration gas. 

Network connection (LAN 
PORT) 

   
Air inlet (ZERO AIR, blue) 

 
Zero-air port set (left) and 

calibration gas port set (right) 

Calibration gas inlet (CAL 
GAS, white) 

Cable port for iGas tubing-and-
card-reader assembly 

Cable port for iGas tubing-
and-card-reader assembly 

  

 

Figure 6-1.  DSX-L Back Panel (6-PORT UNIT SHOWN) 

Note: The port sets 1, 2, and 3 are positioned in the same location on the 3-port unit. 
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The table below briefly describes the connections on the back of an IDS.   

Table 6-1.  Connections on the Back of an IDS 

Connection Description 

ZERO AIR and CAL 

GAS 

Connects the IDS to cylinders using gas tubing. 

iGas 1, 2, and 3 (or up to 

6 for a 6-port IDS) 

If you are using iGas, these ports are used to connect the Smart 

Card reader to the IDS. 

Service Port 
A serial port that is used by Industrial Scientific technicians to 

service the IDS. 

DC (12-volt) Power Inlet Connects the IDS to a 12-volt power source. 

AC Power Inlet Connects the IDS to an AC power source. 

USB Port 

A port used to accept USB drives.  USB drives are used to connect 

a compatible printer or to upload future software updates to the 

Docking Station. 

Network Port A standard Ethernet port to connect the IDS to your network. 
 
 

NOTE: Industrial Scientific recommends that gas tubing should be ester-based polyurethane 

type 85A. The maximum length for tubing is 3.05 m (10’); however, for Chlorine (Cl2), 

Ammonia (NH3) and Hydrogen Chloride (HCl) gases, the gas tube length should not exceed .91 

m (3'). 

 

The front of the IDS contains the cradle into which an instrument is docked.  It also contains an 

LCD screen, a series of LED lights, and a keypad. 

The LCD screen contains information about the activity of the IDS.  The IDS contains three LED 

lights: red, yellow, and green.  In general, if the red LED is illuminated, there is a problem with 

the IDS or the instrument that is currently docked.  The yellow LED indicates that the IDS is 

busy performing a task, such as calibrating an instrument or downloading data.  The green LED 

lights when the IDS is ready to receive instructions, either from the Docking Station Server, or 

from the IDS menu. 

 

NOTE: Do not either dock or undock an instrument on the IDS when the yellow LED is 

illuminated, except when the instrument battery is charging. 

 

Please refer to the LED and Alarm Signals section for more detail about the meanings of LED 

indicators, LCD messages, and alarm signals. 
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LCD Screen 

 

LEDs 

Green (top) 

Amber (middle) 

Red (bottom) 

 

Left Arrow Key Enter Key Right Arrow 
Key 

  

Figure 6-2.  .  Front Panel of a DSX-L  

6.3. Setting Up an Instrument Docking Station  

To prepare the IDS hardware for operation, follow the instructions listed below. 

Step Instruction 

1. Be sure that the DSS is running on your network, and that you have a connection to 

the network for the IDS. 

2. Connect the network cable into a network connection. Plug the other end of the cable 

to the LAN Port located on the back of the IDS.   

3. Remove the power supply’s cover: press the lever and slide the cover in the direction 

indicated. The adapter plug (or dedicated power cord, if ordered) replaces the cover.  

4. Plug the power cord into a suitable outlet.  The IDS automatically turns on when you 

plug it in. 

 

NOTE:  When the IDS is first plugged in, the three LEDs simultaneously flash.  There is then a 

40-second delay while the IDS boots.  During the boot-up phase, the yellow LED is illuminated.  

When the IDS has completed booting, the backlight on the LCD panel turns on and the IDS 

emits a short beep. 
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Step Instruction 

5. After the IDS has finished booting, the DSS automatically detects the IDS on the 

network.  The LCD on the IDS displays “Discovering.”  The yellow LED 

illuminates. 

6. When the LCD on the IDS displays the current date and time and the green LED is 

illuminated,  the IDS has been configured in DSSAC and is now set up and ready for 

further configuration.  

 

6.4. Instrument Docking Station Status and Properties 

When an IDS has been connected to the network and powered on for the first time, the DSS 

detects it and gathers its information to store in the system.   

  

 
 

 

  
 
  

Port Set 4 (left) 
  

Port Set 5(middle) 
 

Port Set 6 (right) 
 

 Power supply port (12 VDC) 

Port Set 1* (left) USB port (USB) for firmware 
upgrades only 

 

Port Set 2 (middle) 

Port Set 3 (right) 

*Use port set 1 only for zero-grade-air 
cylinders (or a fresh air fitting), not for 
calibration gas. 

Network connection (LAN 
PORT) 

   
Air inlet (ZERO AIR, blue) 

 
Zero-air port set (left) and 

calibration gas port set (right) 

Calibration gas inlet (CAL 
GAS, white) 

Cable port for iGas tubing-and-
card-reader assembly 

Cable port for iGas tubing-
and-card-reader assembly 

  

Figure 6-1.  DSX-L Back Panel (6-PORT UNIT SHOWN) 

Note: The port sets 1, 2, and 3 are positioned in the same location on the 3-port unit. 

(Optional) 

 



 

166 

 

To view the current status of the IDS in the DSSAC, follow the instructions listed below.   

Step Instruction 

1. Launch the DSSAC application. 

2. Click on the DSS option in the navigation pane. 

3. The contents pane displays a list of IDSs and their current status. It also displays 

the serial number of the instrument that is currently docked, if any, and the date and 

time of the last connection. 

 

 

 

Figure 6-2.  Contents Pane Showing IDSs and Current Status 

 

NOTE:   This screen will automatically update with the most recent information every 

30 seconds.  If you would like to see the most current information immediately, you can refresh 

the screen by right-clicking on the DSS option in the navigation pane and selecting Refresh.  

You can also press the F5 function key on your keyboard. 

 

Step Instruction 

4. You can double-click on an entry in the list to view the properties of the IDS or of the 

instrument that is docked.  If there is no instrument docked on the IDS, the DSSAC 

displays the Edit Docking Station dialog box.  See below for more information about 

the IDS properties.  If an instrument is docked on the IDS, the Select Device dialog 

appears. 

 

Figure 6-3.  Select Device Dialog Box 
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Step Instruction 

5. Select whether you wish to view the IDS or instrument properties.  If you select View 

instrument properties and then click OK, the Edit Instrument dialog box appears.  If 

you select View Docking Station properties and then click OK, the Edit Docking 

Station dialog box appears. 
 

You can also view the IDS properties in the DSSAC.  To do this, follow the instructions listed 

below. 
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Step Instruction 

1. Click the Docking Stations option in the navigation pane. 

2. The contents pane displays a list of IDSs that have been configured in the system.  Any 

IDS that is currently active appears in blue. 

 

Figure 6-4.  Sample Contents Pane 

 

Column Title Description 

Serial Number Serial number of the docking station as well as an icon to 

indicate a docking station type. 

Type Indicates the instrument type for the docking station:  GasBadge 

Pro, MX6 iBrid, Tango TX1, Ventis Pro4, Ventis Pro5, Ventis 

LS, or Ventis MX4.   

Gas In <x> Indicates the type of gas, if any, currently assigned to port x and 

its current status.  The status of a Gas In connection can be 

“OK”, “Low”, “Empty”, “Due to Expire”, “Expired”, 

“Disabled” or “N/A”. 

Last Connected The Date/Time stamp for the last time the docking station talked 

to the Docking Station Server. 

Location Current location assigned to the Docking Station. 

Software 

Version 

The version of the Docking Station software that the docking 

station is currently running. 

Printer The printer that the docking station will automatically print 

calibration reports to. 

    

 

3. Double-click on the IDS whose properties you wish to view. 

Alternative:  You can also right-click on the IDS and select Properties from the context 

menu. 

Alternative:  You can also select the IDS, and then click the File menu, and select 

Properties. 

4. The Edit Docking Station dialog box appears. 
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5. The Edit Docking Station dialog box contains two tabs. 

General - This tab contains information about the IDS.  Since IDSs are 

automatically configured by the Docking Station Server, many of 

the fields cannot be changed.  You can, however, change the 

Language Setting, Location, Menu Locked and IDS Printer fields.  

See the table below for an explanation of each field on the 

General tab. 

Gas Inlets -  This tab is used to configure the Gas In connections on the IDS.  

See section 6.6 Configuring Gas Cylinders for information about 

using the Gas Inlets tab. 

Manage 

Events - This tab displays the journal events for the current Docking 

Station. 

NOTE:  The optional iGas feature can automatically configure your gas cylinders in the 

DSSAC for you.  See section 6.11 Using iGas for more information about iGas. 
 

 

Figure 6-5.  Edit Docking Station Dialog Box – General Tab 
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Step Instruction 

6. If you make any changes, click the OK button to save your changes.  Otherwise, click 

the Cancel button to return to the list of IDSs without making any changes. 

 

Table 6-2.  Fields in the Edit Docking Station Dialog Box (General Tab) 

Field Description 

Serial Number  The serial number of the IDS.   

Type 

The type of instrument that the IDS supports.  Possible options are 

GasBadge Pro Single Gas Monitor, MX6 iBrid Multi-Gas Monitor,  

Tango TX1 Single-gas Monitor, Ventis LS, or Ventis MX4 Multi-Gas 

Monitor.  

Part Number The Industrial Scientific part number for the IDS.   

Setup Date  The manufactured date of the IDS.   

Software Version  The version of the IDS software that is running on the IDS.   

Language Setting  
The language that is used on the IDS menu.  Options are: “English,” 

“Français,” “Espanol” “Deutsch,” “Czech,” “Polish,” or “Russian.”  

Location  Use this field to identify the physical location of the IDS. 

Menu Locked  

Indicates if the menu can be used on the IDS.  If “No” is selected, then 

the IDS menu can be used.  If “Yes” is selected, then the IDS menu 

cannot be used. 

IDS Printer 

A non-editable dropdown list of all printers configured on the DSS server 

machine.  A blank selection (the default) means “none” (i.e., no printer 

selected).  Whenever a calibration takes place on the IDS, a calibration 

certificate is printed automatically to the selected printer, if a printer has 

been chosen.  Whenever a bump test takes place on the IDS, a bump 

certificate will be printed automatically to the selected printer, if a printer 

has been chosen.  If no printer has been chosen, the certificates will not 

print automatically. 

NOTE:  In DSSAC, if the “Print” button for calibration or bump 

certificates is pressed, the user will be presented with his/her web 

browser with the certificate rendered within.  The user chooses the 

printer to print to, and prints, using the browser’s print/print setup 

functions. 

Network Info A label displaying the network information of the docking station. 

Audible Alarm Enables or disables the docking station buzzer. 
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Figure 6-6.  Edit Docking Station Dialog Box – Manage Events Tab 

The Edit Docking Station screen will have a new tab which displays the journal events for the 

current Docking Station.  The Manage Events tab has Journal Entries and Force Event frames. 

Table 6-3.  Fields in the Edit Docking Station Dialog Box (Manage Events Tab) 

Field Description 

Force Event frame Inside the Force Event frame is a drop-down list of all the possible 

events which may be forced and a button which forces the selected 

event. 

Event Code Drop-

down 

The Event Code selection drop-down box lists the available events for 

that Docking Station.  It also includes a “None” as the first entry. 

The “all the possible events” option is defined as any event that has 

been performed by the Docking Station and now has a journal entry.  

The “None” entry is the default. 
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Field Description 

Force Event button The Force Event button is disabled while “None” is the current 

selection of the Event Code drop-down box.  Selecting an Event Code 

other than “None” enables the button. 

Pressing the Force Event button after an event code is selected removes 

the selected event from the Journal Entry listview and Event Code 

dropdown and then sets the currently selected Event Code to “None”. 

The following error message is displayed when the user attempts to 

force an event in any of these cases. 
 

 “Docking Station unavailable due to leak detected” 
 

Forced event will not take place in those cases.  Similarly, forced events 

will not occur if the matching Global Event is currently disabled. 

Journal Entries 

frame 

Inside the Journal Entries frame is a list view which displays all journal 

entries for the current docking dtation and a Display button. 

Refresh List Button The Refresh List button forces the DSSAC to re-query the journal 

entries for the current docking station and updates the Journal Entry list 

view. 

Journal Entry list 

view 

The Journal Entry list view displays the Journal Type and Time for all 

journal entries for the current Docking Station.  The list is sorted 

alphabetically by journal type. 

Double-clicking on any journal entry opens the Event Journal Details 

screen (same functionality as the original Journal node) 
 

 

Figure 6-7.  Event Journal Details Screen 
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6.5. Removing an Instrument Docking Station 

You can remove an IDS from the DSSAC.  However, the next time that the IDS is connected to 

the network, the Docking Station Server detects it and adds it back into the list of IDSs in the 

DSSAC.   

You may need to remove an IDS if it is no longer in use or it is being moved to another docking 

station network. 

To remove an IDS, follow the instructions listed below. 

Step Instruction 

1. Launch the DSSAC application. 

2. Click the Docking Stations option in the navigation pane. 

3. Select the IDS that you wish to remove.  You can select multiple IDSs by pressing 

the CTRL key on your keyboard while clicking on each IDS. 

4. Click on the File menu and select Remove. 

Alternative: You can also right click on the selected IDS(s) and select Remove from 

the drop-down menu. 

5. A confirmation prompt appears.  Click Yes to remove the IDS(s).  Click No to cancel 

the removal. 

6.6. Configuring Gas Cylinders 

In order to perform calibrations and bump tests, the IDS gas connections must be configured to 

use gas cylinders.  Configuring gas cylinders involves two steps: (1) setting up the physical 

hardware, i.e., the IDS and cylinders, and (2) configuring the Gas In connection in the DSSAC. 

Each IDS has three or six port sets. Port set 1 is used to connect a fresh air fitting or a zero-

grade-air cylinder. Port sets 2 – 6 are used to connect to gas cylinders. 

The DSX docking station requires that a demand flow regulator be used on calibration gas 

cylinders that are connected to an IDS. 

 

NOTE:  If you are using iGas, you do not need to follow the instructions below.  Please refer to 

section 6.11 Using iGas.   

 

CAUTION:  Compressed gas cylinders and their contents may present specific hazards to the 

user.  Use only in a well-ventilated area.  Use only in accordance with the instructions and 

warnings marked on the cylinder and the appropriate Material Safety Data Sheets. 
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To configure an IDS Gas In connection to use calibration gas, follow the instructions below. 

Step Instruction 

1. Connect the demand flow regulator to the gas cylinder.  With the gauge facing away 

from you, place the regulator on top of the cylinder and turn the cylinder until it is 

connected tightly. 

2. Connect the open end of polyurethane gas tubing to the fitting on the demand flow 

regulator.  Connect the other end of the tubing to the CAL GAS (or ZERO AIR) port 

on the back of the station; turn the leur clockwise to tighten. 

 

NOTE: For Chlorine (Cl2), Ammonia (NH3) and Hydrogen Chloride (HCl) gases, the gas 

tube length should not exceed three (3) feet.   

 

NOTE: Industrial Scientific recommends that gas tubing should be ester-based polyurethane 

type 85A.  The maximum length for tubing is 3.05 m (10’); however, for Chlorine (Cl2), 

Ammonia (NH3) and Hydrogen Chloride (HCl) gases, the gas tube length should not exceed .91 

m (3'). 

Step Instruction 

3. Launch the DSSAC application.  Click the Docking Stations option in the navigation 

pane. 

4. Double-click on the IDS whose Gas In connections you wish to configure. 

Alternative:  You can also right-click on the IDS and select Properties from the 

context menu.   

Alternative:  You can also select the IDS, and then click the File menu, and select 

Properties.   

5. The Edit Docking Station dialog box appears.  Click on the Gas Inlets tab.  The Gas 

Inlets tab contains either three (3) or six (6) tabs based on the number of gas ports 

available on the docking station. There is a tab for each Gas In connection on the 

IDS. 
 

 

NOTE: Each Gas In tab contains an icon to identify the status of the connection.  See Table 6-4 

for a description of each of the icons. 
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Figure 6-1.  DSX-L Back Panel (6-PORT UNIT SHOWN) 

Note: The port sets 1, 2, and 3 are positioned in the same location on the 3-port unit. 
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Step Instruction 

6. Click on the Gas In tab that corresponds to the Gas In connection to which you have 

connected the gas cylinder. 

 

Figure 6-2.  Gas Inlets Tab 

7. Click the Assign button.  A menu of options appears.  Choose from the options 

below. 

 Fresh Air – Configures the Gas In connection to use fresh ambient air, or for a 

Zero Air cylinder. 

 ISC – Configures the Gas In connection to use an Industrial Scientific gas 

cylinder.  See the Using ISC gas section for specific procedures for adding 

ISC gas. 

 Non-ISC – Configures the Gas In connection to use a gas cylinder that was 

not purchased from Industrial Scientific.  See the Using non-ISC gas for the 

specific procedures for adding non-ISC gas. 

 Disabled – Configures the Gas In connection to be disabled, i.e., not using 

either a gas cylinder or fresh air.   

8. The settings you have chosen appear in the dialog box on the Gas In tab that you had 

selected.  If the Gas In connection is configured with gas, then the Gas Name, 

Concentration and Gas Symbol displays on the screen.  The expiration date of the gas 

cylinder appears above the list of gases. 
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Figure 6-3.  A Configured Gas In Tab 

Step Instruction 

9. Click the OK button from the Edit Docking Station dialog box to save your changes. 

10. The gas cylinder is now ready to be used. 

 
 

CAUTION:  When configuring Gas In connections, be careful that you have configured the 

correct gas type in the DSSAC that matches the gas type in the cylinder connected to the Gas In 

connection on the IDS.  If this setup is incorrect, your calibrations may be run with the incorrect 

gas, rendering the results inaccurate. 

 

Table 6-4.  Gas Inlets Tab Icons 

Icon Description Explanation 

 Solid Green Circle  The cylinder is ok or is using fresh air.   

 Solid Yellow Circle  The cylinder is low.   

 Solid Red Circle  The cylinder is empty.   

 Yellow Circle with a Rex X The cylinder will expire within 30 days. 
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 Red Circle with a White X  The cylinder is expired.   

 
Yellow Circle with an 

exclamation point  
The Gas In connection is disabled.   

 
 

NOTE:  If you hover your mouse pointer over one of the icons on the Gas Inlets tab, the status 

of the cylinder or Gas In connection displays.   

 

 

6.7. Adding Gas from Industrial Scientific 

To add an ISC gas, follow the instructions below. 

Step Instruction 

1. From the Edit Docking Station dialog box, click on the Gas Inlets tab. 

2. Select the tab corresponding to the Gas In connection that you are configuring. 

3. Click the Assign button and select ISC. 

4. The Cylinder Configuration dialog box appears. 

5. Select an Expired Date for the gas. 

NOTE:  You cannot enter a date for the Expired Date that is earlier than today’s date. 

6. Select an ISC gas type from the list. 

7. Click OK.  The cylinder information is added to the Gas In tab. 

8. Optionally enter a cylinder serial number.  (This field may be left blank.)   This field 

is editable when the user is manually adding a cylinder (both for ISC and NON-ISC 

cylinders).  NOTE: Valid characters include any combination of alphanumeric 

characters, dashes, and period, up to 30 characters in length.  Invalid characters 

include  “%”, “&”, “<”, and “>”.  Leading or trailing spaces will be trimmed from the 

data entered in this field.  Data entered in this field is saved to the Cylinder table in 

the DS2 Database, but is NOT sent to iNet. 

9. Click OK from the Edit Docking Station dialog box to save your changes.  If any of 

the Gas In tabs contain a disabled configuration, the system displays a Confirm Save 

Docking Station message.  Click Yes to save the IDS information. 
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Figure 6-4.  Adding Gas from Industrial Scientific 

6.8. Adding Gas from a Third Party 

To add a gas from a company other than Industrial Scientific, follow the instructions below. 

Step Instruction 

1. From the Edit Docking Station dialog box, click on the Gas Inlets tab. 

2. Select the tab corresponding to the Gas In connection that you are configuring. 

3. Click the Assign button and select non-ISC. 

4. The Cylinder Configuration dialog box appears. 

5. Select an Expired Date for the gas. 

NOTE:  You cannot enter a date for the Expired Date that is earlier than today’s date. 

6. Click the Add button.  The Concentration dialog box appears. 

7. Select a Gas, and enter a value for PPM, %VOL or %LEL (if applicable).  Click OK. 
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Figure 6-5.  Adding Non-ISC Gas 

 

 

NOTE:  When you enter a PPM value, the %VOL value will automatically compute.  Similarly, 

if you enter a value for %VOL, the PPM value will automatically compute.  This feature also 

applies to gases that use a %LEL value. When you enter a value for one of the fields, the other 

two compute automatically.   

 

Figure 6-6.  The Gas Concentration Dialog Box 

 

NOTE:  You cannot enter a value that would compute a %VOL greater than 100%. 
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Step Instruction 

8. Repeat steps 6 and 7 to add additional gases, if necessary. 

9. If you want to remove a gas from the list, you can select it, and then click the 

Remove button.  You can select  by pressing the CTRL key while clicking on each 

gas that needs to be removed. 

Alternative:  You can also right-click on the gas and select Remove from the context 

menu. 

10. Once all of the gases have been entered, click OK from the Cylinder Configuration 

dialog box.  The cylinder information is added to the Gas In tab. 

11. Click OK from the Edit Docking Station dialog box to save your changes.  If any of 

the Gas In tabs remains disabled, the system displays a Confirm Save Docking 

Station message.  Click Yes to save the IDS information. 
  

6.9. Changing Gas Cylinders 

When you change a gas cylinder on IDS, there is a specific set of steps that must be followed in a 

certain order.  First, you should disable the Gas In connection in the DSSAC.  Then, disconnect 

the gas cylinder from the IDS, and reconnect the new bottle.  Finally, open the DSSAC 

application and configure the Gas In connection to use the new gas.   

The order of operations is important to prevent any calibration errors.  For example, if a Gas In 

connection is not disabled before disconnecting a gas cylinder, there is a chance that the system 

might attempt a calibration while there is no gas connected.  Disabling the Gas In connection 

prevents this from occurring.   

 

NOTE:  If you are using iGas, cylinder changes are automatically detected when you change 

Smart Cards.  Please refer to section 6.11 Using iGas for additional information about 

configuring gas cylinders using iGas.   

 

To change gas cylinders on an IDS, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application.  Click the Docking Stations option in the navigation 

pane. 

2. Double-click on the IDS for which you are changing gas cylinders. 

Alternative:  You can also right-click on the IDS and select Properties from the 

context menu. 

Alternative:  You can also select the IDS, and then click the File menu, and select 

Properties. 

3. Click on the Gas Inlets tab. 

4. Click on the Gas In tab that corresponds to the Gas In connection for which you are 

changing gas cylinders. 
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Step Instruction 

5. Click the Assign button, and select Disabled from the menu.  This disables the Gas In 

connection. 

6. Click OK from the Edit Docking Station dialog box.  Click Yes when the Confirm 

Docking Station Save message appears. 

7. Disconnect the old gas bottle from the IDS.  Remove the gas tubing from the fitting 

on the demand flow regulator.  With the gauge facing away from you, unscrew the 

gas cylinder bottle until it detaches from the regulator. 

8. Connect the new gas bottle to the IDS.  See section 6.6 Configuring Gas Cylinders 

for detailed instructions on connecting gas cylinders. 

9. Return to the DSSAC application.  Click the Docking Stations option in the 

navigation pane. 

10. Double-click on the IDS for which you are changing gas cylinders. 

11. Click on the Gas Inlets tab. 

12. Click on the Gas In tab that corresponds to the Gas In connection for which you are 

changing gas cylinders. 

13. Click the Assign button, and select ISC or non-ISC from the menu, depending on the 

gas cylinder you are adding.  See the previous sections on using ISC gas or using 

non-ISC gas for specific procedures for adding ISC or non-ISC cylinders. 

14. Click OK from the Edit Docking Station dialog box. 

15. The Gas In connection is now configured to use the new gas cylinder. 
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6.10. Supported Sensors 

Below are lists of the supported sensor types for each instrument that is compatible with the 

Docking Station.   

Table 6-5.  Supported Sensors 

Sensor 
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Ammonia (NH3)        

Carbon Dioxide (IR) (CO2)        

Carbon Dioxide/Hydrocarbons 

(CO2/HC) 

       

Carbon Dioxide/Methane 

(CO2/CH4) 

       

Carbon Monoxide (CO)        

Carbon Monoxide (CO/H2 

Low) 
       

Carbon Monoxide and 

Hydrogen Sulfide (COSH) 

       

Chlorine (Cl2)        

Chlorine Dioxide (ClO2)*         

LEL (Methane)        

LEL (Pentane)        

Hydrocarbon (IR)        

Hydrogen (H2)        

Hydrogen Chloride (HCl)        

Hydrogen Cyanide (HCN)        

Hydrogen Sulfide (H2S)        

Methane 5% vol.        

Methane (IR) (CH4)        

Nitrogen Dioxide (NO2)        

Nitric Oxide (NO)        

Oxygen (O2)        

Phosphine (PH3)        

PID (10.6 eV photoionization)         

Sulfur Dioxide (SO2)        

 

*NOTE:  The DS cannot calibrate or bump test a chlorine dioxide sensor. It can charge an 

instrument with a Chlorine Dioxide sensor and can download the sensor’s data.  
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6.11. Using iGas 

iGas is an optional feature that uses a Smart Card to automatically configure gas cylinders.  This 

feature can save time that you would spend manually disabling and then reconfiguring a Gas In 

connection in the DSSAC each time you change a gas cylinder.   

If you are an iGas customer, an iGas Smart Card will be attached, via a plastic ring, to the neck 

of each of your calibration gas cylinders.  The iGas Smart Card contains information about the 

gas cylinder.  When the card is connected to the card reader, the system reads the information 

about the gas and automatically configures the Gas In connection in the docking station system.   

iGas can also be used with an optional pressure switch which detects when the gas pressure in 

the cylinder is low.  iGas sends this information to the Docking Station Server so it is visible in 

the DSSAC.  If you are an iNet customer, this data is also sent to the iNet Network Operations 

Center so that Industrial Scientific can proactively send new gas cylinders to you.   

 

NOTE:  The pressure switch option is standard when you use iGas with iNet.   

 

To connect a cylinder using iGas, follow the instructions listed below. 

Step Instruction 

1. Connect the demand flow regulator to the gas cylinder. With the gauge facing 

away from you, place the regulator on top of the cylinder and turn the cylinder until it 

is connected tightly. 

2. Connect one end of the polyurethane gas tubing bundled with the iGas reader cable to 

the fitting on the demand flow regulator. 

 

NOTE: Industrial Scientific recommends that gas tubing should be ester-based 

polyurethane type 85A. The maximum length for tubing is 3.05 m (10’); however, for 

Chlorine (Cl2), Ammonia (NH3) and Hydrogen Chloride (HCl) gases, the gas tube 

length should not exceed .91 m (3'). 

3. Disconnect the supplied Luer fitting from the Gas In connection you wish to use. 

4. Connect the Luer fitting to the other end of the tubing, and then attach the fitting to 

the Gas In connection in the back of the IDS. 

5. Connect the Smart Card reader cable to the iGas Port directly below the Gas In 

connection to which you connected the gas tubing. 

6. If necessary, connect the Smart Card reader cable to the Smart Card reader. 

7. If you are using the Pressure Switch option, connect the wires from the pressure 

switch to the pressure switch connection on the right side of the Smart Card reader. 

8. Slide the iGas Smart Card that is attached to the calibration cylinder into the Smart 

Card  reader. 
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iGas card 

iGas card reader 

 

 

 

 

tubing  

pressure switch plug  

 

 

tubing with fitting 

 

 

card-reader cable 

 

Figure 6-7.  iGas Cylinder connected to DSX-L  

 

NOTE:  It is important that the gas line is connected before the iGas card so that the system is 

ready to draw gas after it reads the card.   

 

NOTE:  Be sure that the Smart Card is connected to the correct iGas Port.  For example, if you 

have connected the gas line to Gas In # 2, then the Smart Card must be connected to iGas Port #2.  

If the correct port is not used, the system could use the wrong type of gas for a calibration or 

bump test, rendering the results inaccurate. 

 

Step Instruction 

9. The system reads the information about the gas  cylinder from the iGas Smart Card 

and automatically  configures the Gas In connection in the DSSAC. 

10. The gas cylinder is ready to use. 
 

NOTE:  If you are using iGas, do not edit the cylinder configuration in DSSAC.  Doing so could 

temporarily override the settings configured by iGas, possibly causing the docking station system 

to use inaccurate information for calibrations or bump tests.  If the
 

settings do get overwritten, 

simply reinsert the iGas Smart Card to reconfigure the gas cylinder.   
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Port Set 4 (left) 
  

Port Set 5(middle) 
 

Port Set 6 (right) 
 

 Power supply port (12 VDC) 

Port Set 1* (left) USB port (USB) for firmware 
upgrades only 

 

Port Set 2 (middle) 

Port Set 3 (right) 

*Use port set 1 only for zero-grade-air 
cylinders (or a fresh air fitting), not for 
calibration gas. 

Network connection (LAN 
PORT) 

   
Air inlet (ZERO AIR, blue) 

 
Zero-air port set (left) and 

calibration gas port set (right) 

Calibration gas inlet (CAL 
GAS, white) 

Cable port for iGas tubing-and-
card-reader assembly 

Cable port for iGas tubing-
and-card-reader assembly 

  

 

Figure 6-1.  DSX-L Back Panel (6-PORT UNIT SHOWN) 

Note: The port sets 1, 2, and 3 are positioned in the same location on the 3-port unit. 
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Basic Operation  
 

Chapter 

7 
 

7.1. Introduction 

This section describes the features of the Instrument Docking Station (IDS), such as menu 

options, the LED and alarm signals, and how to force the docking station to perform immediate 

calibrations and bump tests from the IDS menu.  The diagram below shows the front panel of an 

IDS.  This panel contains the LCD screen, the LED lights and the keypad with which you access 

the menu on the IDS.   

 

 

LCD Screen 

 

LEDs 

Green (top) 

Amber (middle) 

Red (bottom) 

 

Left Arrow Key Enter Key Right Arrow 
Key 

Figure 7-1.  Front Panel Components of the DSX-L Docking Station 

7.2. Menu Options 

The menu on an IDS is used to request actions such as on-demand calibrations or bump tests.   

 

NOTE:  The menu cannot be used when the IDS is performing a task (the yellow LED is 

illuminated), except for when it is charging an instrument’s battery.   
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NOTE:  The menu cannot be used if the Menu Locked setting for the IDS in DSSAC is set to 

“Yes.”  This option can be set in the DSSAC in the Edit Docking Station dialog box.  See 

section 6.4 Instrument Docking Station Status and Properties for more information about the 

Menu Locked setting.   

To access the menu on an IDS, follow the instructions listed below. 

Step Instruction 

1. Be sure that the IDS is not performing a task.  (The green LED is illuminated, and the 

LCD panel displays the current date and time.) 

2. Press any of the keys on the IDS keypad.  The main menu appears. 

3. Use the ARROW keys on the keypad to navigate the menu.  Use the ENTER key to 

select an option. 

4. The menu options are listed below. 

Item Description 

Instrument 

If you select this option, the following submenu appears: 
 

Item Description 

Bump 

Test 

Used to force the IDS to perform a bump test.  See 

the Forced Bump Tests section later in this chapter 

for more information about using the Bump Test 

menu option. 

Calibrate 

Used to force the IDS to perform a calibration.  See 

the Forced Calibration section later in this chapter 

for more information about using the Calibrate 

menu option. 

Download 

Data 

Used to download datalog data to the Docking 

Station Server.  See the Downloading and Clearing 

Datalog Data section later in this chapter for more 

information about the Download Data menu option. 

Clear 

Datalog 

Used to clear datalog data from the instrument.  See 

the Downloading and Clearing Datalog Data 

section later in this chapter for more information 

about the Clear Datalog menu option. 

Previous Returns to the main menu. 
 

NOTE:  The Instrument menu is only available when an instrument 

is docked on the IDS. 
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Step Instruction 

Docking 

Station 

If you select this option, the following submenu appears: 
 

Item Description 

Set 

Language 

Changes the language used on the LCD display on 

the IDS.  See the Changing Language Settings 

section later in this chapter for more information 

about the Set Language menu option. 

Diagnose 

Used to run the pressure diagnostic test on the 

IDS.  See the IDS Diagnostics section later in this 

chapter for more information about the Diagnose 

menu option. 

Information 

Provides information about the IDS, such as serial 

number, software version and the IP address of the 

DSS. 

Previous Returns to the main menu. 

   

   

 

 

NOTE:  The IDS menu will exit if no key on the keypad is pressed after 10 seconds.  If this 

occurs, and you wish to re-access the menu, simply press any of the keys on the keypad, 

provided that the IDS is not actively performing a task (the yellow LED is illuminated), except 

for when the instrument’s battery is charging.   

7.3. LED and Alarm Signals 

The IDS contains LED lights and an alarm to provide you with feedback about the activities on 

the IDS.  The LEDs (green, yellow, and red) will light alone or in combination depending on the 

status of the IDS.  The status of lit LEDs is explained below. 

 Green LED only - Indicates that the IDS is fully charged and available for use. 

 Yellow LED only - Indicates that the IDS is busy. 

 Green and yellow LEDs - Indicate that the IDS is currently charging. 

 Red LED only - Indicates that the IDS is unavailable due to an error or a problem.   

 

NOTE:   Never dock or undock an instrument while the yellow LED is illuminated (IDS is busy), 

except when the instrument battery is charging (both yellow and green LEDs are lit). 

 

The alarm is used to indicate a problem with the IDS.  For example, if an instrument is removed 

from the IDS before a calibration is complete, an alarm will sound.   

The LEDs and alarm work in combination with the LCD display to indicate the status of the IDS.   

Below is a series of tables that show possible LCD display, LED and alarm combinations when 

the IDS is in various states. 
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The following table displays possible feedback when the IDS is on, but no instrument is docked. 

Table 7-1.  System Feedback (No Instrument Docked) 

LCD Display LED Alarm Description 

Starting <type of 

instrument>  
Yellow  Off  IDS is booting up.   

Discovering  Yellow  Off  
IDS has just finished booting up and is 

identifying itself to the Docking Station Server.   

Diagnosing  Yellow  Off  Running diagnostics on the IDS  

Updating Data  Yellow  Off  Updating the system with new IDS settings  

Unavailable  Red  Off  
IDS is not functioning properly.  Check the 

DSS error log.   

Unavailable Server  Red  Off  IDS cannot connect to the server.   

 
The following table displays possible feedback when the IDS is on, and an instrument is docked. 

Table 7-2.  System Feedback (Instrument Docked) 

LCD Display LED Alarm Description 

Registering Instrument  Yellow  Off  
The instrument is being registered in the 

docking station system.   

Discovering  Yellow  Off  
IDS is detecting the instrument that was just 

docked. 

Calibrating  Yellow  Off  Currently calibrating the instrument. 

Testing Instrument  Yellow  Off  
Currently performing bump test on the 

instrument. 

Downloading Datalog Yellow  Off  Downloading datalog data to the DSS. 

Downloading Alarm 

Events 
Yellow Off Downloading alarm events from the instrument. 

Clearing Datalog  Yellow  Off  Clearing datalog data from the instrument. 

Diagnosing Instrument  Yellow  Off  Running diagnostic tests on the instrument. 

Updating Instrument  Yellow  Off  Updating settings on the instrument. 

Current Date and Time 

Charging  
Yellow  Off  Instrument’s battery is being charged. 

Download Manual 

Operations 

Yellow Off Downloads manual calibration and bump test 

operations performed by user. 

Clear Manual 

Operations 

Yellow Off Clears all manual operations once downloaded 

to DSS. 
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LCD Display LED Alarm Description 

Unavailable Instrument  Red  On  
There is a problem with the instrument, such as 

a failed calibration.   

Unavailable Gas  Red On 
The IDS could not locate required gas for a 

bump test or a calibration.   

Undocked Instrument  Red On 
An instrument was undocked from the IDS 

during an event.   

Unsupported Software 

Version  
Red On 

The docked instrument’s software is not 

supported for use with the docking station.   

Current Date and Time 

Battery Error  
Red Off 

There is a problem with the battery in the 

docked instrument.   

Service Instrument 

Soon 

Red 

and 

Green 

Off Instrument needs service by Industrial 

Scientific. Applies to Tango instrument only. 

 

7.4. Forced Bump Tests 

You can force an IDS to run a bump test on an instrument by using the IDS menu.  You may 

wish to do this when you want to run a bump test before the next automatic bump test scheduled 

for the instrument. 

To force a bump test, follow the instructions listed below. 

Step Instruction 

1. Make sure that the IDS is on and that the proper gas cylinder is connected to the 

docking station and that it is correctly configured in the DSSAC.  See the 

Configuring Gas Cylinders section for more information about configuring gas 

cylinders. 

2. Dock the instrument in the IDS. 

3. Press any of the keys on the IDS keypad to access the main menu. 
 
 

NOTE:   The menu cannot be used when the IDS is performing an instrument action.   

 

NOTE:  The menu cannot be used if the Menu Locked setting for the IDS in DSSAC is set to 

“Yes.”  

 

Step Instruction 

4. Use the ARROW keys on the keypad until Instrument is highlighted. 

5. Press the ENTER key.  The Instrument menu appears. 

6. Use the ARROW keys on the keypad to select Bump Test.  Press the ENTER key. 
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Step Instruction 

7. The LCD displays a confirmation prompt: “Are you sure?”   Use the ARROW keys 

on the keypad to highlight Yes and then press the ENTER key.  If you select No, the 

LCD returns to the main menu. 

8. The IDS begins performing the bump test.  The LCD displays “Testing Instrument.”  

The yellow LED is illuminated. 

9. When the bump test is complete, the LCD returns to the main menu, and the green 

LED is illuminated. 
 

NOTE:  In the event of a failed sensor (CL2, HCL, or NH3), the docking station ignores any 

large reading that are above the sensor’s maximum reading.  In addition, the docking station 

ignores any negative readings whose absolute value is larger than the sensor’s maximum reading. 

 

NOTE:  If the instrument fails the bump test, the IDS will perform a calibration.  If the 

calibration fails, then the red LED illuminates and the IDS sounds an alarm.  If the oxygen 

sensor fails the bump test, the unit will display an “Unavailable Instrument” message. 

7.5. Calibration 

7.5.1. Forced Calibrations 

You can force an IDS to calibrate an instrument by using the IDS menu.  You may wish to do 

this when you want to perform a calibration prior to the next calibration scheduled for the 

instrument.   

To force a calibration, follow the instructions listed below. 

Step Instruction 

1. Make sure that the IDS is on and that the proper gas cylinder is connected to the IDS 

and that it is correctly configured in the DSSAC.  See section 6.6 Configuring Gas 

Cylinders for more information about configuring gas cylinders.   

2. Dock the instrument in the IDS. 

3. Press any of the keys on the IDS keypad to access the main menu. 
 
 

NOTE:  The menu cannot be used when the IDS is performing an instrument action.   

 

NOTE:  The menu cannot be used if the Menu Locked setting for the IDS in DSSAC is set to 

“Yes.”  
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Step Instruction 

4. Use the ARROW keys on the keypad until Instrument is highlighted. 

5. Press the ENTER key.  The Instrument menu appears. 

6. Use the ARROW keys on the keypad to highlight Calibrate.  Press the ENTER key. 

7. The LCD displays a confirmation prompt: “Are you sure?”   Use the ARROW keys 

on the keypad to highlight Yes, and then press the ENTER key.  If you select No, the 

LCD returns to the main menu. 

8. The IDS begins performing the calibration.  The LCD displays “Calibrating.”  The 

yellow LED is illuminated. 

9. When the calibration is complete, the LCD returns to the main menu and the green 

LED is illuminated. 
 
 

NOTE:  If the instrument fails the calibration, the red LED illuminates and the docking station 

sounds an alarm.   

 

7.5.2. O2 Sensor Failures During Calibrations 

If an O2 sensor fails a DSX bump test in any docked instrument, the IDS will display the red 

light, and the message “Unavailable instrument”, and will beep.  Underneath the “Unavailable 

Instrument” message, the IDS will display “O2 Bump Failure” in parenthesis. 

 

Figure 7-2.  Error Screen after O2 Sensor Failure 

An automatic calibration will not take place if an O2 sensor fails a bump test, regardless of what 

other sensors are installed.  In addition, most forced events will also not be allowed.  This 

prevents the user from simply forcing a calibration, clearing the error, and thinking all is well. 

A forced Bump test will be the only type of forced event which is allowed in this case.  All other 

forced events will simply result in the same “unavailable instrument” message. 

 

NOTE:  The only way to clear this error is to either replace the sensor, or to force a bump test 

and have it pass. 
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7.6. Download and Clearing Datalog Data 

You can force an IDS to download datalog data from an instrument to the Docking Station 

Server.  When you download datalog data from an instrument, the instrument’s datalog 

memory is also cleared.   

You can also choose to clear datalog data on an instrument without downloading it to the system.   

7.6.1. Forced Datalog Download 

To download datalog data, follow the instructions listed below. 

Step Instruction 

1. Make sure that the IDS is on. 

2. Dock the instrument in the IDS. 

3. Press any of the keys on the IDS keypad to access the main menu. 
 

 

NOTE:  The menu cannot be used when the IDS is performing an instrument action.   

 

NOTE:  The menu cannot be used if the Menu Locked setting for the IDS in DSSAC is set to 

“Yes.”  

NOTE:  If two sensors are installed in the Tango TX1 when the data are logged, DS2 will 

download data for three sensors. Data from the installed sensors are logged and downloaded as 

sensor 1 and sensor 2 data. Data that are logged and downloaded as sensor 3 (or VIRTUAL) are 

algorithm-calculated values that are based on sensor 1 and sensor 2 data. DSSAC displays only 

the VIRTUAL data. 

 If only one sensor is installed or working when the data are logged, the downloaded and 

DSSAC-displayed data will contain only information for that sensor.  

 

 

Step Instruction 

4. Use the ARROW keys on the keypad until Instrument is highlighted. 

5. Press the ENTER key.  The Instrument menu appears. 

6. Use the ARROW keys on the keypad to select Download Datalog.  Press the ENTER 

key. 

7. The LCD displays a confirmation prompt: “Are you sure?”   Use the ARROW keys 

on the keypad to highlight Yes, and then press the ENTER key.  If you select No, the 

LCD returns to the main menu. 

8. The IDS begins downloading the datalog data.  The LCD displays “Downloading 

Datalog.”   The yellow LED is illuminated. 

NOTE:  The instrument’s datalog memory is also cleared.  The LCD displays 

“Clearing Datalog” when the datalog data is being cleared. 
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Step Instruction 

9. When the datalog download is complete, the LCD returns to the main menu and the 

green LED is illuminated. 
 

7.6.2. Clearing Datalog Data 

To clear datalog data from an instrument’s memory without downloading it to the system, follow 

the instructions listed below. 

Step Instruction 

1. Make sure that the IDS is on. 

2. Dock the instrument in the IDS. 

3. Press any of the keys on the IDS keypad to access the main menu. 
 
 

NOTE:  The menu cannot be used when the IDS is performing an instrument action.   

 

NOTE:  The menu cannot be used if the Menu Locked setting for the IDS in DSSAC is set to 

“Yes.”  

 

Step Instruction 

4. Use the ARROW keys on the keypad until Instrument is highlighted. 

5. Press the ENTER key.  The Instrument menu appears. 

6. Use the ARROW keys on the keypad to select Clear Datalog.  Press the ENTER key. 

7. The LCD displays a confirmation prompt: “Are you sure?”   Use the ARROW keys 

on the keypad to highlight Yes, and then press the ENTER key.  If you select No, the 

LCD returns to the main menu. 

8. The IDS clears the datalog data from the instrument’s memory.  The LCD displays 

“Clearing Datalog.”  The yellow LED is illuminated. 

9. When the datalog data has been cleared, the LCD returns to the main menu, and the 

green LED is illuminated. 

 

7.7. IDS Diagnostics 

You can manually run a pressure diagnostics test for an IDS using the menu on the IDS LCD 

display.  This feature can be used to reset the IDS to an available state after a leak has been fixed.   

For example, if a fitting is not physically connected, the system-automated pressure diagnostics 

test will detect a leak.  After the test fails, the LCD on the IDS will display “Unavailable 

Leaking.” Once the problem has been corrected, you can manually run the pressure diagnostics 

test to remove the error state, and allow the IDS to be used.   
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To run IDS Diagnostics, follow the instructions listed below. 

Step Instruction 

1. Press any of the keys on the IDS keypad to access the main menu. 
 

 

NOTE:  The menu cannot be used if the Menu Locked setting for the IDS in DSSAC is set to 

“Yes.”  

 

Step Instruction 

2. Use the ARROW keys on the keypad until Docking Station is highlighted. 

3. Press the ENTER key.  The Docking Station menu appears. 

4. Use the ARROW keys on the keypad to select Diagnose.  Press the ENTER key. 

5. The LCD displays a confirmation prompt: “Are you sure?” Select Yes, and press the 

ENTER key.   

6. The LCD screen displays “Diagnosing.”  If the leak issue has been corrected, the 

LCD screen displays the current date and time.  The green LED is illuminated. 

7. If the diagnostic test fails again, contact Industrial Scientific Corporation for service.  

See section 13.7 Industrial Scientific Support Services for contact information. 
 

7.8. Instrument Docking Station Operating Guidelines 

Use the following safety guidelines to help to ensure your own personal safety and to help 

protect your Instrument Docking Station and working environment from potential damage.   

 

CAUTION:  Compressed gas cylinders and their contents may present specific hazards to the 

user.  Use only in a well-ventilated area.  Use only in accordance with the instructions and 

warnings as marked on the cylinder and the appropriate Material Safety Data Sheet. 

 

7.8.1. General 

A Instrument Docking Station (IDS) is a sensitive piece of equipment that should be treated with 

care.  It should be handled in the same way you would handle a laptop computer.  General 

guidelines are listed below. 

 To reduce the risk of fire or electric shock, do not expose the IDS to rain or moisture.   

 Do not operate an IDS with any cover(s) removed.   

 Avoid extremes in temperature.  Typical operating temperature should be between -5º C 

(23º F) and 40º C (122º F).   

 Do not drop the unit. 

 The IDS should be serviced only by qualified service personnel.  Contact Industrial 

Scientific Corporation for examination, repair, or adjustment.   
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 To help prevent electric shock, plug the IDS power cable into properly grounded 

electrical outlets.  These cables are equipped with 3-prong plugs to help to ensure proper 

grounding.  Do not use adapter plugs or remove the grounding prong from a cable.  If you 

must use an extension cable, use a 3-wire cable with properly grounded plugs.   

 Do not use corrosive chemicals or vapors near the IDS.   

 Do not immerse the cord or plug in water.   

 To avoid the potential hazard of electric shock, do not use a IDS during an electrical 

storm without proper protection.   

 To avoid the potential hazard of electric shock, do not connect or disconnect any cables 

to or from the IDS during an electrical storm.   

 To avoid possible damage to the system board, wait 5 seconds after turning off the IDS 

before restarting.   

 To avoid shorting out an IDS when disconnecting a network cable, first unplug the cable 

from the LAN Port on the back of the IDS, and then from the network jack.  When 

reconnecting a network cable to a IDS, first plug the cable into the network jack, and then 

into the LAN Port on the back of the IDS.   

 To help protect an IDS from sudden, transient increases and decreases in electrical power, 

use a surge suppressor, line conditioner, or uninterruptible power supply (UPS).   

 Be sure nothing rests on an IDS’s cables and that the cables are not located where they 

can be stepped on, cut, or tripped over.   

 Do not push any objects into the openings of an IDS.  Doing so can cause fire or electric 

shock by shorting out interior components.   

 Keep IDSs away from radiators and heat sources.  Do not block cooling vents. Avoid 

placing loose papers underneath an IDS; do not place an IDS in a closed-in wall unit, or 

on a bed, sofa, or rug.   

 An IDS is equipped with a fixed-voltage power supply.  The IDS will operate at only one 

voltage (see the regulatory label on the outside of the IDS for its operating voltage).   

 

7.8.2. Cleaning 

Before you clean your IDS, disconnect the power cord from the electrical outlet.  Clean your IDS 

with a soft cloth dampened with water.  Do not use liquid or aerosol cleaners, which may contain 

flammable substances.  Do not spray water directly onto the unit.   

 

7.8.3 Explanation of Symbols Used on Unit 

 

Symbol Description 

 Direct Current 

 Alternating Current 

 
Protective Conductor Terminal 

 
Caution (refer to accompanying documents) 
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7.8.4 Specifications 

Physical Specifications 

Instruments supported GasBadge Pro, MX6 iBrid, Tango TX1, Ventis MX4, or Ventis LS 

Dimensions GasBadge Pro, Tango TX1: H: 22.66 cm (8.92 "); W: 16.89 cm     (6.65 "); 

D: 27.31 cm (10.75 ") 

Ventis Pro4, Ventis Pro5, Ventis MX4, Ventis LS: H: 24.97 cm (9.83 "); W: 

16.89 cm (6.65 "); D: 27.31 cm (10.75 ") 

MX6 iBrid: H: 25.3 cm (9.96 "); W: 16.89 cm (6.65 "); D: 27.31 cm (10.75 ") 

Gas and fresh-air  intake ports 3-port configuration: two gas; one fresh-air   

6-port configuration: five gas; one fresh-air 

Pump flow rate 1.2 SCFH (550 mL/min) 

Communication 10/100 Ethernet support, RJ45 Cat5 connection (or greater); for longer 

cables, 14−110 m [46–360 ‘] use a solid conductor shielded twisted pair 

cable.  

USB port for data storage device or printer (for use with DSX Standalone 

Mode only). 

Display 128 x 64 dot matrix LCD  

Language options: English, French, German, Portuguese (Brazil), and 

Spanish 

Performance Specifications 

Operating temperature range 0–50 ºC (32–122 ºF) 

Operating humidity range 0–80% relative humidity (RH) up to 30 ºC (86 ºF), decreasing linearly to 50% 

RH at 50 ºC (122 ºF) 

External power supply ratings Supply voltage: 100–240 VAC/12 VDC 

Frequency range: 50–60 Hz 

Current rating: 5A 

7.8.5. Regulatory Notices 

Electromagnetic Interference (EMI) is any signal or emission, radiated in free space or conducted 

along power or signal leads, that endangers the functioning of radio navigation or other safety 

service or seriously degrades, obstructs, or repeatedly interrupts a licensed radio communications 

service.  Radio communications services include but are not limited to AM/FM commercial 

broadcast, television, cellular services, radar, air-traffic control, pager, and Personal 

Communication Services (PCS).  These licensed services, along with unintentional radiators 

such as digital devices, including computer systems, contribute to the electromagnetic 

environment.   

7.8.6. Wiring Requirements 

Voltage used must be the same as specified on this device (100/240 VAC) or 12VDC.  Using a 

higher voltage is dangerous and may result in a fire or other accident causing device damage.  

Using a lower voltage will cause unexpected results.  Industrial Scientific is NOT responsible for 

damage resulting from improper use of an IDS.   

 

     
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8.1. Introduction 

An event is an activity that automatically occurs in the docking station.  You determine when 

these events run by scheduling them in the DSSAC.   

 

NOTE:  Only users assigned to the Systems Administrator role can edit and add events.  Users 

assigned to the Technician role may view events, but not change them.   

 

The types of events that you can schedule at particular dates and/or times are: 

 Calibration - Used to automatically calibrate an instrument.   

 Alarm Events Download - Used to automatically downloading alarm events from an 

instrument 

 Bump Test - Used to automatically perform bump tests on an instrument.   

 Bump Test (Tango) – Applies only to Tango instruments. Bump Test (Tango) and 

“Bump Test” global events have no effect on each other. 

 Datalog Download - Used to download datalog data from an instrument.   

 Diagnostics - Used to run diagnostic tests on an instrument or IDS.  The results of these 

tests are sent to the iNet Network Operations Center for analysis.   

 Download Manual Operations - Downloads manual calibration and bump test 

operations performed by user. 
 

NOTE:  There are also two events that occur automatically in the system.  These events are 

Settings Update and Settings Read.  “Settings Update” controls the transfer of option 

information from the server to instruments and IDSs.  “Settings Read” handles registration of 

new Docking Stations, instruments, and components.  These events occur daily for IDSs, and 

upon docking for instruments.   

 

NOTE:  If two sensors are installed in the Tango TX1 when the data are logged, DS2 will 

download data for three sensors. Data from the installed sensors are logged and downloaded as 

sensor 1 and sensor 2. Data that are logged and downloaded as sensor 3 (or VIRTUAL) are 

algorithm-calculated values that are based on sensor 1 and sensor 2 data. DSSAC displays only 

the VIRTUAL data. 
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 If only one sensor is installed or working when the data are logged, the downloaded and 

DSSAC- displayed data will contain only information for that sensor.  

There are two types of events. 

 Global -These events are built into the system, and apply to all IDSs or instruments that 

are configured in your docking station network.  There are Global events for both IDSs 

and instruments.   

 Special -These events are created by an administrator, and apply only to the instruments 

designated to use them.  Special events override Global events.  For example, if an 

instrument is configured to use a Special calibration event, it calibrates according to the 

schedule set in the Special event, and not the Global calibration event.  The Global 

calibration event is ignored for that instrument.   

Events can be run at the following intervals.  

 Upon Docking -The event will run each time that an instrument is placed on the IDS.  

This interval only applies to instrument events.   

 Daily -The event runs each day at a specified time, or whenever the IDS or instrument is 

available that day.   

 Weekly - The event runs on the specified day of the week at a specified time, or 

whenever the IDS or instrument is available on the specified day or thereafter.   

 Monthly -The event runs on the specified day of the month at a specified time, or 

whenever the IDS or instrument is available on the specified day or thereafter.   

 Quarterly - The event runs once each 90 days, or whenever the IDS or instrument is 

available on the specified day or thereafter.   

 

NOTE: If an IDS or instrument is not available at the scheduled time, the event will run for that 

IDS or instrument the next time it is available.  For example, if an instrument event is set up to 

run weekly on Tuesdays, and an instrument is not docked until Wednesday, the event will run on 

Wednesday for that instrument.   

 

8.2. Global Events 

Global events apply to all IDSs or instruments in your docking station network.  You cannot add 

or remove global events.  However, you can schedule global events to run at a time that you 

specify.   

8.2.1. Global Instrument Docking Station Events 

There is one global Instrument Docking Station event built-in to the system:  

 Diagnostics. 

By default, the Diagnostics IDS event is set to run Daily at midnight.   

 

NOTE:  You cannot disable the IDS global event.   
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To view or edit the global IDS event, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Expand the Events option in the navigation pane, if necessary. 

3. Expand the Docking Station option that is underneath Events, if necessary. 

4. Click on Global.  The IDS global event appears in the contents pane. 

 

 

 

Figure 8-1.  IDS Global Event Screen 

 

Step Instruction 

5. Double-click on the Diagnostics event. 

Alternative:  You can also click on the File menu and select Properties. 

Alternative:  You can also right-click on the event and select Properties from the 

context menu. 



 

202 

 

 

 

Figure 8-2.  IDS Global Event Screen 

 

Step Instruction 

6. The Edit Docking Station Event dialog box appears.  It contains two tabs: 

 General - Contains information about the event and when it is scheduled to 

run.   

 Journal - Contains records of the last time that the event ran for various IDSs.  

See Chapter 9 for more information about the Journal.   
 

 

NOTE:  Only users assigned to the Systems Administrator role can edit events.  Users assigned 

to the Technician role may view events, but not change them.   

 

NOTE:  Global IDS events cannot be disabled.   
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Step Instruction 

7. From the General tab, select an Interval.  The choices are: 

 Daily -If you select “Daily,” you must also specify an Effective Date to 

indicate when the event should start running.   

 Weekly -If you select “Weekly,” you must also select a Day (e.g., Sunday, 

Monday, etc.) to indicate the day of the week on which the event should run, 

and specify an Effective Date to indicate when the event should start running.   

 Monthly -If you select “Monthly,” you must also select a Day (e.g., 1st, 2nd, 

3rd .  31st) to indicate the day of the month on which the event should run, 

and specify an Effective Date to indicate when the event should start running.   

 Quarterly - The event runs once each 90 days, or whenever the IDS or 

instrument is available on the specified day or thereafter. 
 

NOTE:  If you select the 30th or 31st as the Day, the event runs on the last day of the month for 

months that do not have 30 or 31 days, e.g., the event would run on February 28th.   

 

Step Instruction 

8. Click OK to save the changes to the Event. 
 

 

8.2.2. Global Instrument Events 

The global instrument events that are built-in to the system are:  

 Bump Test  

 Bump Test (Tango) 

 Diagnostics  

 Calibration  

 Alarms 

 Download Datalog 

 Download Manual Operations 

 

See Table 8-1 for the default settings for each of these events.   

 

NOTE:  You can disable instrument global events that you do not want to run.   

 

NOTE:  The “Bump Test (Tango)” global event applies only to Tango instruments. Bump Test 

(Tango) and “Bump Test” global events have no effect on each other.  

 

 

To view or edit a global Instrument Event, follow the instructions listed below. 
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Step Instruction 

1. Open the DSSAC application. 

2. Expand the Events option in the navigation pane, if necessary. 

3. Expand the Instrument option that is underneath Events, if necessary. 

4. Click on Global.  The instrument global events appear in the contents pane.  The 

contents pane displays the Event ID, the Type of event, and the current scheduled 

Interval.  If the Event ID column contains an icon with a red line through it, the event 

is disabled. 
 

 

Figure 8-3.  Instrument Global Events Screen 

Step Instruction 

5. Double-click on the Event whose settings you would like to view or edit. 

Alternative:  You can also click on the File menu and select Properties. 

Alternative:  You can also right-click on the event and select Properties from the 

context menu. 

6. The Edit Instrument Global Event dialog box appears.  It contains two tabs. 

 General Contains information about the event and when it is scheduled to run. 

 Journal Contains records of the last time that the event ran for various 

instruments.  See Chapter 9 for more information about the Journal. 
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Figure 8-4.  Edit Global Instrument Event Dialog Box 

 

NOTE:  Only users assigned to the Systems Administrator role can edit events.  Users assigned 

to the Technician role may view events, but not change them.   

 

Step Instruction 

7. From the General tab, select an Interval.  The choices are: 

 Upon Docking - If you select “Upon Docking,” you must also specify an 

Effective Date when the event should start running.  The event runs each time 

that an instrument is docked in the IDS.   

 Daily - If you select “Daily,” you must also specify an Effective Date to 

indicate when the event should start running and a Run Time to indicate the 

time at which the event should run. Daily calibration and bump test events 

may be set to run up to 4-times per day at intervals of 6 hours, 8 hours, 12 

hours and 24 hours.  

 Weekly - If you select “Weekly,” you must also select a Day (e.g., Sunday, 

Monday, etc.) to indicate the day of the week on which the event should run, 

and specify an Effective Date to indicate when the event should start running 

and a Run Time to indicate the time at which the event should run. 

 Monthly - If you select “Monthly,” you must also select a Day (e.g., 1st, 2nd, 

3rd .  31st) to indicate the day of the month on which the event should run, 

and specify an Effective Date to indicate when the event should start running 

and a Run Time to indicate the time at which the event should run. 

 Quarterly - The event runs once each 90 days, or whenever the IDS or 

instrument is available on the specified day or thereafter.   

 
 

NOTE:  If you select the 30th or 31st as the Day, the event runs on the last day of the month for  

months that do not have 30 or 31 days, e.g., the event would run on February 28th.   
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Step Instruction 

8. If you do not want the event to run, click in the checkbox next to the Disabled option.  

If the Event is already disabled, you can also enable the event by deselecting the 

checkbox next to the Disabled option. 

9. Click OK to save the changes to the Event. 
 

Table 8-1.  Default Settings for Global Instrument Events 

Event Default Settings 

Bump Test  Interval:  Daily, 24 hours 

Effective Date:  1/1/03 

Run Time:  12:00 AM  

Bump Test (Tango) Interval:  Daily, 24 hours 

Effective Date:  4/10/33 

Run Time:  12:00 AM 

Diagnostics  Interval:  Daily, 24 hours 

Effective Date:  1/1/03 

Run Time:  12:00 AM  

Calibration  Interval:  Monthly 

Day:  1st 

Effective Date:  1/1/03 

Run Time:  12:00 AM  

Download Datalog Interval:  Upon Docking  

Effective Date:  1/1/03  

Alarms Interval:  Upon Docking 

Run Time:  After Download Datalog 

Effective Date:  1/1/03 

Download Manual 

Operations 

Interval:  Upon Docking 

Run Time:  12:00 AM 

Effective Date:  1/1/03 

 

8.3. Special Events 

Special Events are custom events that you can assign to specific instruments.  If an instrument is 

assigned to a Special Event, the Global Event no longer applies to that instrument.  You may 

wish to setup special events to handle groups of instruments that have special maintenance 

requirements.  For example, you may have a group of heavily used instruments that you wish to 

calibrate weekly instead of monthly, as specified in the global event.   
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You can add the following types of Special Events:  

 Bump Test 

 Bump Test (Tango) 

 Diagnostics 

 Calibration 

 Alarms 

 Download datalog 

 Download Manual Operations 

 NOTE:  The “Bump Test (Tango)” special event is system created. It applies to any 

Tango instrument that is in single-sensor mode or has two installed sensors and one is in 

calibration fail. When any Tango TX1 instrument is in either state, DSS will override any 

other bump test event for the unit.  

To add a Special Event for an instrument, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Expand the Events option in the navigation pane, if necessary. 

3. Expand the Instrument option that is underneath Events, if necessary. 

4. Click on Special.  Any instrument Special Events that have been previously added 

appear in the contents pane.  The contents pane displays the Event ID, the Type of 

event, the current scheduled Interval, and the Event Name.  If the Event ID column 

contains an icon with a red line through it, the event is disabled. 

5. Click the File menu and select Add. 

Alternative:  You can also right click on the Special option in the navigation pane 

and select Add from the context menu. 
 

 

NOTE:  Only users assigned to the Systems Administrator role can add special events.  Users 

assigned to the Technician role may view events, but not change them.   

 

Step Instruction 

6. The Add Instrument Special Event dialog box appears. 

7. Select an Event Owner from the drop down list of users.  Only the event owner or the 

system administrator DSSUSER will be able to edit the special event. 
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Step Instruction 

8. Select an Event Code.  The choices are: 

 Bump Test 

 Bump Test (Tango) 

 Diagnostics  

 Calibration  

 Alarms 

 Download Datalog 

 Download Manual Operations 

9. Select an Interval.  The choices are: 

 Upon Docking - If you select “Upon Docking,” you must also specify and 

Effective Date when the event should start running.  The event runs each time 

that an instrument is docked in the IDS.   

 Daily -  If you select “Daily,” you must also specify an Effective Date to 

indicate when the event should start running and a Run Time to indicate the 

time at which the event should run. Daily calibration and bump test events 

may be set to run up to 4-times per day on intervals of every 6 hours, 8 hours, 

12 hours or 24 hours.  

 Weekly - If you select “Weekly,” you must also select a Day (e.g., Sunday, 

Monday, etc.) to indicate the day of the week on which the event should run, 

and specify an Effective Date to indicate when the event should start running 

and a Run Time to indicate the time at which the event should run.   

 Monthly - If you select “Monthly,” you must also select a Day (e.g., 1st, 2nd, 

3rd, …, 31st) to indicate the day of the month on which the event should run, 

and specify an Effective Date to indicate when the event should start running 

and a Run Time to indicate the time at which the event should run.   

 Quarterly - The event runs once each 90 days, or whenever the IDS or 

instrument is available on the specified day or thereafter.   
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Figure 8-5.  Add Special Instrument Event Dialog Box 

 

NOTE:  If you select the 30th or 31st as the Day, the event runs on the last day of the month for 

months that do not have 30 or 31 days, e.g., the event would run on February 28th.   

 

Step Instruction 

10. Enter a name for the event in the Event Name field. 

11. In the Instruments field, select the instrument to which the event should apply.  You 

can select multiple instruments by pressing the CTRL key on your keyboard while 

clicking on each instrument. 

12. Click the Add button.  The instruments are added to the Instruments Included in 

Event box.  To remove an instrument from a special event, select the serial number of 

the instrument that should be removed from the Instruments Included in Event list, 

and click the Remove button. 

13. Click OK to save the event.  The event is added to the list of Special Events in the 

contents pane. 
 

 

NOTE:  The next time that you view the special event, the Journal tab will be visible.  The 

Journal tab contains records of the last time that the event ran for various instruments.  See 

Chapter 9 for more information about the Journal.   
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8.4. Defaults for Scheduled Events  

For new DSS installs, the table below shall be the default schedules for all events.  For upgrades 

to previous versions of DSS, the default schedule is not altered by the installer.  For upgrades, all 

current event schedules remain unmodified by the installer.  See the table below. 

 

Table 8-2.  Defaults for Scheduled Events 

Event Priority Schedule Time Enabled 

IDS Settings Read 1 Daily 12:00am Yes 

IDS Settings Update 2 Daily 12:00am Yes 

IDS Diagnostics 3 Daily 12:30am Yes 

Instrument Settings Read 4 Upon Docking 1:00am Yes 

Instrument Settings Update 5 Upon Docking 1:00am Yes 

Instrument Diagnostics 6 Upon Docking 1:30am Yes 

Manual Operations Download 7 Upon Docking 1:00 am Yes 

Bump Test 8 Daily 2:00am Yes 

Calibration 9 Monthly 2:00am Yes 

Datalog Download 10 Upon Docking 2:30am Yes 

Alarm Events Download 11 Upon Docking 3:00am Yes 

 

 

 

     
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9.1. Introduction 

The Journal provides a history of when the Global and Special events ran in your docking station 

network.  The Journal records events that ran successfully and unsuccessfully. 

The Journal tracks only the last occurrence of each event for each IDS or instrument.  When an 

event occurs again for an instrument or IDS, the old entry is overwritten.  For example, if 

Instrument X was last calibrated on 8/01/06, the Journal contains this data.  When the next 

calibration occurs on 9/01/13, the journal entry for 8/01/14 is replaced with the new entry for 

9/01/13.   

Journal entries are overwritten based upon the event’s ID.  It is possible to see multiple journal 

entries for the same type of event for an instrument if it occurred as a result of different events.  

For example, if an instrument calibrates under the global event, and then it is assigned to a 

special calibration event, journal entries will exist for both the global event and the special event.   

9.2. Viewing Journal Entries 

You can view Journal entries for your entire docking station network or for an individual event.  

Journal entries are created for all of the global and special events, and the two system events, 

“Settings Update” and “Settings Read.”  To view all Journal entries, follow the instructions listed 

below. 

Step Instruction 

1. Open the DSSAC application. 

2. Expand the Events option in the navigation pane, if necessary. 

3. Click on Journal. 

4. The Journal entries appear in the contents pane.  For each entry, the following 

information displays: the Date/Time at which the event occurred, the Serial Number 

of the instrument or IDS for which the event ran, and the Type of event (e.g., Bump 

Test, Calibration, Diagnostics) that ran. 
 

 

NOTE:  Journal entries that appear in blue text represent instruments that are currently docked, 

or IDSs that are currently running on the network.   
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Step Instruction 

5. Double-click on the journal entry to view detailed information about the event that 

occurred.  The Event Journal Details dialog box appears. 

6. Click OK to close the Event Journal Details dialog box. 

7. You can sort the Journal entries by clicking on a column header in the contents pane. 
 

 

 

Figure 9-1.  Event Journal Details Dialog Box 

 

NOTE:  The journal details display in the language that is set for the DSSAC.   

 

NOTE:  Journal details having entries greater than 8K bytes are truncated. 
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Figure 9-2.  Sample Event Journal Details Screen 

An IDS uploads its IP Address to the DSS.  The DSS uploads the following network-related 

information to iNet for each IDS, if it has the information for the IDS. 

1. Docking station’s IP Address. 

2. MAC address of docking station’s wired Ethernet port. 

3. MAC address of wireless card (only if there is one). 

4. Docking station’s server IP Address (or host name if IDS is configured with a specific 

server host name instead of server IP address; e.g., “AN1632”). 
 

To view Journal entries for an individual event, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Expand the Events option in the navigation pane, if necessary. 

3. Expand the docking station or instrument options that are underneath Events, if 

necessary, depending on the type of event you wish to view. 

4. For docking stations, click on Global.  For instruments, click on either Global or 

Special. 

5. The list of configured events appears in the contents pane. 

6. Double-click the event whose journal you wish to view. 

Alternative:  You can also right-click on the event and select Properties from the 

context menu. 
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Step Instruction 

7. Click on the Journal tab.  For each journal entry you can view the Date/Time at 

which the event occurred, and the Serial Number of the instrument or IDS for which 

the event was run. 

 

 

 

Figure 9-3.  Viewing Journal Entries for an Individual Event 

 

 

     



 

 

 

Default Settings 

Chapter 

10 
 

10.1. Introduction 

This section describes how to maintain the default settings for alarms and calibration gases in the 

DSSAC.  These functions are only available to users who are assigned to the Systems 

Administrator role.  However, a user assigned to the Technician role can view the settings, but 

not change them.   

10.2. Default Alarm Settings 

When first installed, DSX contains a series of default alarm settings for each of the compatible 

instruments and each of the sensor types that can be used with them.  These settings are the 

recommended thresholds for the following alarms:  

 Alarm Low -The gas concentration threshold that triggers the low 

alarm.  The alarm sounds when the instrument detects that the gas 

concentration has reached or exceeds this level.  The exception to 

this rule is for Oxygen (O2) where the alarm sounds when the 

concentration of oxygen reaches or falls below this level.   

 Alarm High -The gas concentration threshold that triggers the 

high alarm.   

 TWA -The gas concentration threshold for Time Weighed 

Average (TWA) readings that triggers an alarm.   

 STEL -The gas concentration threshold for Short Term Exposure 

Limit (STEL) readings that triggers an alarm.   

Default Alarm Settings apply only to instruments when they are docked for the first time, or to 

new sensors whose information is not in the database.  Therefore, you should set up your default 

settings before docking any instruments that are registered in the database.  Changing the Default 

Alarm Settings after an instrument has been registered will not update the instrument sensor’s 

settings, unless a new sensor is installed in the instrument.  You can, however, change an 

individual sensor’s settings to different alarm values, if desired, using the DSSAC.  See section 

5.8 The Components Tab for information about sensor-specific alarm settings.   

 

NOTE:  Only users assigned to the Systems Administrator role may configure Default Alarm 

Settings in the DSSAC.   
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10.3. Modifying Default Alarm Settings 

To modify Default Alarm settings, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the View menu and select Default Alarm Settings. 

3. The Company Alarms dialog box appears.  It contains multiple tabs, one for each 

compatible instrument type. 

4. Each tab contains a list of sensor types that can be used with the instrument.  Select 

the instrument for which you want to change alarm settings. 

5. To edit an alarm setting for a sensor type, double-click on its entry in the list. 

Alternative:  You can select the sensor type, and click the Properties button. 

Alternative:  You can also right-click on the sensor type and select Properties from 

the context menu. 

NOTE:  Access to the Alarms Settings screen (via the double-click method or the 

Properties button) is only available if the user is an administrator. 

 

 

Figure 10-1.  Company Alarms Dialog Box 
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Step Instruction 

6. The Alarm Settings dialog box appears (for Administrators only).  By default, the 

Factory setting is selected.  You can override this setting by selecting Company. 
 

 

Figure 10-2.  Alarm Settings Dialog Box 

 

NOTE:  You can return to the factory settings by editing the Alarm Setting and selecting 

Factory.   

 

Step Instruction 

7. You can now edit the values for Alarm Low, Alarm High, Alarm TWA and Alarm 

STEL.  Click OK to confirm your changes. 

NOTE:  Look at the Sensor Type to determine the type of value that should be 

entered for the alarm values (e.g., PPM, %VOL, or %LEL). 

8. The sensor type appears in the list in bold type, which indicates that custom settings 

have been entered, but are not yet saved.  

9. In the Company Alarms dialog box, Click on Update Sensors to save the changes.  

10. Click OK to close the Company Alarms dialog box. 

11. The changes you made are applied to instruments and sensors when they are first 

registered in the database. 
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10.4. Default Calibration Gases 

The docking station system allows you to define the concentration of calibration gas that you 

typically use to calibrate certain sensor types.  You can define calibration gases for each of the 

compatible instrument types.   

Default Calibration Gases apply only to instruments when they are docked for the first time, or to 

new sensors whose information is not in the database.  Therefore, you should set up your default 

settings before docking any instruments that are registered in the database.  Changing the Default 

Calibration Gas settings after an instrument has been registered will not update the instrument 

sensor’s settings, unless a new sensor is installed in the instrument.   

10.5. Modifying Default Calibration Gas Settings 

To modify Default Calibration Gas settings, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the View menu and select Default Calibration Gases. 

3. The Company Calibration Gases dialog box appears.  The Company Calibration 

Gases dialog box contains a tab for each compatible instrument type.  Each tab 

contains a list of sensor types that applies to the instrument.  Select the instrument for 

which you want to change calibration gas settings. 
 

 

Figure 10-3.  Company Calibration Gases Dialog Box 

 

NOTE:  VX500 Photo Ionization Detector contains one entry for the PID Sensor.   
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Step Instruction 

4. To edit a calibration gas setting for a sensor type, double-click on its entry in the list. 

Alternative:  You can select the sensor type, and click the Properties button. 

Alternative:  You can also right-click on the sensor type and select Properties from 

the context menu. 

NOTE:  Access via the double-click method or the Properties button is only available 

if the user is an administrator. 

5. The Gas Calibration dialog box appears.  By default, the Factory setting is selected.  

You can override this setting by selecting Company. 
 

NOTE: You can return to the factory settings by editing the Gas Calibration setting and 

selecting  Factory. 

 

Step Instruction 

6. Enter the Concentration of the calibration gas that you wish to use for the sensor 

type.  Click  OK to confirm your changes. 

NOTE:  Look at the Sensor Type to determine the type of value that should be 

entered for the concentration value (e.g., PPM, %VOL, or %LEL). 

7. The sensor type appears in the list in bold type, which indicates that custom settings 

have been confirmed, but are not yet saved.  

8. In the Company Calibration Gases dialog box, Click on Update Sensors to save the 

changes.  

9. Click OK to close the Company Calibration Gases dialog box. 
 

 

Figure 10-4.  Gas Calibration Dialog Box 
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NOTE:  If the user is an administrator, selecting any sensor type enables the properties button.  

If the user is a technician, selecting any sensor type does not enable the properties button.  

Clicking the Properties button or selecting the Properties menu opens the Gas Calibration screen. 

 

NOTE:   If the user is an administrator, right-clicking on any sensor type displays a pop-up 

menu with Properties as a menu option.  If the user is a technician, right-clicking on any sensor 

type does nothing.  If the user is an administrator, double-clicking on any sensor type opens the 

Gas Calibration screen.  If the user is a technician, double-clicking on any sensor type does 

nothing. 

 

 

     
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Printing 

Chapter 

11 
 

11.1. Introduction 

You can print information that appears in the contents pane of DSSAC for the following options:  

 Users  

 Docking Stations 

 Events  

 Instruments 

 Journal. 

You can also print the details of individual IDSs and instruments.   For instruments, you can 

print calibration and bump test certificates, as well as datalog data.  In addition, you can print 

calibration and datalog graphs using the Graph Toolbar.   

11.2. Printing a List from the Contents Pane  

To print the contents pane, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the option in the navigation pane that represents the type of information you 

would like to print.  For example, if you would like to print a list of Instruments, 

click on the Instruments option. 

3. If necessary, click on a column heading to sort the list the way you would like it to 

appear for the print out.  You can also resize the columns to display the data properly 

for the print out. 

4. Click on the File menu and select Print. 

Alternative:  You can also right-click on the option in the navigation pane and select 

Print from the context menu. 

5. The Print dialog box appears.  Select the printer to which you would like to print, and 

the number of copies that you would like to print. 

6. Click OK.  The information is sent to the printer you selected. 

7. The output is a formatted report of the data that appears in the contents pane for the 

option that you had selected. 
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11.3. Printing IDS or Instrument Detail  

To print the details of an instrument or IDS, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments or Docking Stations option in the navigation pane. 

3. Right click on the instrument or IDS whose details you would like to print. 

4. The Print dialog box appears.  Select the printer to which you would like to print, and 

the number of copies that you would like to print. 

5. Click OK.  The information is sent to the printer you selected.  If you printed an IDS, 

the output contains the information on the General tab and each of the Gas In tabs.  If 

you printed an instrument, the output contains the information on the General, 

Options (if available), Components, Users and Sites (if available), and Notes tabs. 

Alternative:  You can also select the instrument or IDS, and click the File menu and 

choose Print. 
 

 

NOTE:  The Access Code field will not be included on an instrument print out.   

 

You can also print the details of an instrument or IDS from within the Edit Instrument or Edit 

Docking Station dialog box.  Follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments or Docking Stations option in the navigation pane. 

3. Double-click on the instrument or IDS whose details you would like to print. 

4. Click the Print button. 

 

11.4. Configuring the Auto-Print Feature (Versions 3.0 and Higher) 

After the docking station system is completely operational, the follow feature may be enabled to 

allow calibration and bump test reports to be automatically printed to a specified printer after the 

event has occurred.   

Before setting up the software for the auto-print feature make sure that the user that is logged 

onto the machine has administrative privileges to change the printer.   
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The user will be required to properly configure the printers on the server or PC before they will 

become available for use in this feature.  The steps to configure a printer are listed below. 

Step Instruction 

1. Create or choose a user account on the server or PC machine which will be used by 

the printing service.  This user account must be password protected.  The user MUST 

have administrator rights. 

2. Log into the server or PC machine using the user account created in the previous 

step. 

3. Make sure you can open Internet Explorer.  If IT needs to go through the wizard, 

complete the steps asked. 

NOTE:  Internet Explorer Version 7.0 (or later) must be installed for the Auto-Print 

feature to operate. 

4. Through Windows, add any printers desired by selecting START / SETTINGS / 

PRINTERS AND FAXES / ADD PRINTER. 

5. Log back in as an Administrator. 

6. Access the services running on the server by START / SETTINGS / CONTROL 

PANEL / ADMINISTRATIVE TOOLS / SERVICES. 

7. Locate the service named “DSX Server Auto Print”. 

8. Right-click on this service and select “Properties”. 

9. Select the “log-on” tab. 

10. Select “This account” instead of the default. 

11. Click “Browse”. 

12. The following window will appear. 

 

Figure 11-1.  The Select User Window 
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Step Instruction 

13. Enter the name of the user that was selected previously into the textbox. 

14. Click “Check names” and verify that the name is recognized. 

15. Select ok. 

16. Enter the users password into the password box and confirm box. 

17. Right click the service and select “Stop.” 

18. Right click the service and select “Start.” 

19. The service should now have access to all printers configured for that user. 

20. When using DSSAC and a selected unit is chosen from the Docking Station lists, the 

General Information tab for the docking station will look like the following.  A drop 

down list of printers is available.  (Printers will appear in this list if the service was 

set up properly). 

 
 

Figure 11-2.  The General Information Tab for the Docking Station 

21. When a printer is selected from the IDS Printer list, Calibration and Bump Test 

Certificates will automatically print to the chosen printer each time one of these 

events occurs.  A sample of each of the reports is shown below. 
 

NOTE:   If DSS’s tracelog service is enabled, then the DSX Server AutoPrint service will write 

debug messages to the file called “ds2_printing_log.txt” in the same directory that the server’s 

tracelog file is configured to write to.  For example, if tracelog is configured to be  

D:\logs\ds2_server_log.txt, then the AutoPrint service will log its messages to 

D:\logs\ds2_printing_log.txt.   

The AutoPrint service reads configuration settings on startup to determine if and where it should 

write its log file.  It will reread the configuration file once every minute to see if trace log 

settings have changed and, if so, then the AutoPrint service will change on the fly to use the new 

log settings. 
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The AutoPrint service uses the maximum size specified tracelog file to also control the 

maximum size of the printing log.  That is, if tracelog is configured to restart at 1MB, then the 

AutoPrint service will also restart the printing log once it exceeds 1MB.  Each time the 

AutoPrint server logs a message, it checks the size of the log file.  If the file is less than tracelog 

max size, it appends the message.  If the file is greater than this max size, it clears the file and 

then writes the message. 

11.5. Printing Calibration and Bump Test Certificates  

To print calibration or bump test certificates, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 

3. Double-click on the instrument that has the calibration or bump test data for which 

you would like to print a certificate. 

4. Click on the Calibrations or Bump Tests tab. 

5. Do one of the following: 

 Select a Start Date and an End Date, and then click the Display button to 

show data for a specific date range.   

 Click the Show Last button to display the results of the last calibration or 

bump test.   

6. Select the entry that you would like to print.  You can select multiple calibration 

entries by pressing the CTRL key on your keyboard while selecting each entry. 
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Step Instruction 

7.  Calibration and bump test certificates may optionally have signature lines printed to 

include a Performed By and/or a Received By signature. They can also include the 

selected instruments’ Status information.  To add the signature lines and/or include 

instrument status on the Cal or Bump certificates 

 Select the View dropdown menu from the DSSAC main tool bar. 

 Click on Configuration. 

 The Configuration dialog box will appear as shown.  Select the Reporting tab. 

 Check one or both boxes for the desired signature line, and/or check the box 

“Include Status in Bump/Cal Certificate”. Click “OK”. 

 

 

8. Click the Print Certificate button. 

Alternative:  You can also right-click on the entry, and select Print Certificate from 

the context menu. 

9. The Print dialog box appears.  Select the printer to which you would like to print, and 

the number of copies that you would like to print. 

10. Click OK.  The information is sent to the printer you selected. 

11. The output displays the serial number of the instrument, the serial number of the 

sensor, the gas type, the status of the instrument, and whether or not the test passed or 

failed.  For calibrations, the Full Span Reserve calculation is also printed. 
 

NOTE:  Any user-selected calibration or bump certificate can be printed. 

 

NOTE:  For a multi-gas instrument, selecting one sensor and then clicking the PRINT button 

prints the instrument’s calibration certificate for all of the installed sensors at that time. 

 

A “Cylinder ID” column (represented by “CYL”) contains the Serial number of the cylinder, if 

the cylinder is iGas.  This serial number is read from the iGas card.  It consists of the Lot number 

and the cylinder number 
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If the cylinder is not iGas, the cylinder ID column contains the Cylinder ID number entered 

manually by the user through DSSAC.  If the user has not entered an ID, this column is blank. 

A “Cylinder Expiration” column (represented by “Exp”) contains the expiration date read from 

the iGas card.  If the cylinder is non-iGas, this column contains the expiration date entered 

manually by the user through DSSAC. 

 

 

 

Figure 11-3.  Sample Tango TX1 Calibration Certificate 
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Figure 11-4.  Sample Tango TX1 Bump Certificate 

11.6. Printing Datalog Data 

To print datalog data, follow the instructions listed below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the Instruments option in the navigation pane.  The contents pane displays a 

list of instruments. 
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Figure 11-5.  The Instruments Option in Navigation Pane 

 

Step Instruction 

3. Double-click on the instrument that has the datalog data that you wish to print. 

4. Click on the Datalog tab. 

5. Select a Start Date and an End Date, and then click the Display button to show data 

for a specific date range. 

6. Select the session whose information you would like to print. 

7. Click the Actions button. 

8. Selecting the Print Data option prints a Datalog Detail Report.  It is disabled until a 

session is selected. 

Selecting the Print Summary option prints a Datalog Summary Report.  It is disabled 

until a session is selected.  Note that this option is disabled by default or whenever no 

session is currently selected. 

9. The information is sent to the printer you selected. 

10. The output displays each reading taken during the session, as well as the TWA and 

STEL calculations at the time of each reading.  The list is categorized by period and 

site information. 
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Figure 11-6.  The Datalog Tab 

 

Figure 11-7.  Sample Datalog Summary Report 

     



 

 

Language Features 

Chapter 

12 
 

12.1. Introduction 

The DSX-L supports seven languages for the user interface on the IDS LCD display and in the 

DSSAC application: English, French, Spanish, German, Czech, Polish, and Russian.  When the 

DSS installation software is launched, the Software Startup Window displays the language 

choices.  Click on the desired language. The Launcher page will reload in the chosen language. 

 

Figure 12-1.  Installer Software Startup Window  

12.2. Changing Language Settings 

This section describes how to change your language settings for both the IDS and the DSSAC.   

12.2.1. Instrument Docking Station Language Settings 

The language setting for an IDS can be changed by either of the following ways:  
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 Using the Edit Docking Station dialog box in the DSSAC  

 Using the IDS menu.   

To change IDS language settings using the DSSAC, follow the instructions below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click the Docking Stations option in the navigation pane. 

3. The contents pane displays a list of IDSs that have been configured in the system. 

4. Double-click on the IDS whose language settings you wish to change. 

5. The Edit Docking Station dialog box appears. 

6. On the General tab, select a language in the Language Setting field. 

7. Click the OK button to save your changes.  The change will take effect the next day, 

when the system runs the Settings Update event for the IDS. 

Alternative:  You can also right-click on the IDS and select Properties from the  

context menu. 

Alternative:  You can also select the IDS, and then click the File menu, and select 

Properties. 

To change IDS language settings using the IDS menu, follow the instructions listed below. 

Step Instruction 

1. Press any of the keys on the IDS keypad to access the main menu. 
 

NOTE:  The menu cannot be used when the IDS is performing an instrument action.   

 

NOTE:   The menu cannot be used if the Menu Locked setting for the IDS in DSSAC is set to 

“Yes.”  

 

Step Instruction 

2. Use the ARROW keys on the keypad until Docking Station is highlighted. 

3. Press the ENTER key.  The Docking Station menu appears. 

4. Use the ARROW keys on the keypad to select Set Language.  Press the ENTER key. 

5. A list of languages appears.  Use the ARROW keys on the keypad to navigate to the 

language that you would like to use.  Press the ENTER key to select the language. 

6. The LCD displays a confirmation prompt: “Are you sure?”  Select Yes, and press the 

ENTER key. 

7. The LCD screen returns to the main menu.  The language setting on the Docking 

Station has been changed. 
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NOTE:   If the language is not changed in DSSAC, the language set in DSSAC will override the 

setting made on the IDS menu the next time the system runs the Settings Update event for the 

IDS. 

 

12.2.2. DSSAC Language Settings 

To change the language used in the DSSAC application, follow the instructions below. 

Step Instruction 

1. Open the DSSAC application. 

2. Click on the View menu and select Configuration. 

3. Click on the Language tab, if necessary. 

4. Select a language from the drop-down list in the “Language Setting” field.  Click 

OK. 

5. A DSSAC Settings Change message appears to inform you that the change will not 

take effect until the next time that DSSAC is restarted. 

6. Click the File menu and select Exit to close the DSSAC application. 

7. Re-open the DSSAC application.  The language you selected is used to display 

information in the DSSAC. 
 

     



 

 



 

 

Troubleshooting 

Chapter 

13 
 

13.1. Introduction 

This section provides information about troubleshooting problems in the docking station system.  

The issues are categorized into three main areas:  

 DSSAC Issues  

 DSS Issues  

 Instrument Docking Station Issues. 

13.2. Using the Event Log 

If you experience a problem with the Docking Station Server (DSS) or the DSSAC, many error 

messages can be viewed in the operating system‘s Event Log.  In addition, information about 

events that did not run successfully is recorded in the Event Log.   

For DSSAC workstations, you can view the event log from the computer on which DSSAC is 

running.  For the DSS computer, you can view the event log in the same way only if you have 

physical access to the server.  You can also access the event log of the DSS remotely, provided 

you have administrative rights on the server.  The DSS messages will be written to the DSX 

Docking Station Log in the Event Log.   

To access the Event Log on the current computer, follow the instructions listed below. 

Step Instruction 

1. Click on the Start button.   

2. Select Control Panel.  The Control Panel window opens. 

3. Double-click on the Administrative Tools icon to open the Administrative Tools 

window. 

4. Double-click on Event Viewer.  The Event Viewer utility opens.  The docking station 

records errors to the Application log. 

5. If you need to access the DSS Event Log, you can use the Computer Manager icon 

instead of the Event Viewer icon.  When the Computer Manager opens, click on the 

Action menu and choose Connect to another computer.  Select the server that is 

running the DSS software. 

To access the Event Log on another computer, follow the instructions that are listed below. 
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Step Instruction 

1. Click on the Start button 

2. Select Control Panel.  The Control Panel window opens. 

3. Double-click on the Administrative Tools icon.  The Administrative Tools window 

opens. 

4. Double-click on the Computer Manager icon.  The Computer Manager utility opens. 

5. Click on the Action menu and choose Connect to another computer.  Select the server 

whose Event Log you wish to view. 

6. Once you have connected to remote computer, click on Event Viewer in the left pane 

of the window.  Please refer to your operating system‘s user guide for detailed 

information about using the Event Viewer. 
 

Table 13-1.  Sample Event Log Messages 

Error 

Condition 

Event Viewer Message 

Required gas is 

not connected 

(no iGas 

connected and 

no gas manually 

configured 

through DSSAC) 

******* EVENT VIEWER MESSAGE: Warning 0 Event type: 

InstrumentCalibrationForcedEvent 

Docking Station: 0403525-075 

Docked Instrument: 0211350084 

Description: Resources for event on 0403525-075 were 

unavailable.Could not find cylinder needed for sensor: 

001714522082#S0001 

Error Text:  

*******END EVENT VIEWER MESSAGE******* 

Required gas is 

connected, but 

expired 

******* EVENT VIEWER MESSAGE: Warning 0 Event type: 

InstrumentCalibrationForcedEvent 

Docking Station: 0403525-075 

Docked Instrument: 0211350084 

Description: Resources for event on 0403525-075 were 

unavailable.Cylinder has expired. 

Cylinder id =83075A-104 

Port number: 2 

Could not find cylinder needed for sensor: 

001714522082#S0001 

Error Text:  

*******END EVENT VIEWER MESSAGE******* 
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Error 

Condition 

Event Viewer Message 

Required gas is 

connected, but 

empty 

******* EVENT VIEWER MESSAGE: Warning 0 Event type: 

Instrument Heartbeat 

Docking Station: 0403525-075 

Docked Instrument: 0211350084 

Description: Resources for event on 0403525-075 were 

unavailable.Cylinder is empty. 

Cylinder id =82041-89 

Port number: 2 

Could not find cylinder needed for sensor: 

001714522082#S0001 

Error Text:  

*******END EVENT VIEWER MESSAGE******* 

Fresh air is not 

configured 

manually 

through DSSAC 

******* EVENT VIEWER MESSAGE: Warning 0 Event type: 

InstrumentCalibrationForcedEvent 

Docking Station: 0403525-075 

Docked Instrument: 0211350084 

Description: Resources for event on 0403525-075 were 

unavailable.Fresh air not found. 

Error Text:  

*******END EVENT VIEWER MESSAGE******* 

13.3. DSSAC Issues 

Situation Explanation/Solution 

You cannot log on to the 

DSSAC (Invalid User Name or 

Password.  Please reenter to log 

in.) 

 Make sure that you user name and password are typed 

correctly.  Passwords are case-sensitive.  Check to see 

if the CAPS LOCK is turned on your keyboard. 

You cannot log on to the 

DSSAC (Invalid IP Address) 
 Click the Options button on the DSSAC Login dialog.  

Make sure that the IP address is the correct address for 

the DSS you are trying to access. 

You receive a network error 

when launching the DSSAC 

application 

 The DSS is down, or the computer is not connected to 

the network.  Contact your network administrator or 

docking station systems administrator. 

Data entered in DSSAC is not 

saved 
 Connection to the network has been interrupted.  

Contact your network administrator. 
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You receive a network error 

while in the DSSAC 
 Connection to the network has been interrupted.  

Contact your network administrator.   

 The DSS may be down.  Contact your network 

administrator or docking station systems administrator.   

 Your user account has been removed or modified (e.g., 

role changed, password changed, account disabled) by 

a Systems Administrator.   

You cannot see the User option 

or the Default Alarm Settings, 

or the iNet tabs in the 

Configuration dialog 

 Your role is set to “Technician.”  An administrator 

needs to change your role to “Systems 

Administrator“ in order to for you to use these 

functions. 

You cannot see all of the 

instruments in the system when 

you click on the instruments 

option in the navigation pane 

 A filter is in effect.  Right click on the Instruments 

option in the navigation pane, and select Cancel. 

 

13.4. DSS Issues 

Situation Explanation/Solution 

Upload to iNet fails  Internet connection failure.  Contact your network 

administrator. 

 Verify that the correct Company Password and URL 

have been configured in the DSSAC. 

DSSAC clients and IDS cannot 

connect to the DSS 
 Verify that the server is running and is connected to the 

network.   

 For DSSAC clients, ensure that the correct server IP 

address is specified in the Login dialog box.   

 For IDSs, verify that the correct server IP address is 

configured by checking the Information screen from the 

IDS menu.  DSS does not communicate with IDSs  

 Verify that the DSS has a fixed IP address, and that 

DHCP is running to assign IP addresses to the IDSs.   

Bump and/or Calibration 

certificates are blank when 

printed using the Auto Print 

feature 

 Verify the version of Internet Explorer that is being 

used.  The docking station system requires version 6.0 

or later.  Earlier versions may print blank bump and 

calibration certificates. 
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13.5. Instrument Docking Station Issues 

Situation Explanation/Solution 

Instrument did not calibrate  Gas cylinder is expired.   

 Gas cylinder is empty.   

 Gas requested for calibration was not available.   

 Gas tubing that supplies the gas is blocked or 

disconnected.   

 The Gas In connections are configured incorrectly in 

DSSAC.   

Unexpected calibration failure  Gas is not connected to the appropriate Gas In 

connection; thus, the instrument was calibrated using 

fresh air.   

 Gas configured for the Gas In tab in the DSSAC does 

not match actual gas in the cylinder.   

Changes to settings were not 

properly applied to a IDS or 

instrument 

 IDS was unplugged during the event.   

 Network connection possibly interrupted.   

 Instrument was not properly docked in the IDS.   

Cannot perform a forced 

calibration 
 Instrument is not properly docked in the IDS.   

When a datalog download is 

attempted, the IDS displays 

“Unavailable” 

 The instrument’s datalog data is probably corrupt.  

Manually clear the datalog from the instrument. 

Cannot use the menu on the 

IDS 
 The IDS is actively performing a task.   

 The Menu Locked option has been set for the IDS in 

the DSSAC.   

IDS green LED is on, but the 

IDS is not displayed in blue text 

in the DSSAC 

 Network connection from the IDS may be down or 

unplugged. 

“Discovering” message displays 

on the IDS for an extended 

period of time 

 Network connection from the IDS may be down or 

unplugged. 

IDS does not display the correct 

time 
 Verify that the server has the correct time for your 

time zone.  The IDSs use the time available from the 

server. 

An instrument shows a failed 

sensor on its display, but the 

IDS displays the instrument as 

available 

 The instrument was probably calibrated in the field.  

The docking station is not aware of the failed 

calibration.  Force a calibration on the IDS. 
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Situation Explanation/Solution 

IDS display reads 

“Unavailable” 
 An error occurred with the IDS.  Review the DSS 

event log, and look for errors related to the IDS serial 

number 

IDS display reads “Unavailable 

Instrument” 
 Check the docked instrument’s properties in DSSAC 

to see if the instrument failed calibration. 

IDS display reads “Unavailable 

Server” 
 IDS cannot contact the server.  The IDS display shoes 

its own IP address and also the IP address of the server 

it is currently configured to connect to. 

“Diagnostic Vacuum” error  Diagnostic test fails if vacuum <= 130 or vacuum >= 325 

“Diagnostic Solenoid No 

Vacuum“ error 
 Diagnostic test fails if vacuum >= 325. 
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Situation Explanation/Solution 

IDS display reads “Unavailable 

Gas” (or “No Fresh Air” when 

connected to v5.0 DSS or later) 

 Gas that was required for a bump test or calibration 

was not available.   

 The gas cylinder may be low or empty.   

 Ensure that the Gas In configuration in DSSAC is 

correct.   

 If more than one gas is missing, the IDS displays the 

first gas it needed, but did not have access to.  Thus, if 

the first missing gas is then provided, but a second gas 

is still missing, the user is presented with a second 

“Unavailable Gas” message, but with the chemical 

symbol of the second gas. 

 If prior to an aborted cal/bump the pressure of the 

cylinder was previously “OK” or “Low”, then 

underneath the Unavailable Gas message, the word 

“Low” or “Empty” appears (respectively) 

 If the server determines that a scheduled or forced 

calibration or bump cannot occur because a needed gas 

cylinder is empty or expired, then the IDS displays 

“Empty” or “Expired” (as appropriate) along with the 

chemical symbol of the missing gas. 

Unavai l abl e Gas

( H2S)

SN:  0511061- 023

  

Unavai l abl e Gas

( Fr esh Ai r )

SN:  0511061- 023

  

Unavai l abl e Gas

( Low)

SN:  0511061- 023

 

Unavai l abl e Gas

( Empt y)

SN:  0511061- 023

  

Unavai l abl e Gas

( H2S Empt y)

SN:  0511061- 023

  

Unavai l abl e Gas

( H2S Expi r ed)

SN:  0511061- 023

 

Figure 13-1.  Examples of No Gas Displays 

 

13.6. Enabling the Tracelog 

To enable the tracelog feature in the Docking Station Server Admin Console, follow the 

procedure listed below. 
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Step Instruction 

1. Log into the Docking Station Server Admin Console.  A sample display is shown below. 

 

Figure 13-1.  Sample Display of Docking Station Server Admin Console 

2. Select the Configuration 

option from the View 

menu. The 

Configuration window 

is displayed. 

 

Figure 13-2.    Configuration Option of the View Menu 
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Step Instruction 

3. Click the “Logging” tab 

on the Configuration 

window. 

 

Figure 13-3.    The Logging Tab 

4. Click the “DS2 Server 

Logging Enabled” check 

box. 

 

Figure 13-4.    Verify Log File Parameters 

5. Ensure that the log file  

“c:\ds2_server_log.txt” 

is entered into the “Log 

File” field. 

6. Ensure that “1000” is 

entered into the "Max 

Size (KB)" field. 

7. The “View Log” button 

can be used to view the 

log file.  The “Purge 

Log” button can be used 

to purge the log file.  

Refer to Figure 13-5 to 

view a sample log file. 
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Step Instruction 

 

 

Figure 13-5.  Viewing a Sample Log File Using the View Log Button 

8. Click “OK” to exit the menu. 

 

NOTE:  The log file grows in small increments as the logged data is added to the file.  The log 

file is stored as “c:\ds2_server_log.txt.”  

 

13.7. Industrial Scientific Support Services 

Contact the Industrial Scientific Customer Service Department 24 hours a day by phone, fax or 

e-mail.  Phone lines are handled by friendly, knowledgeable professionals 24 hours a day from 

8 PM Eastern Standard Time (EST) Sunday evening through 6 PM (EST) Friday evening.  Your 

call will be answered by a real person, not an answering machine or an automated attendant with 

complicated menu selections.   

 

Phone:  412-788-4353 

Toll Free:  1-800-DETECTS (338-3287) 

Fax:  412-788-8353 

Service:  1-888-788-4353 

Web:  www.indsci.com 

    

http://www.indsci.com/


 

 

Warranty 

Chapter 

14 
 

14.1. Warranty 

 Industrial Scientific Corporation’s DSX™ Docking Stations are warranted to be free from 

defects in material and workmanship under normal and proper use and service for two years 

from the initial date of shipment by Industrial Scientific Corporation. 

 

14.2. Limitation of Liability 

THE WARRANTY SET FORTH ABOVE IS STRICTLY LIMITED TO ITS TERMS AND IS IN LIEU 

OF ALL OTHER WARRANTIES, GUARANTEES, EXPRESS OR IMPLIED, ARISING BY 

OPERATION OF LAW, COURSE OF DEALING, USAGE OF TRADE OR OTHERWISE. 

INDUSTRIAL SCIENTIFIC MAKES NO OTHER WARRANTIES, EITHER EXPRESSED OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY 

OR FITNESS FOR PARTICULAR PURPOSE.  

 

SHOULD THE PRODUCT FAIL TO CONFORM TO THE ABOVE WARRANTY, BUYER’S ONLY 

REMEDY AND INDUSTRIAL SCIENTIFIC’S ONLY OBLIGATION SHALL BE, AT INDUSTRIAL 

SCIENTIFIC’S SOLE OPTION, REPLACEMENT OR REPAIR OF SUCH NON-CONFORMING 

GOODS OR REFUND OF THE ORIGINAL PURCHASE PRICE OF THE NONCONFORMING 

GOODS. 

 

IN NO EVENT WILL INDUSTRIAL SCIENTIFIC BE LIABLE FOR ANY OTHER SPECIAL, 

INCIDENTAL OR CONSEQUENTIAL OR OTHER SIMILAR DAMAGES, INCLUDING LOSS OF 

PROFIT OR LOSS OF USE, ARISING OUT OF THE SALE, MANUFACTURE OR USE OF ANY 

PRODUCTS SOLD HEREUNDER WHETHER SUCH CLAIM IS PLEADED IN CONTRACT OR IN 

TORT, INCLUDING STRICT LIABILITY IN TORT AND WHETHER INDUSTRIAL SCIENTIFIC 

HAS BEEN ADVISED OF THE POTENTIAL FOR SUCH DAMAGES. 

 

Industrial Scientific’s total liability hereunder from any cause whatsoever (except liability from personal 

injury caused by Industrial Scientific’s negligence), whether arising under contract, warranty, tort 

(including negligence), strict liability, products liability or any other theory of liability, will be limited to 

the lesser of Buyer’s actual damages or the price paid to Industrial Scientific for the Products that are the 

subject of Buyer’s claim.  All claims against Industrial Scientific must be brought within one year after 

the cause of action arises, and Buyer expressly waives any longer statute of limitations. 

 

It shall be an express condition to Industrial Scientific’s warranty that all products be carefully inspected 

for damage by Buyer upon receipt, be properly calibrated for Buyer’s particular use, and be used, 

repaired, and maintained in strict accordance with the instructions set forth in Industrial Scientific’s 
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product literature.  Repair or maintenance by non-qualified personnel will invalidate the warranty, as will 

the use of non-approved consumables or spare parts.  As with any other sophisticated product, it is 

essential and a condition of Industrial Scientific’s warranty that all personnel using the products be fully 

acquainted with their use, capabilities and limitations as set forth in the applicable product literature.   

 

Buyer acknowledges that it alone has determined the intended purpose and suitability of the goods 

purchased.  It is expressly agreed by the parties that any technical or other advice given by Industrial 

Scientific with respect to the use of the goods or services is given without charge and at Buyer’s risk; 

therefore, Industrial Scientific assumes no obligations or liability for the advice given or results obtained. 
 

 

     

 

 

 

 

 



 

 

 

iNet Configuration 

Chapter 

15 
 

14.1. What is iNet? 

This section provides a brief overview of iNet and how to configure the DSX docking station for 

use with iNet.   

iNet is a subscription-based gas detection program giving you peace of mind that their your 

equipment is properly maintained; that you are able to provide required records on  demand; and 

that your workers are kept safe from hazardous gases. 

 

With iNet, each time your instrument is docked on the DSX, maintenance tasks such as bump 

tests, calibrations, or firmware upgrades are performed based on user-defined schedules. If an 

issue such as a failed sensor is detected within the instrument, a replacement monitor is 

proactively sent to you.  

 

iNet Control – a cloud-based dashboard accessible from any PC browser – provides a 

comprehensive view of your gas detection program. You’ll see that someone from your team 

turned off an instrument that went into alarm while working; you’ll see what gas hazards your 

team is exposed to and at what levels; and more. In addition, all of your program’s data is stored 

in one place making it easy to produce accurate records and reports on demand.  

 

For more information about iNet, visit www.indsci.com/inet or contact the Industrial Scientific 

Customer Service Department.   

Phone:  (800) DETECTS (800-338-3287) or (412) 788-4353  

Fax:   (800) 788-8383 or (412) 788-8353 

e-mail:  info@indsci.com  

 

14.3. Configuring iNet Settings 

When you subscribe to the iNet service, Industrial Scientific supplies you with a Company 

Password and a URL that is used to access the iNet Network Operations Center.  This 

information is entered into the DSSAC for the server to use when it connects to iNet.  Only users 

assigned to the Systems Administrator role can configure iNet settings.   

 

To configure iNet settings, follow the instructions listed below. 

http://www.indsci.com/inet
mailto:info@indsci.com
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Step Instruction 

1. Open the DSSAC application. 

2. Click on the View menu and select Configuration.  The Configuration dialog box 

appears. 

3. Click on the iNet tab. 

4. Click on the Enabled checkbox to enable iNet. 

5. Enter the iNet User Id provided to you in the URL field. 

6. Enter the iNet Password provided to you in the iNet Password field. 

7. Enter your iNet account number as the Default iNet Account Number.  

8. Click OK to save your changes.  DSX Docking Station is now ready to use iNet. 

 

 

Figure 14-1.  iNet Configuration Dialog Box 
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15.4. iNet and Proxy Settings 

The iNet connector behaves as follows with regard to proxy settings. 

1. If the configuration.xml file contains proxy settings, it uses them. 

2. If the configuration.xml file does not contain proxy settings, it defaults to the proxy 

address programmed into Internet Explorer for the user account under which the DS2 

iNet connector service is running. 

3. The proxy settings in the configuration.xml file must appear as follows in order to be 

valid and used. 

 
<iNet cdbid="mycdbid" 

url="https://inetupload.indsci.com/UploadWeb/services/Uploader" 

enabled="T" proxyaddress="http://proxyserver/" proxyuser="userid" 

proxypassword="password" uploadUser="userid" uploadPasswd="password" 

/> 

Figure 15-2.  Proxy Setting Syntax in File configuration.xml 

4. The iNet connector will output the following lines to tracelog when there is data to 

upload. 

 

 

5/16/2005 4:43:13 PM 2 INET: IE Proxy address=<IE proxy address here> 

5/16/2005 4:43:45 PM 2 INET: Found proxy settings in 

Configuration.xml file, overriding IE 

settings: 

5/16/2005 4:43:47 PM 2 INET: proxy ip=<address from config file> 

5/16/2005 4:43:48 PM 2 INET: proxy user=<user from config file> 

5/16/2005 4:43:48 PM 2 INET: proxy passwd=<passwd from config file> 

 

Figure 14-3.  Sample Tracelog Output 

 

 

     
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Acronyms and 
Abbreviations 

Appendix 

A 
 

This appendix contains acronyms and abbreviations that are used within this document. 

Table A-1.  Acronyms and Abbreviations 

Abbr Definition 

A Ampere 

AAW toxic 

ABS acrylonitrile butadiene styrene 

ASCII American Standard Code for Information Interchange 

BBIR broad band infrared 

bit binary digit 

bps bits per second 

C centigrade 

CALI calibration 

CAT catalytic 

Ch channel 

CH4 methane 

chem chemical 

Cl2 chlorine 

ClO2 chlorine dioxide 

CO carbon monoxide 

CSV comma separated variables 

DC direct current 

DCS distributed control system 

DHCP dynamic host configuration protocol 

DISP display 

DSN docking station network 

DSS Docking Station Server 
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Abbr Definition 

DSSAC Docking Station Server Admin Console 

F Fahrenheit 

FAQ frequently asked questions 

FAUL fault 

FIFO first-in-first-out 

GND ground 

H2 hydrogen 

H2S hydrogen sulfide 

HCl hydrogen chloride 

HCN hydrogen cyanide 

IDS instrument docking station 

iNet instrument network 

ISC Industrial Scientific Corporation 

IT Information Technology 

LAT latch mode 

LED light emitting diode 

LEL lower explosive limit (combustible gases) 

LSB least significant bit 

mA milliampere 

MINU minute 

mm millimeter 

MON month 

MSMQ Microsoft Message Queuing 

NC normally closed 

NEMA National Electrical Manufacturers Association 

NH3 ammonia 

NO normally open, Nitric Oxide 

NO2 nitrogen dioxide 

NOR normal mode 

O2 oxygen 

OXY oxygen 

PH3 phosphene 

http://rds.yahoo.com/S=2766679/K=NEMA/v=2/SID=e/l=WS1/R=1/SS=14261853/IPC=us/SHE=0/H=3/SIG=118kng604/EXP=1106619573/*-http%3A/www.nema.org/
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Abbr Definition 

PID Photo ionization detector 

PLC programmable logic controller 

ppm parts per million 

R.HI high alarm relay 

R.FAU fault relay 

R.LOW low alarm relay 

REST restart 

RTC real time clock 

RTU remote terminal unit 

SN serial number 

SO2 sulfur dioxide 

SPST single-pole, single-throw 

STEL short term exposure limit 

TOX toxic 

TWA time weighted average 

UDP user datagram protocol 

V Volts 

VAC Volts Alternating Current 

VOL volume 

WDAY weekday 

 

 

     
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Glossary of Terms 

Appendix 

B 
 

This appendix contains a glossary of terms that are used within this document. 

Table B-1.  Glossary of Terms 

Item Definition 

Bump Test  Also known as “Functional test,” a procedure that verifies that an 

instrument is able to detect gas.  A brief exposure of the monitor to a 

known concentration of gas(es) for the purpose of verifying sensor 

and alarm operation.  It is not intended to be a measure of the accuracy 

of the instrument.   

Bump Test Event  An event in the DSX Docking Station that will automatically perform 

a bump test on a docked instrument.   

Calibration  A test that is used to adjust an instrument to correct for inaccuracies.  

A known gas concentration is used as a calibration standard to verify 

and adjust the output of the instrument. 

Calibration Event  An event in the DSX Docking Station that will automatically perform 

a calibration on a docked instrument.   

Compact Flash  Removable storage cards that are efficient in terms of weight, size, 

and durability.  Often used in digital cameras, printers, and handheld 

computers, and can be used for wireless access.   

Contents Pane  The right frame of the DSSAC application that displays the details an 

option that was selected in the navigation pane.  For example, the 

instruments contents pane displays a list of instruments that have been 

configured in the docking station network.   

Diagnostic Test  A test to determine if a particular function on an instrument or IDS is 

operating properly.  Diagnostic tests are run on instruments as a part 

of the iNet service to proactively determine if a malfunction exists.   

Diagnostics Event  An event in the DSX Docking Station that will automatically perform 

diagnostic tests on a docked instrument or on an IDS.  The results of 

these tests are sent to iNet for analysis.   
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Item Definition 

Docking Station 

Network  

Also referred to as DSN, the network on which all components of 

DSX Docking Station reside.  A docking station network consists of 

one (1) Docking Station Server, multiple Instrument Docking Stations 

(IDS), and multiple Docking Station Server Admin Console (DSSAC) 

workstations.   

Docking Station 

Server Admin 

Console  

Also referred to as DSSAC, the Windows
® 

application that is used to 

administer the components of a Docking Station Network.   

Docking Station 

Server  

Also referred to as DSS, server software that controls a Docking 

Station Network.  The DSS handles all functions of the IDSs and 

DSSAC clients.  DSS runs on a Microsoft Windows 2000 or 

Windows 2003 server.   

Full Span Reserve  The difference between a reading on an instrument and the actual 

known gas concentration in a calibration gas cylinder, displayed as a 

percentage, used to measure the accuracy of a sensor.  A Full Span 

Reserve value is computed by dividing a sensor’s reading by the 

actual concentration in the gas cylinder.  For example, if a sensor’s 

reading was 70 ppm, and the concentration in the cylinder was 100 

ppm, the Full Span Reserve value would be 70%.   

Functional Test  See “Bump Test.”  

Datalog data  Information about the levels of exposure to gases over a period of 

time.  This information is recorded on an instrument during its 

operation.   

Datalog Download 

Event  

An event in the DSX Docking Station that automatically downloads 

datalog data from a docked instrument and stores it in the DSX 

Docking Station system.   

iGas  A feature of DSX Docking Station that utilizes Smart Card technology 

to automatically configure gas cylinders for your IDSs.   

iNet  Also known as the Instrument Network, a service provided by 

Industrial Scientific Corporation that monitors a customer’s 

instrument data to ensure that equipment is in optimum working 

condition.  If a service need is detected, appropriate action is taken 

depending on the iNet program in which the customer participates.  

Typical service options are an on-site service visit, replacement 

product, or a new part. 

Instrument  Any device that is used to detect gases or Volatile Organic 

Compounds (VOCs).  For purposes of DSX Docking Station, these 

devices are within Industrial Scientific Corporation’s Portable 

Instruments product line.   
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Item Definition 

Instrument Docking 

Station  

The physical hardware into which an instrument is placed for 

calibration, bump tests, diagnostic tests, and datalog downloads to the 

Docking Station Server. 

LEL (Lower 

Explosive Limit)  

The minimum concentration at which a gas will explode, displayed as 

a percentage (%LEL).  The term “LEL” is also used to describe a type 

of sensor that detects combustible gases. 

Navigation pane  The left frame of the DSSAC application that contains a tree-like 

structure used to navigate to different items in the docking station 

network. 

Network 

Administrator  

Typically the person or persons assigned to configure an 

organization’s network and troubleshoot connectivity issues.  

communications protocols used to connect hosts on the Internet.   

PID (Photo Ionization 

Detector)  

An instrument that utilizes ultra-violet light energy to ionize and 

detect the presence of an unknown gas or vapor. 

PPM (Parts per 

Million)  

A unit of measurement used for small proportions of concentrations.  

In gas analysis, it expresses the volume of a gas present in terms of its 

relationship to a whole of 1 million parts of air.  Examples: 1% of 

volume = 10,000 ppm; 100% of volume = 1,000,000 ppm.   

Settings Read Event  An event in the DSX Docking Station where the current settings on an 

instrument or IDS are read to see if they have changed.  This event 

runs daily for IDSs, and upon docking for instruments, in conjunction 

with the Settings Update Event.  This event cannot be configured by 

an end-user. 

Settings Update 

Event  

An event in the DSX Docking Station in which Instrument or IDS 

settings that were updated in the DSSAC are uploaded to the docked 

instrument or to the IDS.  This event runs daily for IDSs, and upon 

docking for instruments.  This event cannot be configured by an end-

user. 

Smart Card  A plastic card, about the size of a credit card, with an embedded 

microchip that contains data.  DSX Docking Station uses Smart Cards 

for the iGas component.   

Span See “Full Span Reserve”  

Span Reserve  See “Full Span Reserve”  

STEL (Short Term 

Exposure Limit)  

The average amount of gas (in PPM) a worker can be exposed to in a 

15-minute period with no long term health effects.  This may occur 4 

times a shift with one hour between 15-minute exposures. 

TWA (Time 

Weighted Average)  

The average amount of gas (in PPM) a worker can be exposed to over 

a certain time period.  This time is defined as 8 hours to represent a 

normal workday.   
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Item Definition 

%VOL  The percent of volume, assuming a whole of 100%, typically used to 

describe the amount of a particular gas in a gas/air mixture.   

 

    



 

 

 

Contact Information 

Industrial Scientific Corporation 

1 Life Way 

Pittsburgh, PA 15205-7500 USA 

Web: www.indsci.com  
Phone: +1 412-788-4353 or 1-800-DETECTS (338-3287) 

E-mail: info@indsci.com  

Fax: +1 412-788-8353 

 

Industrial Scientific France S.A.S. 

5 Rue Frédéric Degeorge, CS 80097  

62002 Arras Cedex, France 

Web: www.indsci.com  

Téléphone : +33 (0)1 57 32 92 61 

E-mail: info@eu.indsci.com  

Fax: +33 (0)1 57 32 92 67 
 

英思科传感仪器（上海）有限公司 

地址：中国上海市浦东金桥出口加工区桂桥路 290号 

邮编：201206 

电话：+86 21 5899 3279 

传真：+86 21 5899 3280 

E-mail： info@ap.indsci.com 

网址： www.indsci.com  

服务热线：+86 400 820 2515 
  
To locate a nearby distributor of our products or an Industrial Scientific service center or 

business office, visit us at www.indsci.com.  

 

Rendez-vous sur notre site Web www.indsci.com, si vous voulez trouver un distributeur 

de nos produits près de chez vous, ou, si vous recherchez un centre de service ou un 

bureau Industrial Scientific. 

 

Besuchen Sie uns unter www.indsci.com, um einen Vertriebshändler unserer Produkte 

oder ein Servicecenter bzw. eine Niederlassung von Industrial Scientific zu finden. 

 

Para buscar un distribuidor local de nuestros productos o un centro de servicio u oficina 

comercial de Industrial Scientific, visite www.indsci.com. 

 

如需查找就近的产品经销商或 Industrial Scientific 服务中心或业务办事处，请访问

我们的网站 www.indsci.com。  

 


